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Preface

The FileSite Installation and User’s Guide describes how to install and use 
FileSite, and describes the WorkSite features that are available in Microsoft Office 
and Adobe Acrobat integrated applications. It also describes the operation of the 
WorkSite Viewer and Portable programs. It is intended for end users of FileSite. 

This preface contains the following sections:

 “Version”

 “Notational Conventions”

 “Command-line Syntax Conventions”

 “Notices”

 “Product Documentation”

 “Support and Contact Information”

 “Document Revision History”

Version

The information in this guide is current as of FileSite version 8.5. The content was 
last modified October 2010. Corrections or updates to this information may be 
available through the Autonomy Support site; see “Support and Contact 
Information” on page 25. 
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Notational Conventions

This guide uses the following conventions:

Convention Usage

Bold User-interface elements such as a menu item or button. 
For example:

Click Cancel to halt the operation.

Italics Document titles and new terms. For example:

 For more information, refer to the IDOL Server 
Administration Guide.

 An action command is a request, such as a query or 
indexing instruction, sent to IDOL Server.

monospace font File names, paths, and code. For example:

The FileSystemConnector.cfg file is installed 
in C:\Autonomy\FileSystemConnector\

monospace bold Data typed by the user. For example:

 Type run at the command prompt.

 In the User Name field, type Admin.

monospace italics Replaceable strings in file paths and code. For 
example:

user UserName
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Command-line Syntax Conventions
Command-line Syntax Conventions

This guide uses the following command-line syntax conventions.

The use of punctuation—such as single and double quotes, commas, 
periods—indicates actual syntax; it is not part of the syntax definition.

Convention Usage

[ optional ] Brackets describe optional syntax. For example:

[ -create ]

| Bars indicate “either | or” choices. For example:

[ option1 ] | [ option2 ]

In this example, you must choose between option1 
and option2.

{ required } Braces describe required syntax in which you have a 
choice and that at least one choice is required. For 
example:

{ [ option1 ] [ option2 ] }

In this example, you must choose option1, option2, 
or both options.

required Absence of braces or brackets indicates required 
syntax in which there is no choice; you must type the 
required syntax element.

variable

<variable>

Italics specify items to be replaced by actual values. For 
example:

-merge filename1

(In some documents, angle brackets are used to denote 
these items.)

... Ellipses indicate repetition of the same pattern. For 
example:

-merge filename1, filename2 [, filename3 
... ]

where the ellipses specify, filename4, and so on.
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Notices

This guide uses the following notices:

Product Documentation

For more information on the administrative utilities provided with FileSite, refer to 
the WorkSite Server Administrator's Guide and the WorkSite Desktop Client 
Customization Guide.

CAUTION A caution indicates an action can result in the loss 
of data.

IMPORTANT An important note provides information that is 
essential to completing a task. 

NOTE A note provides information that emphasizes or 
supplements important points of the main text. A note supplies 
information that may apply only in special cases—for example, 
memory limitations, equipment configurations, or details that 
apply to specific versions of the software.

TIP A tip provides additional information that makes a task 
easier or more productive. 
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Support and Contact Information
Support and Contact Information

Read this section to obtain the latest product documentation, request technical 
support, or contact Autonomy.

Download the Latest Documentation

You can retrieve the latest available product documentation from Autonomy’s 
Knowledge Base on the Customer Support site. 

To download the latest document revisions

1. Type this URL in your Web browser's address field:

https://customers.autonomy.com

2. Click Log In and type your e-mail address and password. 

3. Click Sign in.

4. Click Knowledge Base.

5. Type query text or select a category to filter your search for documentation. 
The most recently added documents display at the top of the results list.

The version number associated with a document (for example, version 8.5) is the 
product version that the document describes. If a document has a revision 
number (for example, Revision 5), the document has been revised since it was 
first released with the specified product version. The Knowledge Base contains 
the latest available revision of any document.

IMPORTANT Access to the contents of the Customer 
Support site requires a user name and password. To obtain 
a user name and password, follow the sign-up instructions 
on the home page. 
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Contact Autonomy Technical Support

Autonomy Technical Support exists to provide you with prompt and accurate 
resolutions to difficulties relating to using Autonomy software products. You can 
contact Technical Support using any of the following methods:

 Call or e-mail the support group at the location that is nearest to you:

 Access the Customer Support site at: https://customers.autonomy.com

Access to the contents of the Customer Support site requires a user name and 
password. To obtain a user name and password, follow the sign-up instructions on 
the home page. 

Contact Autonomy

Contact the location that is nearest to you for general information about 
Autonomy:

Europe and Worldwide North and South America

E-mail: tsp-europe@autonomy.com

Telephone: 
00 800 4837 4890 (UK, Germany, Spain, 
Netherlands, France) 
+44 (0) 800 0 282 858 (UK only)

Hours: 09:00 to 17:00 (GMT+1)

E-mail: support@autonomy.com

Telephone: 
1 877 333 7744
1 403 294 1107 (Canada direct)

Hours: 07:00 to 18:00 MST (GMT-7)

Europe and Worldwide North and South America

E-mail: autonomy@autonomy.com

Telephone: +44 (0) 1223 448 000
Fax: +44 (0) 1223 448 001

Autonomy Corporation plc
Cambridge Business Park
Cowley Road, Cambridge, CB4 0WZ, UK

E-mail: autonomy@autonomy.com

Telephone: 1 415 243 9955
Fax: 1 415 243 9984

Autonomy, Inc.
One Market Plaza, Spear Tower, Suite 1900
San Francisco, CA. 94105, US
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Document Revision History
Document Revision History

See Table 1 for a list of updates to this guide.

Table 1  Revision History

Document 
Revision Release Date Notes

4 19 October 2010  Added support for Microsoft Office 2010 
32-bit.

 8.5 SP2 Release.

3 05 April 2010  Added information on “Language Settings” on 
page 50.

 8.5 SP1 Release.

2 21 August 2009  Updated information in “New Features in This 
Release” on page 39.

 Added information on “Loading Localized 
KeyView Resource Files” on page 50.

 Added information to “Sending an E-mail to a 
Folder” on page 123.

 Added information on “Inserting a WorkSite 
Hyperlink” on page 285.

 Updated information in “Setting More Printer 
Options” on page 343.

1 12 June 2009 8.5 Release.
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CHAPTER 1  
Introduction
This chapter contains the following topics:

 “What is WorkSite?”

 “What is FileSite?”

 “Key Features of FileSite”

 “New Features in This Release”

What is WorkSite?

WorkSite™ is a document-management system (DMS)—a software product that 
can manage millions of documents for hundreds or thousands of users. A DMS is 
used to help organizations overcome problems with managing large numbers of 
documents, which affect efficiency, accuracy, and information security. 

WorkSite enables you to:

 Effectively use online document collections that can store millions of 
documents.

 Organize work into Workspaces corresponding to clients, matters or projects.

NOTE The term document as applied in this guide refers to 
an electronic file, including not only text files, but also 
spreadsheets, images, e-mails, and many other types.
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 Share Workspaces and documents with other groups or specific users.

 Find and retrieve documents and Workspaces quickly, using powerful 
searching tools.

 Provide consistent system-wide document security rules.

 Create and track multiple versions of a document.

 Maintain extensive document histories and audit trails.

 Automatically archive and restore documents.

 Integrate records management (that is, physical documents) into the 
document-management system.

Client-Server Architecture

You access WorkSite by logging into a WorkSite Server. A server is a computer 
that performs operations requested by other PCs, which are called clients. 
FileSite™ is a client application that runs on a PC and communicates with 
WorkSite.

The WorkSite DMS consists of the following components:

 A WorkSite Server, which handles client requests and manages access to the 
information in the system.

 A database, such as Microsoft SQL Server®, which stores document metadata 
(information about the documents).

 A file server, which stores the documents themselves.

 A set of full-text index collections, which manage the information used to 
search for documents.

These components work together to organize and index your documents. From a 
user’s standpoint, the file server and database operate as a single entity, called a 
library. As shown in Figure 1, one WorkSite server can be connected to several 
libraries at the same time.
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What is FileSite?
Figure 1 WorkSite Client-Server diagram

What is FileSite?

FileSite is a desktop application for using WorkSite that is fully integrated with 
Microsoft® Office® and Microsoft Outlook®. The term integrated means that you 
use FileSite directly from inside Microsoft Office applications, including managing 
your e-mail using the familiar Microsoft Outlook interface. FileSite is specially 
designed to meet the needs of the legal community, but it can also be customized 
for government organization and other businesses.

NOTE Refer to the WorkSite Server Design Guide for more 
information on this topic.
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Although it provides access to all document types in WorkSite through Microsoft 
Outlook, FileSite is most often used to manage e-mail. It does this in cooperation 
with Microsoft Exchange Server®, an e-mail and collaboration software product 
developed by Microsoft.

FileSite Utilities

The following utilities are also provided with the FileSite application:

 WorkSite Viewer, which allows you to view multiple documents at once.

 WorkSite Portable, an application that lets users download WorkSite 
documents to a local computer and work on them when they are not 
connected to a WorkSite server.

 Integration modules for Microsoft Office and Adobe Acrobat, which allow you 
to use WorkSite functionality from these commonly used applications.

Key Features of FileSite

Along with the standard DMS features like version control and document 
versioning, FileSite offers key features in the following areas:

 “E-mail Management”

 “Matter-Centric Collaboration”

 “Building an Electronic Case File”

 “Matter-Centric Navigation”

 “Worklists”

 “Document Profile Information”

 “Search”

 “Relating Documents”

 “Security”

 “Accessibility Features”

NOTE FileSite is one of several WorkSite client 
applications. Others include DeskSite™, OffSite, and 
WorkSite Web.
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E-mail Management

FileSite allows you to save e-mail messages and their attachments to WorkSite by 
dragging them from Outlook folders and dropping them into WorkSite folders. 
Once added to WorkSite, e-mails can be stored in the same searchable repository 
as other documents, and typical document functions can be performed with 
e-mails.

Matter-Centric Collaboration

Matter-centric collaboration (sometimes called engagement-centric collaboration) 
gives users an online space for contributing and consuming content related to a 
particular legal matter or engagement. FileSite provides containers (such as 
folders and Workspaces) that help you organize content by matter/engagement.

A matter-centric approach lets users easily and effectively collaborate and 
exchange information with each other. For example, to assign a matter/
engagement to a colleague or practice group, you can simply add it to the 
appropriate user or group’s My Matters or My Engagements folder.

Building an Electronic Case File

The Workspace serves as the main container for all the information you need to 
handle the case or engagement. In the legal field, it is the electronic equivalent of 
the expandable paper case file or redweld. You can organize the content by 
creating multiple tabs and distributing the information accordingly. Each tab allows 
you to group and categorize different types of information for easier access and 
use. Folders are containers within Workspaces that act as the electronic 
equivalent to the sub-files within a matter.

Each container in WorkSite has its own security and metadata depending on who 
requires access. See “Document Grid” on page 81 for more information.

Matter-Centric Navigation

Matter-centric navigation is achieved by using shortcuts to keep all of your 
matters, favorite containers, or specific Workspaces easily available, eliminating 
the need to drill down through multiple containers. The WorkSite Tree Frame in 
Outlook contains two customizable link lists—My Matters and My Favorites—that 
make it easy to set up matter-centric navigation, which corresponds to your legal 
practices.

My Matters is a container of shortcuts to your personal list of matters, similar to a 
personal filing cabinet. Menu options make it easy to share your My Matters folder 
with others and to subscribe to the My Matters folders belonging to other users—if 
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they are shared. For example, a matter can be automatically assigned to a lawyer 
when the case is opened, and the lawyer’s administrative assistant can subscribe 
to the lawyer’s matters.

See “My Matters” on page 79 for more information.

My Favorites is a customized link list that you create to meet your navigation 
needs. Within My Favorites, you can place shortcuts to documents, folders, or 
Workspaces from multiple WorkSite libraries.

See “My Favorites” on page 79 for more information.

Worklists

Each WorkSite Server that you are logged into has a Document Worklist and a 
Matter Worklist associated with it. The Document Worklist maintains a list of 
recently accessed documents. The Matter Worklist contains a list of recently 
viewed Workspaces. This provides another efficient way to retrieve information 
that you worked with in the recent past.

See “Folder List Components” on page 77 for more information.

Document Profile Information

A profile is a set of data about documents and other WorkSite objects (such as 
who added the item and when it was added). WorkSite uses this information 
(called metadata) to classify, organize, and locate items in the system.

Document profiles allow you to search for documents you need without having to 
remember file names or where the documents are stored on the file server. 
Table 2 lists the information typically contained in a document profile. 

Table 2  Document Profile Information Fields 

Profile Field Description

Document Number Unique number automatically assigned by WorkSite. 

Version Version number of the document. 

Description Descriptive information of the document, up to 254 
characters. 

Name Short name of the document, up to 16 characters. 

Type Application used to create the document and open it 
again. For example, WORD for Microsoft Word. 

Database Library in which the document is stored. For example, 
DMS1, DMS2, and so on. 
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Author User who created the document. 

Operator User currently working on the document. 

Class User-defined classification of the document. For 
example, DOC for a document. 

Client Custom field with special properties based on business 
needs, used to identify the document. 

Matter Custom sub field used to identify the document and 
dependent on the entry in the Client field. 

Custom Fields Additional fields with special properties based on 
business needs, used to classify the document. 

Creation Date Date the document was created. 

Note: Server settings enable you to view the create 
date/time profile property of the documents in FileSite 
in two ways: 

File Date. The date/time that a document was created 
locally, before it was imported into FileSite. 

System Date. The date/time that a document was 
created in the server or imported into the server. 

For more information on server settings, refer to the 
WorkSite Server Administrator’s Guide.

Last Edit Date Most recent date the document was edited. 

Note: Server settings enable you to view the edit date 
profile property of the documents in FileSite in two 
ways: 

File Date. The date that a document was last edited 
locally, before it was imported into FileSite. 

System Date. The date that a document was last edited 
in the server. 

For more information on server settings, refer to the 
WorkSite Server Administrator’s Guide.

Table 2  Document Profile Information Fields 

Profile Field Description
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Because profile fields can be customized, the items listed in Table 2 may not 
match those in your organization’s WorkSite system.

Last Edit Time Most recent time the document was edited. 

Note: Server settings enable you to view the edit time 
profile property of the documents in FileSite in two 
ways: 

File Date. The time that a document was edited locally, 
before it was imported into FileSite. 

System Date. The time that a document was edited in 
the server.

For more information on server settings, refer to the 
WorkSite Server Administrator’s Guide.

File Entry Date the source file was originally created by the 
originating application.

File Edit Date the source file was last edited by the originating 
application.

Last User Name of the user who most recently edited the 
document in WorkSite. 

Size Size of the document in number of bytes. 

Retain Days Number of days before the inactive document is 
eligible for archiving. 

Comment Comment associated with the document, up to 8,000 
characters, and fully searchable. 

Security / Modify (button) Creates an ACL of users and groups. 

Shared As Sets the default security levels. 

NOTE The  Shared to External Users icon indicates 
that a document is shared with external users. See 
“Understanding External Users and Groups” on page 88 for 
information about external users and groups.

Table 2  Document Profile Information Fields 

Profile Field Description
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Typically in legal enterprises, the names and purposes of the Custom fields are 
customized so that Custom1 represents the Client and Custom2 represents the 
Matter, in a parent-child relationship. They are used to sort and search for content 
related to a particular Client-Matter. 

Search

FileSite provides powerful searching capabilities to help you find your documents. 
You can search for documents according to document profile information, the full 
text of document comments, or the full text of documents themselves. After you 
perform a search, you can save the search criteria and search results for later 
reference. You can re-run the search for updates, and also share your saved 
searches with other users.

The Search function is integrated, so you can retrieve and open documents from 
WorkSite within Microsoft Office and Adobe Acrobat and Acrobat Reader 
applications.

See Chapter 6 for more information.

Relating Documents

In addition to grouping documents by their location, you can create relations 
between documents, such as a contract and an addendum. For example, a 
contract could be related to an addendum to the contract and to other documents 
used to create the contract.

An  icon indicates that a document is related to one or more other documents. 
See “Relating Documents” on page 174 for more information.

Security

WorkSite’s security model allows you to share information and collaborate on 
projects while keeping content secure. WorkSite ensures that users have access 
only to those documents that they are authorized for. Even search results are 
filtered according to a user’s access rights.

There are two types of security in WorkSite: role-based security and object-based 
access rights.

In role-based security, roles define the operations that a user can or cannot 
perform within the WorkSite system. The WorkSite Administrator assigns 
privileges to a role and assigns a role to every WorkSite user.
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Object-based access rights are security settings defined on WorkSite containers. 
The owner of the container (at the time of creation) sets security by deciding which 
users require access to the container, and which users should not be allowed 
access to it. By default, items added to a container inherit the security settings of 
the container.

See “WorkSite Security Concepts” on page 86 for more information.

Accessibility Features

FileSite is designed to work with special features that provide greater accessibility 
for users who are visually or hearing impaired, or otherwise physically challenged, 
in accordance with U.S. Section 508 government regulations. FileSite supports 
most assistive technologies and has been previously tested with the following 
versions.

FileSite accessibility features include:

 Red and green icons indicating correct or incorrect entries in required fields.

 Keyboard shortcuts as alternatives to mouse-clicking on dialog boxes and 
menus.

 Text explanations of graphics and icons.

 The ability to turn off the warning that the search scope is limited to a container 
on the Search dialog box.

For specific navigational information, see the following sections:

 “Navigating in the Folder List”

 “Navigating in the Document Grid Without a Mouse”

 “Menu Options and Toolbar Buttons”

Table 3  Supported Assistive Technology

Assistive Technology Operating System 

Jaws 4.02 Windows 2K Pro 

Window Eyes 4.2 Windows/XP 

Super Nova Pro 5.x Windows/2K Pro 

IBM Home Page Reader 3.x Windows 2K Pro 

ZoomText 7.1 Windows/NT 4.x

Magic 8.0 Windows 2K Pro
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New Features in This Release

This section describes the new features and improvements made in FileSite 8.5:

 “Support for Microsoft Office 2010”

 “Inserting WorkSite Hyperlinks”

 “Filing Sender’s Copy of E-mail to a WorkSite Folder”

 “Saving Attachments”

 “Working Offline”

 “Records-Management Enhancements”

 “Visual Representation of Document Security”

 “Quickview Enhancements”

 “Prevention of Flat Filing”

 “File Fidelity”

 “Identification of Filed Messages in Outlook”

 “Attachment Handling”

Support for Microsoft Office 2010

This enhancement enables the integration of FileSite features with Microsoft 
Office 2010 32-bit version.

Inserting WorkSite Hyperlinks

In Microsoft Office integration with FileSite, you can now insert a WorkSite 
hyperlink to a WorkSite document into another WorkSite document using the IWL 
protocol. See “Inserting a WorkSite Hyperlink” on page 285 for more information.

Filing Sender’s Copy of E-mail to a WorkSite Folder

FileSite now files the sender’s copy of an e-mail to a WorkSite folder when the 
same WorkSite folder e-mail address is entered in the BCC field of the e-mail. The 
information entered in the BCC field is now preserved. Additionally, FileSite can 
be configured to set the e-mail’s security level to either Public or Private.
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Saving Attachments

FileSite now provides greater flexibility for filing one or more attachments.

 You can now save an attachment as a new version of an existing WorkSite 
document.

 You can now save attachments from multiple e-mails at the same time.

Working Offline

When you have made changes to WorkSite items while working offline, file 
resynchronization between FileSite and WorkSite occurs automatically in the 
background the next time you reconnect to WorkSite. See Chapter 10 for more 
information.

Records-Management Enhancements

Enhancements to records management include the functionality to undeclare a 
document that is declared as a record. However, the undeclare operation can be 
performed only within a specified time period from when the document was 
declared. Once undeclared, you can modify the document’s metadata, and 
redeclare it. See “Undeclaring a Record” on page 178 for more information.

Visual Representation of Document Security

Icons for the different containers now display keys to indicated that the containers’ 
security is inherited. See “Inherited Security” on page 86.

Quickview Enhancements

A new e-mail quick viewer for DXL and MSG files enables you to preview 
documents in the Outlook browse pane without opening them. The viewer 
provides a clearer view that better emulates Outlook.

Prevention of Flat Filing

Your WorkSite Administrator may not allow users to perform flat filing (saving 
items outside of a specific Workspace or Folder). Preventing flat filing helps to 
ensure consistent filing by Matter and by Client and simplifies the filing and 
retrieval of documents from WorkSite.

Flat-filing prevention affects how you perform the following tasks:
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 Import

 Save/Save As

 Copy

 Move

 Remove from Folder

If flat filing has been disabled, attempts to save items outside of a specific 
Workspace or Folder will cause an error message to display.

File Fidelity

Server settings enable you to view the create and edit date/time document profile 
properties in FileSite in two ways: 

 File Dates. The date/time that a document was created or edited locally, 
before it was imported into FileSite.

 System Dates. The date/time that a document was created/imported or edited 
in the server.

By default, the System date settings are enabled in the server. Consult your 
WorkSite Administrator to change the server settings. For more information, refer 
to the WorkSite Server Administrator’s Guide.

Identification of Filed Messages in Outlook

FileSite now identifies messages that have been successfully filed to 
WorkSite. When a message is filed to WorkSite, and a copy of the message 
remains in a user's mailbox on Exchange, a Filed icon appears in Outlook. 
Similarly, if a filing request fails, a Filing Failed icon appears.

NOTE Do not enable this feature on the server until all 
WorkSite applications (desktop clients, Web, Mobility, and 
server tools) are upgraded to WorkSite 8.5, as this feature is 
not compatible with earlier versions of the WorkSite 
applications.

NOTE Do not enable this feature on the server until all 
WorkSite applications (desktop clients, Web, Mobility, and 
server tools) are upgraded to WorkSite 8.5, as this feature is 
not compatible with earlier versions of the WorkSite 
applications.
FileSite Installation and User’s Guide  41

• 
• 
• 
•
•
•



Chapter 1 Introduction

42
Attachment Handling

In 8.5, you can easily save an e-mail attachment to WorkSite as a new 
document or as a new version of an existing document. See “Importing E-mail 
Attachments as Separate Documents” on page 158 for more information.
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CHAPTER 3  
The FileSite Desktop
This chapter describes the different elements of the FileSite desktop. It contains 
the following topics:

 “Overview”

 “Outlook Shortcut Pane/Bar”

 “Folder List”

 “Document Grid”

 “Document Results Frame”

 “Menu Options and Toolbar Buttons”

See Chapter 4 for more information on the functionalities associated with each 
element of the desktop.

Overview

The FileSite desktop window is modeled on the Windows Explorer and Outlook 
user interfaces. While the functionality is the same, the appearance of the FileSite 
desktop differs between Microsoft Outlook 2003, 2007, and 2010.

The FileSite desktop used with Outlook 2003 or Outlook 2007 contains display 
frames, menus and toolbars. FileSite functionality is available on the toolbar that 
FileSite adds to Outlook, and on the WorkSite menu. See Figure 19 and Figure 
20.
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The user interface for Outlook 2010 has a ribbon bar in place of the traditional 
menu bar. The functionality accessed from the FileSite toolbar and the WorkSite 
menu in previous versions is available on the Home and WorkSite tabs in the 
ribbon bar. See Figure 21.

Figure 19 FileSite Desktop, Outlook 2003
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Figure 20 FileSite Desktop, Outlook 2007
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Figure 21 FileSite Desktop, Outlook 2010

Menu Options and Toolbar Buttons

You use FileSite-specific menu options and toolbars to perform many tasks in 
FileSite. Table 4 and Table 5 show the keyboard shortcuts and toolbar buttons for 
frequently used functions in FileSite. Because menus and buttons are 
customizable by your WorkSite Administrator, your menus may not include all the 
default options described in the following tables.

NOTE In Outlook 2010, the Search Folders function can 
appear at the bottom of the Outlook tree or between the 
FileSite node and the WorkSite server node.

NOTE In Outlook 2010, you can resize the WorkSite icons 
that display in the ribbon bar. Refer to the WorkSite Desktop 
Client Customization Guide for details.
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Most keyboard shortcuts are a combination of ALT+S or SHIFT+F10, followed by 
the mnemonic (underscored letter) that appears on the menu option. When the 
same mnemonic is used in more than one menu option, you can use the shortcut 
more than once to get to the desired option. For example, use ALT+S, then D to 
select Add Documents. Type the shortcut again to select Document Profile 
Defaults.

Table 4  WorkSite Menu Options

Menu Option
Keyboard Shortcut
(Outlook 2003) Toolbar Icon

Login ALT+S+L –

Add Document ALT+S+D

Add Version ALT+S+V –

Search Documents ALT+S+S

Search Workspaces –

Other Search Forms – –

Refresh F5 or ALT+S+R

Configure Submenu

 Document Profile Defaults – –

 Email Profile Defaults – –

 Local Applications – –

 Security Templates – –

 Navigation Options – –

 General Options – –

 Change Preview Orientation – –

 Filing Status – –

Checkin/Synchronize ALT+S+C –
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Table 5  Document Menu Options

Menu Option
Keyboard Shortcut
(Outlook 2003) 

Toolbar Icon

Open SHIFT+F10+O –

Print SHIFT+F10+P –

View SHIFT+F10+V –

Forward SHIFT+F10+W –

Send Link Submenu

 To This Version – –

 To Latest Version – –

Check Out SHIFT+F10+K –

Check In SHIFT+F10+I –

Save As – –

Move SHIFT+F10+M –

Copy Submenu

 Copy – –

 Copy Document and Open – –

 Copy as New Version – –

 Copy as New Version and Open – –

Add Version SHIFT+F10+V –

Add to Folder – –

Refile SHIFT+F10+F –

Delete SHIFT+F10+D –

Unlock SHIFT+F10+U –

Remove from Folder SHIFT+F10+M –

Utilities Submenu

 Bulk Security Edit – –

 Convert to PDF –

 Send as PDF –

Add to My Favorites – –
 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Filing Toolbar
Filing Toolbar

Using the Filing Toolbar, WorkSite makes it easy to file e-mails and attachments. 
See Chapter 5 for more information.

Declare as Record SHIFT+F10+D –

UnDeclare as Record SHIFT+F10+U –

Document Info Submenu

 Versions – –

 History – –

 Related Documents – –

 Checked Out Information – –

 Where Used – –

Properties SHIFT+F10+E

Applications Submenu

 Local Applications Listed – –

Remove Relation – –

NOTE Work Online/Offline is an optional command that 
allows you to switch from working in online mode to OffSite 
without closing and relaunching the application. This option 
is added to the WorkSite menu in Outlook when you enable 
enhanced connection mode switching in FileSite, Microsoft 
Office Integration, and OffSite. See “Seamless Online/
Offline Transition” on page 250.

Table 5  Document Menu Options

Menu Option
Keyboard Shortcut
(Outlook 2003) 

Toolbar Icon
FileSite Installation and User’s Guide  75

• 
• 
• 
•
•
•



Chapter 3 The FileSite Desktop

76
Outlook Shortcut Pane/Bar

The Outlook Shortcut Pane/Bar contains icons representing shortcuts to 
important folders in Outlook. These shortcuts provide easy access to your most 
frequently used folders. FileSite adds WorkSite-specific shortcuts to this pane.

Refer to Microsoft Office Help for instructions on adding shortcuts to the Shortcut 
Pane/Bar.

Figure 22 Example Shortcut Pane

Folder List

The Folder List organizes and displays information about matters, folders, recent 
searches, and servers. It shows the hierarchical structure of all connected servers 
and libraries, as well as folders that facilitate matter-centric navigation, for 
example, My Matters, My Favorites, and the Matter Worklist.

See “Managing the Folder List” on page 89 for more information on performing 
operations within the Folder List.
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You can log into more than one server at a time. Each server you connect to 
appears as a tab at the bottom of the Folder list. When you click on the tab for a 
server, the entire hierarchical structure for that server appears.

Folder List Components

The FileSite desktop window’s Folder List contains the following components:

Figure 23 Example Folder List

Servers

The  Server icon is displayed immediately under the FileSite hierarchy 
heading. It represents the WorkSite servers to which you are currently connected. 
You may be connected to multiple WorkSite servers simultaneously, as shown in 
Figure 23. 

Checked Out Documents

The  Checked-out Documents icon appears for each WorkSite Server you 
are connected to. It contains a list of all documents currently checked out by you. 
The documents are displayed in the Document Grid.
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See “Checked-out Documents” on page 90 for more information on performing 
operations with the Checked-out Documents list.

Document Worklist

The  Document Worklist icon displays a list of links to the documents you 
most recently used or edited, from the libraries you have access to. One list is 
generated for each WorkSite Server you are attached to.

Click the icon to perform a search and display a combined list of your recently 
accessed documents in the Document Grid. The Worklist displays up to 40 
documents per WorkSite library. By default, documents in the worklist are sorted 
by the date they were last accessed.

See “Document Worklist” on page 91 for more information on performing 
operations with the Document Worklist.

Matter Worklist

The  Matter Worklist icon displays a list of the Workspaces for each matter 
you have recently accessed. There is one Matter Worklist for each WorkSite 
Server. Each matter in the Matter Worklist is represented by a  Workspace 
icon.

A Workspace may be further divided into tabs, represented by the  Tab icon. 
You can add  document folders or  search folders to tabs or directly to 
Workspaces.

See “Document Grid” on page 81 for more information on each type of container.

Click the  Matter Worklist icon to perform a search and display your most 
recently used or edited Workspaces. You can expand the Workspace nodes to 
view the tabs and folders it contains. The sort order is set by the date last 
accessed.

See “Matter Worklist Options” on page 63 for more information on how to set the 
maximum number of items to appear in the Matter Worklist.

Recent Searches

The  Recent Searches icon displays a list of searches you recently performed. 
Click the appropriate  Search icon displayed under Recent Searches to 
re-execute the search. (The search criteria for the most recent searches are 

NOTE This container may be captioned as Project 
Worklist or Engagement Worklist.
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stored as properties on the folder.) You can also edit the search criteria on the 
folder and run a new search. The Recent Searches list only retains searches 
performed during the current session—it refreshes each time you reopen the 
application.

See “Recent Searches” on page 92 for more information on performing operations 
with the Recent Searches folder and the search folders.

My Favorites

The  My Favorites icon displays a list of shortcuts to any items that you have 
added to your My Favorites list. You can add Workspaces, folders, and documents 
to your My Favorites list.

See “My Favorites” on page 93 for more information on performing operations 
with the My Favorites folder. 

My Matters

The  My Matters icon displays a list of Workspace shortcuts to matters that you 
are associated with. You have one My Matters list on each connected WorkSite 
Server. This folder contains Workspaces you have created, as well as the My 
Matters folders of other users to which you have subscribed.

See “My Matters” on page 92 for more information on performing operations with 
the My Matters folder.

WorkSite Explorer

The WorkSite Explorer node  displays a list of all the WorkSite libraries you 
have access to. It allows you to navigate through each library.

See “WorkSite Explorer” on page 95 for more information on performing 
operations with the WorkSite Explorer node.

Library
A  Library icon appears for each library available to you on a server. Under 
each library, the following Workspaces and folders associated with it appear:

 My Workspaces, represented by the  icon, is a list of Workspaces you 
created.

NOTE This folder may be captioned My Projects or My 
Engagements.
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 Other Workspaces, represented by the  icon, is a list of Workspaces 
created by other users that you can access.

 My Folders, represented by the  icon, is a list of folders you created.

 Other Folders, represented by the  icon, is a list of folders created by other 
users that you can access.

WorkSite Containers

Table 6 describes the types of container objects available in WorkSite.

Table 6  Types of containers in WorkSite

Container Type Description

Category The  My Favorites category and the  My Matters category are 
used to organize matters you are currently working on. For 
example, you can place all the matters for a single client under one 
category. Alternately, you can create a category of related matters 
or similar types of legal cases.

A category can contain only subcategories and Workspaces; it 
cannot contain folders and documents. You can set security at the 
individual category level.

See “Category” on page 96 for more information on commands 
associated with Categories.

Workspace A  Workspace is the master container and contains all 
information pertaining to a case. The Workspace contains tabs, 
folders and subfolders into which documents are saved.

Each Workspace has its own security and metadata that can 
include Client and Matter, Practice, Type of matter, Industry, 
Jurisdiction, Date Opened and Date Closed.

See “Workspace” on page 100 for more information on commands 
associated with Workspaces.

Tab The  tab is a subdivision of a Workspace that helps you organize 
your work. A Workspace can have multiple tabs.

A tab contains document folders and search folders, but cannot 
contain documents. You can allow other users access to tabs you 
create, based on the security you set on the tab. By default tabs 
inherit security settings from the parent Workspace.

See “Tab” on page 107 for more information on commands 
associated with tabs.

Folder  Folders are containers for static groups of documents. You can 
create folders and share them with other users. They provide a 
method for organizing and sharing documents easily.
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In addition, there are two different types of folders: document folders and search 
folders.

 A  document folder contains documents that are related and grouped 
together. By doing this, you can easily organize documents. Clicking a folder 
icon displays the list of documents in the Document Grid.

See “Document Folder” on page 111 for more information on commands 
associated with document folders. 

 A  search folder has pre-existing search criteria defined and contains 
documents which satisfy this criteria. Each search folder has its own security, 
depending on who requires access to the folder. When you create a search 
folder, you can set folder security to inherit security settings from the parent 
container. See “Search Folder” on page 123 for more information on 
commands associated with search folders.

Document Grid

The Document Grid displays either the content of a folder or the result of a search. 

Columns in the Document Grid

The Document Grid is presented as a table, sorted into sortable columns. See 
“Sorting Documents in the Document Grid” on page 129 for more information on 
how to use columns to sort the display of documents in the Document Grid.

Document Icon Column

The far left column in the Document Grid is the Document Icon column. This 
column displays icons representing the document type for each document in the 
grid.

NOTE The Document Grid can be customized to display 
other columns. See “Customizing the Document Grid” on 
page 129 for more information.
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Rank Column

The Rank column displays a relevancy rank against each result in a list of search 
results. The ranking is based on a relevance sort that is performed by the 
WorkSite server. 

Document Results Frame

The Document Results Frame displays information about the document selected 
in the Document Grid. It is divided into five tabs, as shown in Figure 24: 

Figure 24 Document Results Frame
Figure 25 The Document Results Frame tabs

Document Profile Tab

The Document Profile tab displays the profile information of the document 
selected in the Document Grid. The profile fields that appear in this tab are 
determined by registry settings created on your machine by your WorkSite 
Administrator. 

See “Document Profile Tab” on page 134 for information on operations you can 
perform with the Document Profile tab.

Quick View Tab

The Quick View tab displays a read-only image of the document selected in the 
Document Grid. It allows you to view a document without leaving the FileSite 
desktop. 

See “Quick View Tab” on page 134 for information on operations you can perform 
with the Quick View tab. 

Related Documents Tab

The Related Documents tab displays a list of documents that are related to the 
selected document. 

NOTE The Rank Column appears in the Document Grid 
only when a list of search results is displayed. If the column 
does not appear, see “Adding Columns to the Document 
Grid” on page 129.
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See “Related Documents Tab” on page 134 for information on operations you can 
perform with the Related Documents tab.

Document Versions Tab

The Document Versions tab displays a list of a document's versions.

See “Document Versions Tab” on page 134 for information on operations you can 
perform with the Document Versions tab.

History Tab

The History tab displays a list of activities performed on a document. See “History 
Tab” on page 134 for information on operations you can perform with the History 
tab.
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CHAPTER 4  
Using the FileSite Desktop
This chapter contains the following topics, which describe the FileSite desktop 
and the various operations you can perform:

 “WorkSite Security Concepts”

 “Role-Based Security”

 “Container-Based Access Rights”

 “Understanding External Users and Groups”

 “General Security Rules”

 “Using Elements of the Desktop”

 “Managing the Folder List”

 “Managing WorkSite Containers”

 “Managing the Document Grid”

 “Managing the Document Results Frame”

See Chapter 3 for an introduction to the elements of the FileSite desktop.
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WorkSite Security Concepts

Before you learn about operations performed with elements of the FileSite 
desktop, it is important to understand the key aspects of WorkSite security. In 
most cases, when you are unable to access an item in WorkSite, the reason 
involves the item’s security settings or your system privileges.

WorkSite security is designed to enable sharing of information and collaboration 
while simultaneously keeping content secure. There are two types of security in 
WorkSite:

 “Role-Based Security”

 “Container-Based Access Rights”

Role-Based Security

Roles define the operations that a user can perform within the WorkSite system. 
The WorkSite Administrator assigns roles to users and determines what privileges 
are given to each role. Users cannot change their own role assignments.

Container-Based Access Rights

Workspaces, tabs, and folders have individual security settings. The Owner of the 
container sets security at the time of creation after deciding which users need 
access.

There are three ways to set security on a WorkSite container:

 “Inherited Security”

 “Default Security”

 “Access Control List (ACL)”

Inherited Security

By default, most WorkSite containers and documents are set to inherit security 
settings from the parent container. That is, if you add a folder inside an existing 
folder, the new folder will inherit the security settings of the folder you put it in. 
Similarly, if you add a document to an existing folder, your document will inherit 
the security settings of the folder you put it in.
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Icons for the different containers indicate whether their security is inherited. As 
shown in Table 7, a normal icon indicates that the container has inherited security 
from the parent container. A key added to the image indicates that the container 
uses individual security.

Default Security

The available default security levels are:

 Private: Only the user who created the container, and other users and groups 
explicitly granted access rights, can access the container.

 View: All users can access the container but cannot add or remove items from 
the container unless explicitly assigned access rights.

 Public: All users can access the container unless explicitly denied access, but 
cannot add or remove items from the container unless explicitly assigned 
access rights. Users cannot create root level folders in the WorkSite library.

The Owner or a user with full access on the container can edit its default security 
levels.

Access Control List (ACL)

The Owner of a WorkSite container or a user with full access can assign specific 
access rights to individual users and groups in an Access Control List (ACL).

The access rights corresponding to each level are:

 No Access: Users cannot view the container in the WorkSite library.

 Read: Users cannot add, edit or remove items, but they can view the 
container and its contents.

 Read/Write: Users can add items to the container, but they cannot remove the 
container or change the container’s security.

Table 7   Example Inherited and Individual Security Container Icons

Icon Description

Category folder icon showing inherited security

Category folder icon showing individual security 
(key added)
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 Full Access: Users have full access to the container, with the same rights as 
the Owner of the container. Apart from being able to add, edit, and delete 
items from the container, they can also change the security settings on the 
container. 

Understanding External Users and Groups

An external user is a special type of WorkSite user account that your WorkSite 
Administrator can set up. This type of account helps manage user accounts for 
people outside your organization who require access to your WorkSite system. As 
with standard users, external users can be organized into external groups. For 
information about external users and groups in your WorkSite system, consult 
your WorkSite Administrator.

General Security Rules

The following general security rules are in effect in FileSite:

 When a group is granted access privileges to a container or document, the 
same access rights are applied to all users who are members of the group.

 WorkSite security is based on an optimistic model. This means that, whenever 
access privileges conflict, the greater access privilege is applied. For example, 
suppose you have Read access to a document because you are a member of 
Group 1. However, you also have Read/Write access to the document as an 

NOTE When you create an ACL, the access privileges 
you grant to specific users and groups are exceptions to 
the Default Security level you choose. For example, if a 
document is set to Public, then all users will implicitly 
have Read access to it. But a user who has been 
explicitly granted No Access will not be able to see the 
document, even though it is Public.

NOTE When you create an ACL for any Workspace 
item or folder item, including documents, only users and 
groups that have Read or higher access to the 
Workspace can be added to this list. In other words, only 
users and groups that are listed on the Workspace's 
ACL can be given access rights to the contents of the 
Workspace.
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individual user. In this case, because your individual access level is higher, 
you will have Read/Write access when you open the document.

 Roles take precedence over user/group access rights on WorkSite containers. 
For example, a user who has Full Access on a document folder generally will 
have the right to import documents into that folder. However, if a user’s role 
does not allow importing documents, the user will not be allowed to import.

 The Author (the user who created the document) and the Operator (the user 
currently working on the document) always retain Full Access, regardless of 
the Default Security level.

Using Elements of the Desktop

This section describes how to configure and use the elements of the FileSite 
Desktop.

Managing the Folder List

Operations that can be performed within the Folder List are discussed in this 
section. See “Folder List” on page 76 for an overview of the Folder List and its 
components.

Displaying the Folder List

In Microsoft Outlook, you can keep the Folder List as your main view. If you set 
the Folder List view and close Microsoft Outlook, you will see the Folder List when 
you reopen Microsoft Outlook.

 In Outlook 2003, click the View menu and select Folder List.

 In Outlook 2007, click the Go drop-down menu and select Folder List.

 In Outlook 2010, the Folder List view is the default, but you can modify view 
settings. Click the View tab and select the Navigation Pane drop-down menu.

NOTE In some systems, your WorkSite Administrator 
can configure WorkSite to resolve conflicts using a 
pessimistic security model. In this case, the lower 
access privilege of the user or group is applied. Contact 
your WorkSite Administrator for more information.
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Navigating in the Folder List

You can navigate within the Folder List using the mouse or the arrow keys.

Navigating in the Folder List with a Mouse
Nodes representing containers appear in the Folder List wherever there is a 
branch. Click the plus (+) symbol to expand a node; click the minus (-) symbol to 
collapse a node.

Navigating in the Folder List Without a Mouse
 Use the UP and DOWN arrow keys to move the cursor up and down in the 

tree.

 Use the LEFT and RIGHT arrow keys to open and close nodes in the tree. 
The plus (+) key expands a node and the minus (-) key collapses it.

 Use ENTER to select a worklist, folder, or saved search.

Managing Folder List Components

Operations that can be performed with components of the Folder List are 
described in this section. See “Folder List” on page 76 for an overview of the 
Folder List and its components.

Checked-out Documents
Click the  Checked-out Documents icon to display a list of all documents you 
currently have checked out. The documents appear in the Document Grid.

Right-click the Checked-out Documents icon to access the menu options 
described in Table 8.

NOTE When you select a worklist, folder or saved 
search, focus automatically shifts to the Document Grid, 
enabling you to use keyboard shortcuts to navigate in 
that frame as well. See “Menu Options and Toolbar 
Buttons” on page 72 for a list of keyboard shortcuts for 
frequently used functions. 

Table 8  Checked-out Documents menu options

Menu Option Function

Refresh Refreshes the contents of the Checked-out Documents list. 

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent 
results, so it is recommended that you use WorkSite 
menus.
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Document Worklist
Click the  Document Worklist icon, to display a combined list of your recently 
accessed documents. The documents appear in the Document Grid.

Right-click the Document Worklist icon to access the menu options described in 
Table 9. 

Matter Worklist
Click the  Matter Worklist icon to display a list of your recently accessed 
Workspaces. The documents appear in the Document Grid.

Right-click the Matter Worklist icon to access the menu options described in 
Table 10. 

See “Matter Worklist Options” on page 63 for more information on how to set the 
maximum number of items to appear in the Matter Worklist. 

Table 9  Document Worklist menu options

Menu Option Function

Import Allows you to import a document into the Worklist.

Note: This option may be disabled by your WorkSite 
Administrator.

Search Documents Opens the Search dialog box to search for documents in the 
Document Worklist. 

Refresh Refreshes the contents of the Document Worklist. 

New Allows you to create new documents. 

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.

Table 10  Matter Worklist menu options

Menu Option Function

Refresh Refreshes the contents of the Matter Worklist. 

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommend that you use WorkSite menus.
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Recent Searches
Click the  Searches icon under the  Recent Searches icon to view a list of 
your recently performed searches. Documents that fulfill the search criteria are 
displayed in the Document Grid. 

Right-click the Recent Searches icon to access the menu options described in 
Table 11. 

Right-click the Searches icon to access the menu options described in Table 12. 

My Matters
My Matters displays a list of shortcuts to your Workspaces. You can subscribe to 
another user’s My Matters folder if the user has granted you Read access. You 
cannot see items on a Workspace unless you have at least Read access.

Table 11  Recent Searches menu options

Menu Option Function

Remove all searches Empties the Recent Searches folder.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.

Table 12  Searches menu options

Menu Option Function

New Search Allows you to create a new search. This option is disabled 
in the Recent Searches right-click menu.

Delete Allows you to delete the search. 

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.
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Right-click the  My Matters icon to access the menu options described in 
Table 13. 

My Favorites
My Favorites displays a list of shortcuts to items you selected to add to your My 
Favorites list. You can add Workspaces, folders, and documents to your My 
Favorites list. In addition, you can create categories to organize your frequently 
used items.

Table 13   My Matters menu options

Menu Option Function

Synchronization Options

Note: This option appears 
only if you have installed 
OffSite. 

Displays the Sync Options dialog box to select folders and 
Workspaces for synchronization and set some parameters 
for minimizing the synchronization time. For more 
information, refer to the OffSite Installation and User’s 
Guide.

Add Shortcuts Adds shortcuts from other matters/Workspaces to My 
Matters.

Subscribe Allows you to access the My Matters folders of other users.

Refresh Refreshes the contents of the My Matters folder.

Move Disabled. You cannot move My Matters.

Delete Disabled. You cannot delete My Matters.

Rename Disabled. You cannot rename My Matters.

New Creates new Categories and Workspaces in My Matters.

Properties Opens the My Matters Properties dialog box.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent 
results, so it is recommended that you use WorkSite 
menus.
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Right-click the  My Favorites icon to access the menu options described in 
Table 14. 

Adding Documents to My Favorites
You can add documents (already in a WorkSite library) to your My Favorites list.

1. Select the document from the Document Grid.

2. Right-click the selected document to open the Document menu.

3. Select Add to My Favorites. The Add to My Favorites dialog box opens.

Table 14   My Favorites menu options

Menu Option Function

Synchronization Options

Note: This option 
appears only if you have 
installed OffSite. 

Displays the Sync Options dialog box to select folders and 
Workspaces for synchronization and set some parameters 
for minimizing the synchronization time. For more 
information, refer to the OffSite Installation and User’s 
Guide.

Add Shortcuts Adds shortcuts from other objects to the My Favorites 
folder.

Refresh Refreshes the contents of My Favorites.

Move Disabled. You cannot move My Favorites.

Delete Disabled. You cannot delete My Favorites.

Rename Disabled. You cannot rename My Favorites.

New Allows you to create new Categories.

Properties Opens the My Favorites Properties dialog box.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent 
results, so it is recommended that you use WorkSite 
menus.
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Figure 26 Add to My Favorites dialog box

4. Enter a name for the document.

5. Click OK to add the document to your My Favorites list.

WorkSite Explorer
The WorkSite Explorer node displays a list of all the libraries you can access. It 
allows you to navigate through the folders and Workspaces in each library. Under 
each WorkSite library, you can expand the following nodes to locate documents:

 My Folders

 Other Folders

 My Workspaces

 Other Workspaces
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Right-click the  WorkSite Explorer icon to access the menu options described 
in Table 15. 

Managing WorkSite Containers

Commands associated with WorkSite containers are discussed in this section. 
See “Document Grid” on page 81 for an overview of the various WorkSite 
containers.

Category

You can create a category in My Matters, in My Favorites, or within another 
category. You can set security on a category to make it available to a select list of 
users and/or groups.

Creating a Category in My Matters
1. Right-click the My Matters icon in the Folder List, point to New and select 

Category. The Create New Category dialog box opens.

Table 15  WorkSite Explorer menu options

Menu Option Function

Refresh Refreshes the contents of the WorkSite Explorer node. 

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.
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Figure 27 Create New Category dialog box, General 

2. Enter a Name for the category.

3. Enter a Description for the category.

4. To define the security for the category, click the Security tab.
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Figure 28 Create New Category dialog box, Security

5. When you create a category, it has the same security settings as My Matters 
by default. To change these settings, clear the Inherit permissions from 
parent check box. The Default Security list is enabled.

6. To set the Default Security for the category, make a selection from the Default 
Security list. See “Default Security” on page 87 for more information. 

7. To specify greater or lesser access privileges for specific users and groups, 
make a selection from the Type of Access list. The access privileges that you 
grant to specific users and groups using this list are exceptions to the Default 
Security settings you select for the category. See “Access Control List (ACL)” 
on page 87 for more information. 

NOTE The security settings on a category determine 
whether a user can see the category, and whether the 
user can add or remove objects from the category.
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Creating a Category in My Favorites
1. Right-click the My Favorites icon in the Folder List, point to New and select 

Category. The Create New Category dialog box opens. 

Figure 29 Create New Category dialog box, My Favorites

2. Enter a Name for the category.

3. Enter a Description for the category.

4. Click OK.
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Modifying a Category
Right-click the category in the Folder List to access the menu options described in 
Table 16.

Workspace

You can create a Workspace in My Matters or in a category. You can also set 
security on Workspaces created under them. You can subscribe to any user’s My 
Matters folder to which you have access.

Creating a Workspace
1. Right-click the My Matters icon in the Folder List, point to New and select 

Workspace. The New Workspace Profile dialog box opens. 

Table 16   Category menu options

Menu Option Function

Add Shortcuts Adds shortcuts from other objects to the category.

Subscribe Disabled. You cannot subscribe to a category. 

Refresh Refreshes the contents of the category.

Move Moves the selected category to another category. You can 
also create a new category to move the selected category 
into.

Delete Deletes the category from the WorkSite library. You must have 
Full Access on the category to perform this operation.

Rename Renames the category.

New Creates a new category or Workspace in the selected 
category.

Properties Opens the Category Properties dialog box. 

Outlook native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.

NOTE The dialog box on your system may not contain 
every field that appears in the default dialog box. Your 
WorkSite Administrator can customize the profile to 
meet your business needs.
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Figure 30 New Workspace Profile dialog box

2. Enter a Name for the Workspace. In many cases this will be a Client/Matter 
pair.

3. Enter a Description for the Workspace.

4. Select a Location from the list. The Location is the name of the library where 
the Workspace will reside.

5. You are automatically entered as the Owner of the Workspace.

6. Enter or select the Client and Matter that are associated with the Workspace, 
if required.

7. Enter or select fields in the Other Properties area, such as Category, 
Industry, and Jurisdiction, if required.

8. To set the Default Security for the Workspace, make a selection from the 
Shared as list. See “Default Security” on page 87 for more information.

9. To define the Security for the Workspace, click Modify. The File Permissions 
dialog box opens.
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Figure 31 File Permissions dialog box

10. To specify greater or lesser access privileges for selected users and groups, 
make a selection from the Type of Access drop-down list. The access 
privileges that you grant to specific users and groups using this drop-down list 
are exceptions to the Default Security settings you select for this Workspace. 
See “Access Control List (ACL)” on page 87 for more information. 

NOTE The security settings on a Workspace 
determine whether a user can see the Workspace and 
whether the user can add or remove objects from the 
Workspace.
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Modifying a Workspace
Right-click the created Workspace to access the menu options described in 
Table 17. 

Table 17  Workspace menu options

Menu Option Function

Add Shortcuts Adds shortcuts from other objects to the Workspace.

Search Documents Opens the Search dialog box.

Send Link Opens a new e-mail message with the selected object link 
as an attachment.

Show Web View Opens the WorkSite Web page in the document pane.

Show Hidden Tabs Displays tabs that are hidden. Refresh hides the tabs that 
have been displayed by this option.

Refresh Refreshes the contents of the Workspace.

Refile Applies the Workspace profile and security information to all 
tabs and folders within it. You have the option of modifying 
the security of folders that do not inherit security.

Move Moves the selected Workspace to a category. 

Create Shortcut Opens a browse dialog box and allows you to select a 
Workspace or folder to add as a shortcut.

Delete Deletes the Workspace from the WorkSite library. You must 
have Full Access on the Workspace to perform this 
operation.

Rename Renames the Workspace.

New Creates new document folders, search folders, and tabs.

Add to My Matters Adds a shortcut to the selected Workspace to your My 
Matters list.
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Changing Workspace Profile Information
You can edit profile information of Workspaces you have created, and you can 
also edit Workspaces created by others if you have been granted Full access to 
them.

1. Select the Workspace. 

2. Right-click or press SHIFT+F10 to access the menu. 

3. Choose Properties from the menu. The Properties dialog box opens. 

4. Click Workspace Properties to open the Workspace Properties dialog box. 

5. Add or change the profile information in the same way you would set the 
profile information when creating a new Workspace. See “Creating a 
Workspace” on page 100. 

6. When you click Save to save your changes, you are prompted to Refile. This 
will cause all documents and folders in the Workspace to take on the changes 
you made to the Workspace metadata and security settings. Click Yes to refile 
or No to save your changes without refiling the Workspace.

Add to My Favorites Adds a shortcut to the selected Workspace to your My 
Favorites list. 

Properties Opens the Workspace Properties dialog box.

WorkSite Miner

Note: This option is 
added to the menu using 
a registry key. Contact 
your WorkSite 
Administrator for more 
information. 

Opens the WorkSite Miner window with the scope keyword 
followed by the name of the database in the query box. For 
more information about using WorkSite Miner, refer to the 
Express Search User's Guide.

Note: An error message appears in the following situations: 

 If the Express Search agent is not running in the system 
tray

 If you try to launch WorkSite Miner when Express 
Search is busy or when a lookup window or Properties 
dialog box is open

 If you invoke it from a WorkSite server that is not 
detected by the Express Search agent

Table 17  Workspace menu options

Menu Option Function
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Refiling a Workspace
Workspaces have profile properties. If you have Read/Write access on a 
Workspace, you can change the properties of the objects it contains using the 
Refile option. 

The rules of inheritance when refiling in a Workspace are described in Table 18. 

To perform refiling in a Workspace:

1. Right-click the  Workspace icon in the Folder List to open the menu. 

NOTE If you perform a Refile command on a Workspace, 
all tabs, folders, subfolders, and documents under that 
Workspace take on the profile information of the Workspace. 
The transfer of profile information is cumulative. For 
example, when you refile a Workspace, the profile values of 
the Workspace are transferred to the tabs and folders and 
the documents contained in the folders. If the folders have 
additional properties, these properties are also passed to 
the documents inside the folders during the Refile operation.

NOTE Not all WorkSite objects can be refiled. For example, 
you cannot refile shortcuts, search folders, or document 
folders under search folders. When these objects exist on a 
Workspace that is refiled, they retain their original 
properties.

Table 18  Workspace Refiling Rules

Workspace to Tab  Parent Object: Workspace

 Refiled Object (inherits from parent): Tab

 Metadata: None

 Security: Set folder security to Inherited (from 
parent).

Workspace to Folder  Parent Object: Workspace

 Refiled Object (inherits from parent): Folder

 Metadata: Folder Metadata = Existing Folder 
Metadata + Parent (Workspace) Metadata (except 
CLASS/
SUBCLASS, TYPE, COMMENTS, OPERATOR)

 Security: Set folder security to Inherited (from 
parent).
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2. Select Refile. A message appears asking if you want to apply the container 
properties to all the objects in the container. See Figure 32. 

Figure 32 Apply profile from container message

3. Click Yes to perform the Refile operation. A Refiling dialog box shows the 
progress of refiling. If there are many objects to refile, this operation can take a 
few minutes. See Figure 33. 

4. If you select the Modify security of sub-folders that don’t inherit security 
option, only the security settings for those folders that are not set to inherit 
security from the parent are modified during the refiling of their parent 
container.

NOTE If you have Full Access to the item when you 
refile, a green check mark appears next to it. A yellow 
check mark indicates you have Read/Write access. If 
you do not have access to the item, a red cross mark 
indicates that it could not be refiled.
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Figure 33 Refiling dialog box 

5. Click Close to close the Refiling dialog box. You can also select the Close 
this dialog when refiling is done option to close the dialog box 
automatically.

Tab

You can create a tab in a Workspace and make them available to other users 
based on the security settings on the tab. To create a tab, you must have Full 
Access to the Workspace in which it is created. 

Creating a Tab
1. Right-click the  Workspace icon in the Folder List, point to New and select 

Tab. The Create New Tab dialog box opens. 
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Figure 34 Create New Tab dialog box, General

2. Enter a Name for the tab.

3. Enter a Description for the tab.

4. To define the Security for the tab, click the Security tab. 
8 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Using Elements of the Desktop
Figure 35 Create New Tab dialog box, Security

When you create a tab, it has the same security settings as the Workspace by 
default.

5. If you wish to change these settings, clear the Inherit permissions from 
parent check box. The Default Security list is now enabled.

6. To set the Default Security for the tab, make a selection from the Default 
Security list. See “Default Security” on page 87 for more information. 

7. To specify access privileges for selected users and groups, make a selection 
from the Type of Access list. The access privileges that you grant to specific 
users and groups using this list are exceptions to the Default security setting. 
See “Access Control List (ACL)” on page 87 for more information. 

NOTE The security settings on a tab determine 
whether a user can see the tab and whether the user 
can add or remove objects from the tab.
FileSite Installation and User’s Guide  109

• 
• 
• 
•
•
•



Chapter 4 Using the FileSite Desktop

11
Modifying a Tab
Right-click the  Tab icon to access the menu options described in Table 19. 

Refiling a Tab
Tabs have generally inherit profile properties from the parent Workspace. If you 
have Read/Write access on a tab, you can change the properties of its documents 
and containers using the Refile option.

When you edit the properties of a tab, that is, make changes to its metadata or 
security, you are prompted to refile. This will cause all containers in the tab to take 
on the changes to the metadata.

Table 19  Tab menu options

Menu Option Function

Search Documents Opens the Search dialog box.

Add Shortcuts Adds shortcuts from other objects to the tab.

Send Link Disabled.

Refresh Refreshes the contents of the tab.

Refile Applies the tab security information to all its folders. You 
have the option of modifying the security of folders that do 
not inherit security.

Delete Deletes the tab from the WorkSite library. You must have 
Full Access on the tab to perform this operation.

Rename Renames the tab.

New Creates new document folders or search folders within the 
tab. 

Properties Opens the tab Properties dialog box.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s 
native menu with WorkSite objects can lead to 
inconsistent results, so it is recommended that you use 
WorkSite menus.
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The rules of inheritance when refiling in a tab are described in Table 20 

To refile a Tab:

The procedure for performing a Refile operation in a tab is similar to refiling in a 
Workspace. See “To perform refiling in a Workspace:” on page 105 for more 
information. 

Document Folder

Document folders are used to organize your documents, including e-mail 
messages.

Creating a Document Folder
1. Right-click a Workspace, Tab, or Document Folder icon in the Folder List, 

point to New and select Document Folder. 

2. To create a subfolder, right-click the  Folder icon under which you want to 
create the subfolder. You can also access the folder menu by pressing 
SHIFT+F10.

The Create New Folder dialog box opens. 

Table 20  Tab Refiling Rules

Tab to Folder

 Parent Object: Tab 

 Refiled Object (inherits from parent): Folder

 Metadata: Because Tabs do not have Metadata, Folder 
Metadata = the Tab’s Parent Workspace Metadata (except 
CLASS/SUBCLASS, TYPE, COMMENTS, OPERATOR)

 Security: Set folder security to Inherited (from parent).

NOTE You must have authority to create a subfolder 
within that folder. The Owner of the folder sets the 
security upon creation and can grant security options to 
other users. You can create subfolders under other 
users’ folders if you are given authority to do so. Your 
WorkSite Administrator can disable the ability to create 
subfolders under other users’ folders. 
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Figure 36 Create New Folder dialog box, General

3. Enter a Name for the document folder.

4. Enter a Description for the document folder.

Generating a Folder E-mail Address
If your WorkSite system includes the optional WorkSite Communications 
Server, a FileSite folder with an e-mail address can receive e-mails 
automatically. 

1. Click the  E-mail Address button for FileSite to automatically create a 
unique e-mail address for the folder. If you have entered Client/Matter profile 
information in the folder, this becomes the e-mail address, followed by the 
name of the WorkSite library and the name of your WorkSite Communications 
Server domain. For more information about how to use FileSite features with 
the WorkSite Communications Server, contact your WorkSite Administrator.

2. To set security on the document folder, click the Security tab. 
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Figure 37 Create New Folder dialog box, Security

When you create a folder, it has the same security settings as the Workspace 
by default.

3. If you wish to change these settings, clear the Inherit permissions from 
parent check box. The Default Security list is now enabled.

4. To set the Default Security for the folder, make a selection from the Default 
Security list. See “Default Security” on page 87 for more information. 

5. To specify access privileges for selected users and groups, make a selection 
from the Type of Access list. The access privileges that you grant to specific 
users and groups using this list are exceptions to the Default security setting. 
See “Access Control List (ACL)” on page 87 for more information. 

NOTE The security settings on a folder determine 
whether a user can see the folder and whether the user 
can add or remove documents from the folder.
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6. To set the folder profile information, select the Profile tab. Documents that you 
add to the folder after you set the profile data inherit the profile information 
from the folder. 

Figure 38 Create New Folder dialog box, Profile

7. Click Add/Edit to define the Document Folder profile. The Folder Profile 
dialog box opens. 

NOTE Your WorkSite Administrator may customize the 
Folder Profile dialog box on your system to display 
different fields, based on your company’s business 
needs.
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Figure 39 Folder Profile dialog box 

8. Enter or select a value for each field, as appropriate. You can use the Look up 
button to select a value. A Look up dialog box opens. Figure 40 is an example 
of the Look up dialog box for the Author field. 
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Figure 40 Select Internal Author dialog box

9. Select an appropriate value, click OK or press ENTER to add the profile 
selection. 

10. Repeat this process until you have chosen all the profile fields you want for the 
document folder. The profile fields selected are listed under the Profile tab. 
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Figure 41 Create New Folder dialog box, Profile, selected profile information

11. To remove a Property, select it and click Remove.

12. Click OK to create the folder with its profile information or Cancel to close the 
dialog box without creating a folder. 

Modifying a Document Folder
Right-click the created document folder to access the menu options described in 
Table 21. 

Table 21  Document Folder menu options

Menu Option Function

Add Document Imports a document to the folder.

Add Shortcuts Adds shortcuts from other objects to the folder.

Search Documents Opens the Search dialog box.
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Changing Document Folder Profile Information
You can edit profile information of your folders and folders created by others on 
which you have Full or Read-write access. 

1. Select the folder and right-click or type SHIFT+F10 to access the menu. 

2. Choose Properties from the menu. The Folder Properties dialog box opens. 

3. Select the Profile tab. Click Add/Edit to open the Folder Profile dialog box. 

4. Add or change the profile information in the same way that you would set the 
profile information when creating a new document folder. See “Creating a 
Document Folder” on page 111. 

Send Link Opens a new e-mail message with the selected object link 
as an attachment.

Refresh Refreshes the contents of the folder. 

Refile Applies the folder profile and security information to all 
folders within it. You have two options: 

 Modify security of subfolders that don’t inherit security

 Inherit metadata and security from the parent folder/
Workspace. 

Move Moves the selected folder to a Workspace. 

Create Shortcut Adds a shortcut to the folder from another container. 

Delete Deletes the folder from the WorkSite library. You must have 
Full Access on the folder to perform this operation.

Rename Renames the folder.

New Creates new document folders, search folders, mail 
messages, and documents.

Add to WorkSite 
Contacts

Adds the folder to your WorkSite Contacts list. Your system 
must include the WorkSite Communications Server and the 
folder must have an e-mail address for this option to 
function. 

Add to My Favorites Adds the selected folder to your My Favorites list. 

Properties Opens the Folder Properties dialog box.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.

Table 21  Document Folder menu options

Menu Option Function
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5. When you click Save to save your changes, you are prompted to Refile. Click 
Yes if you wish to Refile. This will cause all documents in the folder to take on 
the changes you made to the folder metadata or security.

6. Click No if you only wish to save your changes without refiling the folder. 

Refiling a Document Folder
The rules of inheritance when refiling in a document folder are described in 
Table 22. 

To refile a Document Folder:

The procedure for performing a Refile operation in a document folder is similar to 
refiling a Workspace. See “To perform refiling in a Workspace:” on page 105 for 
more information.

NOTE Changing profile information in an existing 
folder does not change the profiles of documents in the 
folder unless you Refile. See “Adding Documents to a 
Folder” on page 120 for more information. New 
documents that you import into the folder inherit profile 
information from the folder.

Table 22  Document Folder Refiling Rules

Folder to Subfolder

 Parent Object: Folder

 Refiled Object (inherits from parent): Subfolder

 Metadata: Subfolder Metadata = Existing Subfolder 
Metadata + Parent Folder Metadata (except CLASS/
SUBCLASS, TYPE, COMMENTS, OPERATOR)

 Security: Set subfolder security to Inherited.

Folder to Document

 Parent Object: Folder

 Refiled Object (inherits from parent): Document

 Metadata: Document Metadata = Existing Metadata + 
Folder Metadata (except TYPE, COMMENTS, 
OPERATOR)

 Security: Replace document security with folder 
security defaults.

NOTE For a folder that contains at least one document 
declared as a record, the Refile operation does not modify 
the document’s profile metadata. But, if you have Full 
Access to the declared document, its security is modified 
during refiling.
FileSite Installation and User’s Guide  119

• 
• 
• 
•
•
•



Chapter 4 Using the FileSite Desktop

12
Adding Documents to a Folder
You can add existing WorkSite documents to folders on which you are the Owner 
or have Full access or Read/write access.

1. Select the document from the Document Grid. 

2. Right-click the selected document to open the Document menu. 

3. Select Add to Folder. The Browse for folder dialog box opens. 

Figure 42 Browse for folder dialog box

4. Navigate to the folder where you want to add the document. You can also use 
the Express Search panel to find the folder. See “Express Search Panel” on 
page 266 for more information on using this panel. 

Click a container on the Shortcut Bar to display its contents, or select a folder 
from the Look in list.

5. Click Select to add the document to the folder.

You can also use drag-and-drop techniques to add documents to a folder. 

1. In the Document Grid, select the document(s) you want to add to the folder. 
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2. Depending on how you execute this operation, you can move, copy, or create 
a shortcut to a document or group of documents. 

3. With the left mouse click and the appropriate key depressed, move the pointer 
to the right of the appropriate folder icon in the Folder List. 

4. Release the mouse button. Continue from step 4 of the procedure for “Adding 
Documents to a Folder” on page 120. 

Importing Documents to a Folder
1. Select the folder in which you want to import a document.

2. Click the  Add Documents icon from the toolbar.

In Outlook 2010, click the  Add Documents icon from the Actions area of 
the WorkSite tab.

The Find File To Import to Folder dialog box opens. 

3. Navigate to the document you want to import and select it.

4. Click Open. The New Profile dialog box opens. 

5. Enter information in the fields of the New Profile dialog box.

6. Click OK.

Removing Documents from a Folder
Use the Remove From Folder option if you want to remove a document from a 
folder but not delete it from the WorkSite library. To remove a document from the 
WorkSite library, see“Deleting Documents” on page 170.

1. Select the document(s) in the Document Grid. 

2. Right-click the selected document(s) to open the Document menu. 

Table 23  Adding documents to a folder

If you want to Then

Move a document SHIFT+Left mouse-click+drag

Copy a document CTRL+Left mouse-click+drag
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3. Choose Remove From Folder. You get a message asking you to confirm the 
removal of the document. See Figure 43. 

Figure 43 Confirm Remove message

4. Click Yes to confirm the removal of the document from the folder.

Adding E-mails to a Folder
You can add one or more e-mail messages from Microsoft Outlook to a FileSite 
folder. Select the e-mail message, and drag it into a FileSite folder. If the folder 
has profile data, FileSite uses this information to profile the new e-mail message. 

If the Reuse profile of the first imported email option is selected in the Options 
dialog box (see “Import Settings” on page 60), you only need to enter the e-mail 
profile information once for each folder. FileSite then copies the information from 
the first e-mail message and applies it to other messages that you import.

Adding the Folder E-mail Address to WorkSite Contacts
1. Select the folder and right-click it to open the folder menu. 

2. Choose Add To WorkSite Contacts. The folder address appears in the 
WorkSite Contacts list. 

NOTE Based on role and access rights, the option to 
remove documents from folders may be disabled for 
some users. Contact your WorkSite Administrator for 
more information.

NOTE When the Prevent flatspace filing check box is 
selected on the WorkSite Server Service Manager, the 
Remove From Folder option is disabled for all users. 
If the WorkSite server you connect to has more than one 
database, ensure that the option is enabled for each 
database. Contact your WorkSite Administrator for 
more information.
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Sending an E-mail to a Folder
You can create new e-mail messages using Microsoft Outlook in the usual way. To 
send the message to a WorkSite folder, you can enter an address in the To, CC or 
BCC field of your e-mail message in several ways: 

 Type the entire folder e-mail address.

 Cut and paste the folder e-mail address from your WorkSite Contacts list. 

 Type a partial address and press CTRL+K.

FileSite automatically fills in the rest of the e-mail address from the WorkSite 
Contacts list.

 Use the look-up feature in the Microsoft Outlook Address Book.

FileSite files the sender’s copy of an e-mail to a WorkSite folder when the same 
WorkSite folder e-mail address is entered in the BCC field of the e-mail. 
Additionally, your WorkSite Administrator can configure FileSite to set the e-mail’s 
security level to either Public or Private. Contact your WorkSite Administrator for 
more information.

Deleting a Folder 
1. Select the folder that you wish to delete. 

2. Right-click the selected folder to open the Folder menu. 

3. Select Delete. A Confirm Delete dialog box opens, asking you to confirm the 
deletion of the folder.

4. Click Yes to delete the folder.

Search Folder

Search folders contain search results based on criteria that can be saved and 
reused.

Creating a Search Folder
1. Right-click a  Workspace,  Tab, or  Document Folder icon in the 

Folder List, point to New and select Search Folder. The Create New Search 
Folder dialog box opens. 

NOTE Deleting a folder does not delete its documents 
from the WorkSite library.
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Figure 44 Create New Search Folder dialog box, General

2. Enter a Name for the search folder.

3. Enter a Description for the search folder.

4. To define the Security for the search folder, click the Security tab. 
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Figure 45 Create New Search Folder dialog box, Security

5. When you create a search folder, it has the same security settings as the 
parent container, by default. If you wish to change these settings, clear the 
Inherit permissions from parent check box. The Default Security list is now 
enabled.

6. To set the Default Security for the search folder, make a selection from the 
Default Security list. See “Default Security” on page 87 for more information. 

7. To specify access privileges for selected users and groups, make a selection 
from the Type of Access list. The access privileges that you grant to specific 
users and groups using this list are exceptions to the Default security setting. 
See “Access Control List (ACL)” on page 87 for more information. 

NOTE The security settings on a search folder 
determine whether a user can see the search folder and 
whether the user can edit the existing search criteria 
specified on the folder.
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8. To select search criteria for the search folder, click the Search Criteria Tab.

Figure 46 Create New Search Folder dialog box, Search Criteria 

9. Some search information is already entered. Click Add/Edit to make changes 
to the search criteria. The Search dialog box opens. 
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Figure 47 Search dialog box

10. Enter any additional search criteria in the appropriate fields, or edit existing 
information. Click OK or press ENTER when all values are entered.

As FileSite is creating the search folder, it is also performing a search based 
on the criteria you entered. Each time you click the  Search Folder icon, 
FileSite performs the search again to see if any additional documents should 
be included in the results.

Modifying a Search Folder
Right-click the search folder to access the menu options described in Table 24. 

Table 24  Search Folder menu options

Menu Option Function

Import Imports a document to the folder.

Send Link Disabled.

Refresh Refreshes the contents of the folder. 
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Changing Search Folder Profile Information
In the case of search folders, you can edit their profile information by changing the 
search criteria that is specified on them. 

1. Select the search folder. 

2. Right-click the search folder to access the Search menu. 

3. Select Properties. The Folder Properties dialog box opens. 

4. Select the Search Criteria tab. 

5. Add or modify search criteria in the same way that you would set the search 
criteria when creating a new search folder. See “Creating a Search Folder” on 
page 123 for more information. 

6. Click OK to modify the search folder. 

Deleting a Search Folder
1. Select the Search Folder that you wish to delete. 

2. Right-click the selected folder to open the Folder menu. 

3. Select Delete. A Confirm Delete dialog box opens, asking you to confirm the 
deletion of the folder.

Move Moves the selected folder to a Workspace. 

Create Shortcut Adds a shortcut to the folder from another container. 

Delete Deletes the folder from the WorkSite library. You must have 
Full Access on the folder to perform this operation.

Rename Renames the folder.

New Creates new document folders, search folders, mail 
messages, and documents.

Add to My Favorites Adds the selected folder to your My Favorites list. 

Properties Opens the Folder Properties dialog box.

Outlook’s native menu Opens the Microsoft Outlook menu. Using Outlook’s native 
menu with WorkSite objects can lead to inconsistent results, 
so it is recommended that you use WorkSite menus.

Table 24  Search Folder menu options

Menu Option Function
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4. Click Yes to delete the folder.

Managing the Document Grid

Operations that can be performed within the Document Grid are discussed in this 
section. See “Document Grid” on page 81 for an overview of the Document Grid. 

Sorting Documents in the Document Grid

1. Click the column header once to sort it in ascending or descending 
alphanumerical order.

2. Click the column header again to reverse the sort order.

Selecting Documents in the Document Grid

Clicking a document in the Document Grid selects the document. You can select 
multiple documents by keeping the CTRL key depressed and clicking the desired 
documents. You can select a range by depressing the SHIFT key and then 
clicking on two documents in the grid; those two documents and all those in 
between are selected. If you are unable to use the keyboard and mouse 
simultaneously, we recommend enabling Windows Sticky Keys. Refer to Windows 
Help for details.

Refreshing the Document Grid

Click the  Refresh icon from the toolbar (or from the WorkSite section of the 
Home tab in Outlook 2010) to update the information displayed in the Document 
Grid with the latest information from the WorkSite library. The refresh option is a 
quick alternative to repeating the search or worklist request.

Customizing the Document Grid

You can customize the Document Grid to display any of the profile fields available 
in your WorkSite library. You can add, remove, or resize columns, and sort by 
specified columns of information. The Document Grid can be configured to display 
or hide document comments in the view. You can also create custom views for 
displaying WorkSite documents.

Adding Columns to the Document Grid
1. Right-click the column headings in the Document Grid.

NOTE When you delete a search folder, its documents 
are not deleted from the WorkSite repository.
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2. Select the Field Chooser option from the menu. The Field Chooser window 
opens.

Figure 48 Field Chooser window

3. Select WorkSite fields from the list. 

4. Choose a profile field from the list displayed.

5. Drag and drop the field into the column headings in the Document Grid, 
placing it where you want it to appear. 

Removing Columns from the Document Grid
1. Right-click the column heading you want to remove.

2. Select Remove This Column from the menu. The column is removed from 
the Document Grid. 

Resizing Columns in the Document Grid
1. Position the mouse pointer on the line between the column headers on the 

right side of the column that you want to resize.

2. Click and drag the divider between the column headers to resize that column. 

Displaying or Hiding Comments in the Document Grid
If a document has comments associated with it, those comments can be displayed 
in the Document Grid. To display comments, select AutoPreview from the View 
menu.
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Figure 49 Document Grid, AutoPreview

Creating Custom Views
Microsoft Outlook contains a list of predefined views that determine how 
document information displays in the Document Grid. FileSite views are added to 
the Outlook View menu. The default document view is the FileSite Default View. 
To view other available views: 

1. From the View menu, point to Arrange By. 

2. In the Arrange By submenu, point to Current View. A list of available views 
appears. The currently used view is checked, as shown in Figure 50. 
FileSite Installation and User’s Guide  131

• 
• 
• 
•
•
•



Chapter 4 Using the FileSite Desktop

13
Figure 50 Outlook View Menu Expansion

You can modify this view or create a custom view. Refer to Microsoft Office 
Help for more information.

In Microsoft Outlook 2010, you can see other available views by clicking the 
Change View drop-down menu on the View tab, as shown in Figure 51.
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Figure 51 Outlook 2010 Change View Option

Navigating in the Document Grid Without a Mouse

UP and DOWN arrow keys move the cursor up and down in the Document Grid. 
The PAGE UP and PAGE DOWN keys also move the Document Grid up or down. 
Use the HOME key to go to the top of the list and the END key to go to the bottom 
of the list. 

Managing the Document Results Frame

Operations that can be performed within the Document Results Frame are 
described in this section. See “Document Results Frame” on page 82 for an 
overview of the Document Results Frame.

The Document Results frame provides information on five tabs about a particular 
document. To change the location of the Document Results Frame, from the 
WorkSite menu, point to Configure, and select Change Preview Orientation.

In Outlook 2010, on the WorkSite tab, click the  Change Preview 
Orientation icon from the Configure area.

The location changes from right to bottom and vice-versa.
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Document Profile Tab

You can view a document's profile by selecting a document in the Document Grid 
and then clicking the Document Profile tab. The document’s profile information 
appears in the Document Profile tab. The profile fields that appear in this tab are 
determined by registry settings created on your machine by your WorkSite 
Administrator.

Quick View Tab

To view a document without leaving FileSite, select the document and click the 
Quick View tab. A read-only image of the document appears in the Quick View 
tab. 

Related Documents Tab

To see a list of the document’s relations, select the document and click the 
Related Documents tab. A list of the document's relations appears in the 
Related Documents tab.

See “Relating Documents” on page 174 for more information on how to create 
relations between documents.

Document Versions Tab

To see a list of the document's versions, select the document and click the 
Document Versions tab. A list of the document's versions appears in the 
Document Versions tab. You can configure the Document Grid to show only the 
latest version of the document or to show all versions of the document. See 
“Advanced Options” on page 66 for information on how to make this setting. 

History Tab

To see a list of events in the document's history, select the document and click the 
History tab. A list of activities performed on the document appears in the 
Document History tab.

The kinds and number of activities recorded for this history is determined by your 
WorkSite Administrator but typically includes: 

 Opening and closing the document in an integrated application.

 Recording how long the document was open. 

 Editing the document’s profile.

 Changing the access rights of the document.
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 Printing a document and how many pages were printed.

 Checking out, copying and/or checking in the document.

 Viewing the document.

 Sending the document via e-mail.

 Creating a new version of the document

 Locating (in the computer) where the activity took place.

 Recording comments about the activity.

Document Results Frame Push Pin

The PushPin allows you to control the relationship between the Document Grid 
and the Document Results Frame. Depending on the PushPin state, the 
Document Results Frame behaves differently when you click on an item in the 
Document Grid. You can set the PushPin separately for each tab in the Document 
Results Frame. Your WorkSite Administrator can set the default state and disable 
certain states.

To change the state of the PushPin, click the PushPin icon.

Table 25  PushPin States

PushPin State Tab Name Tab Behavior 

Up All tabs Goes blank

Down All tabs Automatically refreshes
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CHAPTER 5  
Working with Documents and 
E-mails
This chapter contains the following information about the document functions you 
can perform using FileSite:

 “Entering Document Profile Information”

 “Editing Document Profile Information”

 “Searching for Documents”

 “Opening Documents”

 “Viewing Documents”

 “Importing Documents”

 “Importing E-mails”

 “Exporting Documents”

 “Checking Out Documents”

 “Checking In Documents”

 “Copying Documents”

 “Moving Documents”

 “Document Links”

 “Deleting Documents”
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 “E-mailing Documents”

 “Inserting WorkSite Links into Outlook Objects”

 “Printing Documents”

 “Relating Documents”

 “Unlocking Documents”

 “Declaring a Document as a Record”

 “Undeclaring a Record”

 “Restoring Archived Documents”

 “Restoring Archived Document Shortcuts”

 “Displaying Document Information”

 “WorkSite Add-on Functions”

 “Creating New Documents”

 “Creating New Document Defaults”

 “Creating E-mail Profile Defaults”

 “Working with Security Templates”

 “Editing Security on Documents”

 “Application Setup in FileSite”

 “FileSite Features for Microsoft Outlook 2007 or 2010”

Document and E-Mail Functions

Document functions can be performed in the following ways:

 Accessing the Document menu with a right-click or SHIFT+F10 when the 
document is selected. 

 Selecting the desired document and clicking a button in the toolbar. See 
“Menu Options and Toolbar Buttons” on page 72 for more information on 
toolbar buttons.
8 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Document and E-Mail Functions
Table 26 provides an overview of the commands available on the Document 
menu. 

Table 26  Summary of Document menu commands

Commands Description See

Open Opens the document in its native application. If 
the application is not already running, it will be 
launched automatically. 

“Opening Documents” on 
page 148

Open Read Only Opens a read-only copy of the document in its 
native application. If the application is not 
already running, it will be launched 
automatically. 

“Opening Documents” on 
page 148

Print Prints the document. “Printing Documents” on 
page 173

View Opens the document in the WorkSite Viewer. Chapter 9

Forward Opens an e-mail message with the document 
attached. 

“E-mailing Documents” 
on page 170

Send Link submenu
“E-mailing Documents” 
on page 170

 To Latest Version Sends a link to the latest version of the 
document. 

 To This Version Sends a link to the current version of the 
document. 

Check Out Copies the document to your local or network 
drive and marks them as checked-out in the 
WorkSite library. This command is available 
only if the selected document is not checked 
out, archived or locked. This option is not 
available in offline mode.

“Checking Out 
Documents” on page 162

Check In Copies the checked-out document back to the 
WorkSite library. This command is available 
only if the selected document is checked out. 
This option is not available in offline mode.

“Checking In 
Documents” on page 163

Save As Copies the document to your local or network 
drive. This option is not available in offline 
mode.

“Exporting Documents” 
on page 159

Move Relocates the document to the desired 
Workspace and folder. This option is not 
available in offline mode, and from the 
Document Worklist.
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Copy Submenu
“Copying Documents” on 
page 165

 Copy Copies the document. 

 Copy Document and
     Open

Copies the document and opens it in its native 
application.

 Copy as New Version Copies the document and creates a new 
version of it.

 Copy as New Version
     and Open 

Copies the document, creates a new version, 
and opens it in its native application.

Add to Folder Adds the document to the desired folder. “Adding Documents to a 
Folder” on page 120

Add Version Imports a document and saves it as a new 
version of an existing document.

“Importing New Versions 
of Documents” on 
page 155

Refile Applies the folder profile and security 
information to the document. This option is not 
available on search folders.

“Refiling a Document 
Folder” on page 119

Delete Permanently removes the document from its 
folder and the WorkSite library. This command 
is available only if the selected document is not 
checked-out, archived or locked. This option is 
not available in offline mode.

“Deleting Documents” on 
page 170

Unlock Releases the document that is marked as 
“checked-out” or “In use” in the WorkSite 
library, allowing other users to open it. This 
command is available only if the selected 
document is checked-out or locked. This 
option is not available in offline mode.

“Unlocking Documents” 
on page 175

Remove from Folder Removes the document from the folder. This 
option is not available in offline mode.

“Removing Documents 
from a Folder” on 
page 121

Utilities submenu

 Bulk Security Edit Allows you to edit the security settings of 
multiple documents at the same time.

“Editing Security on 
Documents” on page 209

 Convert to PDF Converts an MS Office document to a PDF 
document.

“WorkSite Add-on 
Functions” on page 190

Table 26  Summary of Document menu commands

Commands Description See
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 Send as PDF Converts the document to a PDF document 
and sends it in an e-mail message.

“WorkSite Add-on 
Functions” on page 190

Add to My Favorites Adds a shortcut of the document to your My 
Favorites list.

“Adding Documents to 
My Favorites” on 
page 94

Declare as Record Declares that the document is a record and 
records that fact in the document history. Locks 
document.

“Declaring a Document 
as a Record” on 
page 177

UnDeclare as Record Undeclares a document that is declared as a 
record, and records that fact in the document 
history.

“Undeclaring a Record” 
on page 178

Document Info submenu
“Displaying Document 
Information” on page 181

 Versions Displays other versions of the document that 
may exist in the Document Versions tab of the 
Document Results Frame. This option is not 
available in offline mode.

 History Displays the activity history for the document in 
the History tab of the Document Results 
Frame. This option is not available in offline 
mode.

 Related Documents Displays a list of documents related to the 
selected document in the Related Documents 
tab of the Document Results Frame. This 
option is not available in offline mode.

 Checked Out
     Information

Displays information about the checked-out 
document.

 Where Used Lists the location and path of all folders where 
the document is placed.

Properties Opens the Properties dialog box displaying 
profile information for the document.

“Entering Document 
Profile Information” on 
page 144 and “Editing 
Document Profile 
Information” on page 146

Table 26  Summary of Document menu commands

Commands Description See
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Using Lookup dialogs

In FileSite, every document has a profile that contains information about it. (See 
“Document Profile Information” on page 34 for more information.) A document’s 
profile information is entered in one of the following dialog boxes, depending on 
the type of document function performed.

 New Profile dialog box

 New Version Profile dialog box

 Properties dialog box

 Search dialog box

Within each of these dialog boxes, some fields of profile information are required 
and some are not. Lookup dialog boxes are provided to enter information into 
these fields easily. When a  Lookup button appears next to a text-entry field, 
you can use a lookup dialog box to enter values into it. 

To use a lookup dialog box to enter values:

1. Click the  Lookup button next to the field. A selection dialog box opens that 
contains a list of valid entries for that field of profile information. Figure 52 
shows an example of a selection dialog box for the Author field of profile 
information. 

To move between fields in the following dialog boxes, use the TAB key. There 
are no keyboard shortcuts, since the fields and their names are customizable.

Applications submenu

“Integration with Other 
Applications” on 
page 308

 Local Applications
     Listed

Displays a list of local applications integrated 
with FileSite.

Remove Relation Allows you to cancel relations created between 
documents.

“Removing Relations” on 
page 175

Table 26  Summary of Document menu commands

Commands Description See
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Using Lookup dialogs
Figure 52 Select Internal Author dialog box

2. If the list of validated entries is long, enter a search string in the Show all 
possible entries that match field. Select Start with (the string occurs only at 
the beginning of the document) or Contains (the string appears anywhere in 
the document). 

3. You can select either internal or external authors. To see the list of external 
authors, select the External User option.

NOTE The  Shared to External Users icon 
indicates that a document is shared with external users 
(users outside your organization who need access to 
some locations in WorkSite). See “Understanding 
External Users and Groups” on page 88 for information 
about external users and groups.
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4. Select a WorkSite library from the Look in Databases list. Click Find Now to 
search the list. The search results are displayed again. 

5. Select an entry from the list and click OK. This entry appears in the relevant 
field of the document’s profile record. 

Entering Document Profile Information

When you create a new document, a new version of a document, or a copy of a 
document, FileSite prompts you to enter profile information for it.

The dialog boxes used to enter profile information for a new document, new 
versions of documents, and copies of documents are all customizable by your 
WorkSite Administrator. The dialog boxes that appear in your version of FileSite 
may appear different from the default ones shown here. See Figure 53 for the 
default appearance of the New Profile dialog box.

Figure 53 New Profile dialog box

To enter document profile information: 
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1. Enter appropriate values in the required fields and others of your choice. The 
icons to the left of the field appear if the field is required or if you have made 
an invalid entry.

 The  green exclamation point symbol indicates that profile information is 
required for this field.

 The  red X symbol indicates that the information entered in this 
text-entry box is not a valid entry for this profile field.

2. To set the Default Security, make a selection from the Shared as list. See 
“Default Security” on page 87 for more information. 

3. To define the Security, click Modify. The File Permissions dialog box opens.

Figure 54 File Permissions dialog box

NOTE The warning icons do not appear on the profile 
dialog box if Accessibility Features are turned on. See 
“Other Options” on page 65 for more information on how 
to turn on/off Accessibility Features. 

NOTE To use a  Lookup button, see “Using Lookup 
dialogs” on page 142 for more information. 
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4. To specify greater or lesser access privileges for specific users and groups 
make a selection from the Type of Access list. The access privileges that you 
grant to specific users and groups using this list are exceptions to the Default 
security settings you select. See “Access Control List (ACL)” on page 87 for 
more information.

5. Click OK to close the File Permissions dialog box.

6. Click Save to close the New Profile dialog box.

Editing Document Profile Information

You can edit the profile information on your documents or other users’ documents 
on which you have Full Access or Read/Write Access.

1. Select the document from the Document Grid.

2. Choose Properties from the Document menu. The Properties dialog box 
opens.

NOTE The dialog box in Figure 55 shows the default 
appearance of the Properties dialog box. The dialog 
boxes used to enter profile information are all 
customizable by your WorkSite Administrator, so your 
view of this dialog box may not match.
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Figure 55 Properties dialog box
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3. Make changes or enter new values in the appropriate fields. See “Entering 
Document Profile Information” on page 144 for steps on how to enter values in 
the fields. 

Searching for Documents

One of your most common tasks in FileSite is to search for documents on which 
you want to work. You can search for documents by:

 Clicking the  Document Worklist icon. This displays your combined list of 
recently accessed documents.

 Clicking the  Document Folder icon. This displays the documents 
contained in the current folder.

 Clicking the  Search Folder icon. This performs a saved search again and 
returns documents that meet the search criteria previously entered. 

 Clicking the  Search Documents icon and entering new search criteria to 
look for other documents. 

More detailed information on using FileSite’s extensive searching capabilities 
is available in Chapter 6. 

Opening Documents

1. Select a document from the Document Grid. 

NOTE FileSite offers an “autocomplete” feature. When 
you type the first few characters of the entry and press 
the TAB key, FileSite fills in the entry, if possible. You 
can turn off this feature using a configuration option. 
See “Other Options” on page 65 for more information.

NOTE Only the Author or Operator or users with Full 
Access or Read/Write access to a document can edit its 
profile information. 

NOTE Your WorkSite Administrator can enable your 
system to allow you to enter Child field information 
(such as Matter) without entering Parent field 
information (such as Client).
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Opening Documents
2. Choose Open from the Document menu. The keyboard shortcut for the Open 
command is CTRL+O. 

FileSite automatically opens the document in the primary application defined 
for this document type.

Opening Echo Documents

When you work on a WorkSite document, a copy is automatically echoed (saved 
as a backup) in your NRTEcho directory. You cannot open a file in your Echo 
directory. This feature prevents you from overwriting changes that you made to 
the document. You must first synchronize the document to incorporate the latest 
edits into the WorkSite repository. See “Synchronizing Echo Documents” on 
page 367 for more information. 

Opening Documents from an Integrated Application

When an application is integrated with FileSite, controls that are used to access 
WorkSite features are added to the application’s user interface. For example, you 
can open documents that are contained in a WorkSite library from inside the 
application by selecting WorkSite Open from the application’s File menu. 

See Chapter 7 for more information. 

Opening Documents from a Non-integrated Application

If you do not see the WorkSite Integrated Desktop when you select Open from an 
application’s File menu, then the application is not integrated with FileSite. 

To open a document from a non-integrated application: 

1. Locate the document in the WorkSite library.

2. Use FileSite’s Checkout function to save a local copy of the document on 
your local or network drive. See “Checking Out Documents” on page 162 for 
more information.

3. Open the local copy of the document from within the non-integrated 
application.

NOTE To open a read-only copy of the document in its 
native application, choose Open Read Only from the 
Document menu.
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4. Work on the document and save it when you are finished. 

5. Use FileSite’s Checkin function to check the documents back into the 
WorkSite library. See “Checking In Documents” on page 163 for more 
information. 

Viewing Documents

You can view a document without opening it by using the WorkSite Viewer 
program or FileSite desktop’s Quick View tab in the Document Results Frame. 
You can view most word-processing, spreadsheet, and graphics documents in this 
way. 

Viewing Single Documents

You can view only one document at a time in the Quick View tab. Choose a 
document from the Document Grid and click the Quick View tab. The document is 
displayed in the Quick View tab of the Document Results Frame. 

CAUTION Do not change the filename of the document 
when you save it, or you will only be able to check it in as a 
new document.

NOTE If you are using an application that you think 
should be integrated with FileSite, but you do not see 
the WorkSite Integrated Desktop when you select Open 
from the File menu in that application, consult your 
WorkSite Administrator.

NOTE Documents that are being viewed are not locked or 
marked as “In use”. WorkSite Viewer or Quick View makes 
a temporary copy of the document.

NOTE You can view documents that are “In use” or 
checked out of the WorkSite library, but you cannot open 
them.
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Importing Documents
Viewing Multiple Documents

To view multiple documents simultaneously in read-only format, you must use the 
WorkSite Viewer program. Choose multiple documents from the Document Grid 
and select View from the Document menu. The selected documents open in 
read-only format in the WorkSite Viewer program.

From WorkSite Viewer, you can also search the full text of documents displayed in 
the Viewer frame, copy sections of documents to the clipboard, or print 
documents. See Chapter 9 for more information. 

Importing Documents

You can use the Add Document command in FileSite to add existing documents 
on your computer to a WorkSite library. Document import is not used for 
documents that already exist in the WorkSite library.

Importing Documents into a WorkSite library

1. Select the folder into which you want to import a document. 

2. Select Add Document from the WorkSite menu or click the 
 Add Document button in the toolbar.

In Outlook 2010, click the  Add Documents icon from the WorkSite tab.

NOTE Use this function to import only a few documents at 
a time. FileSite provides an additional administrative utility 
for importing documents in bulk. Contact your WorkSite 
Administrator for more information.

Table 27  When to perform a Document Importation

If you are trying to You should 

Return a previously checked-out 
document to the WorkSite library 

Use the Check in function

Return an echo copy of a document to the 
WorkSite library after you’ve edited it

Synchronize the echo document

Synchronize an echo document and you 
are unable to do so

Use the Add Document function to add it 
to the WorkSite library as a new document
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A standard Windows Find File to Import to Folder dialog box opens.

To move between fields in the following dialog boxes, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

Figure 56 Find File To Import to Folder dialog box

3. Select the file and click Open.

4. Depending on how FileSite is configured by your WorkSite Administrator, do 
one of the following:

 If FileSite opens the Save As dialog box, proceed to Step 5.

 If FileSite opens the New Profile dialog box, proceed to Step 7. 

NOTE The Find File to Import as New Version dialog 
box displays files and folders in your local or network 
drive. If the Delete local files after import option is 
selected, FileSite removes documents from your local 
or network drive after you import them to FileSite. See 
“Document Options” on page 63 for more information on 
turning off this option.
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Importing Documents
5. In the Save As dialog box, navigate to the Workspace or folder where you 
want to save the document. You can also use the Express Search panel to 
find a location. See “Express Search Panel” on page 266 for more information 
on using this panel.

 To display the names of documents already in the current location, click 
Show Documents in this folder.

 Enter the Author, Class, and Subclass (if any) fields. 

 Click Save.

6. If the folder’s metadata does not include all required fields, the New Profile 
dialog box opens for you to enter profile information. You can also open the 
New Profile dialog box by clicking Detail.

7. In the New Profile dialog box, select a location for the new document in a 
WorkSite library. Enter a folder path in the Location field, or click Select to 
view a list of options.

You can select from the following options:

 Databases and folders you have recently accessed

 All Databases. All libraries you are currently connected to are selected. 

 Choose Database. The Choose Database dialog box opens. 

NOTE When the document is added to the folder, the 
document automatically takes on the folder’s profile 
properties or metadata. If the folder’s metadata includes 
all required fields, FileSite automatically creates the 
profile without further input from you.
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Figure 57 Choose Database dialog box

Select a database from the list and click OK. 

 Choose Folder. If you select this option, the Choose a Folder dialog box 
opens.

Figure 58 Choose a Folder dialog box
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Importing Documents
8. Navigate to the Workspace or folder in which you want to save the search. You 
can also use the Express Search panel to find the Workspace or folder. See 
“Express Search Panel” on page 266 for more information on using this panel.

To navigate within this dialog box: 

a. Choose a Folder List component from the bar on the left. Alternately, you 
can select a container from the Look in list. A list of available Workspaces 
and folders appear in the grid.

b. Double-click, or select and press ENTER to drill into the container until you 
reach the folder in which you want to save the search. Click Select. If the 
folder has profile properties, these properties are automatically populated 
in the document’s New Profile dialog box.

9. Enter additional information as needed, and click Save. The document is 
imported into the WorkSite library.

Importing New Versions of Documents

You can use the Add Version command to import a document currently stored on 
your local or network drive, and save it as a new version of a document that 
already exists in the WorkSite library. 

1. Select the WorkSite document you want to import as a new version.

2. Choose Add Version from the WorkSite menu. 

In Outlook 2010, click the  Add Version icon from the WorkSite tab.

The Find File to Import as New Version of # dialog box appears. See Figure 
56. 

3. Select the file and click Open. The New Version Profile dialog box appears, 
with fields prepopulated with the profile information of the original WorkSite 
document.

4. Make any necessary changes and click Save. FileSite imports a new version 
of the original document. 

5. Select  Refresh from the toolbar (or from the WorkSite tab for Outlook 
2010), or click F5 to see the document displaying a new version number.

NOTE Make sure to supply information marked by the 
 icon.
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Importing E-mails

You can import e-mail messages to WorkSite and place them in a FileSite folder. 
Simply select the e-mail and drag-and-drop it into the desired folder. You can also 
import e-mail using the Move Email and Copy Email toolbar options. For more 
information, see “Move E-mails to WorkSite” on page 184 and “Copy E-mails to 
WorkSite” on page 186. 

To import an e-mail message:

1. Select the e-mail message from your Inbox, Sent Items folder, or other 
Outlook folder.

2. Drag and drop the e-mail message to the desired FileSite folder. The Save As 
dialog box opens (see Figure 59). 

NOTE Before you can import an e-mail, your WorkSite 
Administrator must set up a MIME document type and an 
E-MAIL document class. Contact your WorkSite 
Administrator for more information.

NOTE If the Auto Profile E-mails or Documents via 
Drag-and-Drop option is selected in the Options dialog 
box (see “Import Settings” on page 60), e-mail 
messages are auto profiled, and the Save As dialog box 
does not open to enter information about the e-mail 
message.

NOTE If the Auto Profile E-mails or Documents via 
Drag-and-Drop option is not selected, continue with 
Step 3. 
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Importing E-mails
Figure 59 Save As dialog box

3. In the Save As dialog box, navigate to the Workspace or folder where you 
want to save the document. You can also use the Express Search panel to 
find a location. See “Express Search Panel” on page 266 for more information 
on using this panel. 

 To display the names of documents already in the current location, click 
Show Documents in this folder.

 Enter information about the e-mail message in any required or optional 
fields. 

4. If the folder’s metadata does not include all required fields, the New Profile 
dialog box opens for you to enter profile information. You can also open the 
New Profile dialog box by clicking Detail. 

5. Enter additional information as needed, and click Save. The e-mail message 
is imported into the WorkSite library.

NOTE When the e-mail message is added to the folder, 
it automatically takes on the folder’s profile properties or 
metadata. If the folder’s metadata includes all required 
fields, FileSite automatically creates the profile without 
further input from you.
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Importing E-mail Attachments as Separate Documents

You can import e-mail attachments separately as new documents or as new 
versions of existing WorkSite documents. 

1. Select an e-mail message that contains attachments from your Inbox, Sent 
Items folder, or other Outlook folder.

2. Click the Save Attachments toolbar button.

In Outlook 2010, click the  Save Attachments icon from the WorkSite area 
of the Home tab.

3. To save a single attachment, proceed to “Importing a Single Attachment”. To 
save multiple attachments, proceed to “Importing Multiple Attachments”. 

Importing a Single Attachment

1. In the Save Attachments drop-down menu, select the name of an individual 
attachment. 

To save the attachment as a new document in WorkSite:

a. Select New Document. The Save As dialog box opens. See Figure 59. 

b. Navigate to the desired location in WorkSite.

c. Click Save.

To save the attachment as a new version of an existing WorkSite document:

a. Select New Version. The Select Document dialog box opens. 

b. Choose the existing WorkSite document. 

c. Click Select. The New Version Profile dialog box opens. 

d. Enter appropriate values in the relevant fields and click Save. 

Importing Multiple Attachments

1. In the Save Attachments drop-down menu, choose Select Attachments 
From List. The Select Attachments dialog box opens. 

NOTE Alternatively, you can open the e-mail message 
to access similar toolbar functions within the e-mail 
message window.
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Exporting Documents
Figure 60 Select Attachments dialog box

2. Select one or more attachments. Press the CTRL key to select multiple 
attachments.

To save the attachment(s) as a new document in WorkSite:

a. Click New Document. The Save As dialog box opens. See Figure 59. 

b. Navigate to the desired location in WorkSite.

c. Click Save.

To save the attachment as a new version of an existing WorkSite document:

a. Click New Version. The Select Document dialog box opens.

b. Choose the existing WorkSite document. 

c. Click Select. The New Version Profile dialog box opens. 

d. Enter appropriate values in the relevant fields and click Save. 

Exporting Documents

The Save As command copies a document from the WorkSite library to the local 
or network drive. 

NOTE When saving the attachment as a new version, 
you can select only one attachment. 
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You can only return an exported document to the WorkSite library as a new 
document. If you are planning to edit a document and then return it to the 
WorkSite library later, it is advisable to use the Check Out function. Also, when 
you export a document, it is not marked in the WorkSite library as “In use”, so 
other users may access the document and possibly update it while you are editing 
it.

For example, when you export documents as echo documents, you can edit them 
and then synchronize them back to the WorkSite library. When you work on the 
echo copies of these documents, the original documents in the WorkSite library 
are not locked or marked as “In use”. If other users edit the library copy of the 
document while you are editing the echo copy of the document, you will not be 
able to synchronize the document back to the WorkSite library. You can import the 
modified document only as a new document. See Chapter 11 for more information 
on Echo Documents.

Exporting Documents from a WorkSite library

1. Select the document from the Document Grid.

2. Select Save As from the Document menu. The Export dialog box opens.

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

NOTE If you try to export a document that is currently in 
your Echo directory with changes that have not been 
synchronized with the document in the WorkSite library, 
FileSite warns you that you are about to overwrite the 
document in the Echo directory. This feature prevents you 
from overwriting changes that you made to the document in 
the Echo directory. You can, however, export the document 
to another directory.
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Exporting Documents
Figure 61 Export dialog box

3. The default filename is the WorkSite number and version of the document. If 
you are exporting only one document, you can enter a new filename in the 
File Name field. 

4. Enter a destination directory to store the exported document in the 
Destination Path field. You can browse for a local or network directory by 
clicking Browse. 

5. If your system is set up to enable Document Echoing, you can export 
documents as echo documents. Select the Echo option. The Destination 
Path field becomes unavailable, because the destination directory is always 
the NRTEcho directory. 

6. Click OK to export the document. 

NOTE You may also want to use the document 
description as the filename. When you set the document 
option Use description for export, FileSite uses the 
document’s Description field as the filename. See 
“Advanced Options” on page 66.

NOTE To enable the document echoing option, contact 
your WorkSite Administrator.
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Checking Out Documents

You can check out individual documents from a WorkSite library for use outside of 
the WorkSite system. 

The document’s number and version becomes its filename when it is checked-out. 
For example, if you check out a Microsoft Word document with a document 
number of 378446 and a version number of 2, the document will be stored on your 
local or network drive with a filename of 378446_2.doc.

The document’s filename must remain unchanged if you want to be able to check 
it back into the WorkSite system. Do not change a checked-out document’s 
filename. The same filename is used during the document checkin process. See 
“Checkedout Info” on page 183 for information about a checked-out document.

To check out a document: 

1. Select the document from the Document Grid. 

2. Choose Check Out from the Document menu. The Checkout dialog box 
opens.

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

NOTE Individual document checkout is different from 
Portable document checkout. See “Working in Portable 
Mode” on page 348 for more information. 
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Checking In Documents
Figure 62 Checkout dialog box

3. If you are checking out the document for offline use, select the Integrated 
Check Out option. 

4. In the Destination Path field, enter the path to the directory where you want to 
save the checked-out document. If the Integrated Check Out option is 
selected, the document is saved to the NrPortbl directory. Click Browse to 
search for another directory on your local or network drive.

5. Enter a Due Date for the document to be checked in. 

6. Specify the reason for checking out the document in the Comments field.

7. Click OK to check out the document.

Checking In Documents 

You can return modified documents to FileSite using the Check in function. 

1. Click the  Checkedout Documents icon in the Folder List. This displays 
the list of checked-out documents for the selected server in the Document 
Grid. 
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2. Select the document you want to check in. 

3. Choose Check in from the Document menu. The Checkin dialog box opens. 

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

Figure 63 Checkin dialog box 

4. Select one of the following options:

 Replace Original. FileSite replaces the original document with the 
checked-in document. 

 New Version. FileSite checks in the document as a new version of the 
original document. The New Version Profile dialog box opens. See 
“Entering Document Profile Information” on page 144 for more information. 

NOTE You can select multiple documents from the 
Document Grid by keeping the CTRL key depressed 
and left-clicking the desired documents. If you hold 
down the SHIFT key and then left-click on two 
documents in the grid, the two documents and all those 
in between are selected.
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 New Document. FileSite checks in the document as a new document. 
The New Profile dialog box opens. See “Entering Document Profile 
Information” on page 144 for more information. 

5. (Optional) You can choose the following options:

 Keep checked out. The document remains checked-out, but your 
modifications are synchronized with the document in the WorkSite library.

 Delete local file after checkin. The file in the Portable directory is deleted 
and the document is checked in.

 Apply to all documents. The checkin option you selected (Replace 
Original, New Version, or New Document) is applied to all documents 
you selected. This option is available only when you select multiple 
documents.

6. Click OK to check in the document.

Copying Documents

You can make a copy of a document that is stored in a WorkSite library by 
selecting the document from the Document Grid, and then pointing to Copy from 
the Document menu.

The Copy submenu reveals the following options:

 Copy. FileSite makes a duplicate copy of the selected document. Depending 
on how FileSite is configured by your WorkSite Administrator, this option 
opens either the Save As dialog box or the New Profile dialog box.

 Copy Document and Open. FileSite makes a duplicate copy of the selected 
document and opens the new copy in its associated application. Depending 
on how FileSite is configured by your WorkSite Administrator, this option 
opens either the Save As dialog box or the New Profile dialog box.

NOTE Depending on how your system is configured, 
all checkin options may not be available. Your system 
may not allow you to modify existing documents. In this 
case, you can check in documents only as new 
documents.

NOTE If you checked out a document to the Portable 
directory (NrPortbl) on a different computer, you will 
receive an error message if you try to check it back in on 
your desktop computer. You must check in a document 
on the same computer on which you checked it out.
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 Copy As New Version. FileSite makes a duplicate copy of the selected 
document and creates a new version of the document. This option opens the 
New Version Profile dialog box.

 Copy As New Version and Open. FileSite makes a duplicate copy of the 
selected document, creates a new version of the document, and opens the 
new copy of the document in its associated application). This option opens the 
New Version Profile dialog box.

When you select Copy or Copy Document and Open, the Save As dialog box 
opens for you to enter profile information before FileSite adds the copy to the 
WorkSite library. See “Entering Document Profile Information” on page 144 for 
more information. 

When you select Copy As New Version or Copy As New Version and Open, 
the New Version Profile dialog box opens for you to enter profile information 
before FileSite adds the copy to the WorkSite library. See “Entering Document 
Profile Information” on page 144 for more information. 

Moving Documents

You can move a document that is stored in a WorkSite library. Moving relocates 
the document from one container to another. This command is not available in 
offline mode, and from the Document Worklist. 

1. Select the document from the Document Grid. 

2. Choose Move from the Document menu. The Move dialog box opens. 

NOTE The Copy As New Version and Copy As New 
Version and Open options are not available if the 
document is checked-out.

NOTE You can copy a document even when it is “In use” or 
checked-out. The copy will duplicate the last version of the 
document that was saved to the WorkSite library. You 
cannot copy a document as a new version if it is 
checked-out.
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Moving Documents
Figure 64 Move dialog box

3. In the Move dialog box, navigate to the Workspace or folder where you want to 
move the document. You can also use the Express Search panel to find a 
location. See “Express Search Panel” on page 266 for more information on 
using this panel.

4. Click Select. A message appears asking if you want to apply the folder 
properties to this document.

Figure 65 Apply profile from folder message
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5. Click Yes to apply the properties of the destination folder to this document. 
Click No to preserve the existing properties of the document. 

Document Links

Document links can be used as shortcuts to documents in the WorkSite library. 
They are used to access the actual document instead of sending it in an e-mail or 
storing it locally on your desktop. To view an example of a document link, see 
Figure 66. 

The name of a document link uses the name of the WorkSite library that contains 
the document, the document number, the version number, and the extension .nrl.

In order to access the destination document in the WorkSite library, you must be a 
valid user on the WorkSite library and have access to the destination document. 

Document links can be created in the following ways:

 Drag a WorkSite document from FileSite to your local desktop. 

 Drag a WorkSite document from FileSite into a document of an integrated 
word processing application.

 Send a document link in an e-mail message. See “Send Link” on page 171 for 
more information. 

Creating Document Links

To create a link to a WorkSite document on your desktop:

1. In FileSite, select the document from the Document Grid. 

2. Drag the WorkSite document to your desktop.

3. A document link icon similar to the one in Figure 66 appears on your desktop. 
Double-click the icon to view the document using the WorkSite Viewer 
program. 

NOTE Autonomy recommends that customers using 
iManage RecordsManager select the Prevent 
flatspace filing check box on the WorkSite Server 
Service Manager, because only declared records that 
are filed within Workspaces are included in the file plan 
and assigned a retention schedule.
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Document Links
Figure 66 WorkSite document link icon on desktop

To create a link to a WorkSite document within another document:

1. In FileSite, select the document from the Document Grid. 

2. Drag the WorkSite document into a document of a word processing 
application.

3. A document link icon similar to the one in Figure 66 appears in the document.

Figure 67 WorkSite document link in a Word document

4. Double-click the icon to view the document using the WorkSite Viewer 
program. 

Copying WorkSite Documents to the Desktop

You can copy a WorkSite document (not a .nrl) to the desktop or into another 
document of a word processing application. 

1. In FileSite, select the document from the Document Grid. 

2. Hold down the CTRL key, then drag the document to its destination. Be sure 
to keep the CTRL key depressed until the document icon appears on your 
desktop. 

Figure 68 WorkSite document copied to the local desktop

3. Double-click the document icon to view it in its associated application. 
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Deleting Documents

Deleting a document removes it entirely from the WorkSite library. If you want to 
remove a document from a folder without permanently deleting it, see “Removing 
Documents from a Folder” on page 121. 

1. Select the document from the Document Grid. 

2. Choose Delete from the Document menu. A message appears asking if you 
are sure you want to remove the document from the folder. 

Figure 69 Document removal message 

3. If you click Yes, the document is removed from the folder but stays in the 
WorkSite library. If you want to permanently delete the document from the 
WorkSite library, select the Permanently delete the document check box. 

E-mailing Documents

From the FileSite Desktop, you can send a copy of a document, a link to a 
WorkSite document, or a URL link to a document through e-mail.

NOTE Only the Author, Operator, or a user with Full 
Access on a document, or a user whose role permits 
deleting documents, is allowed to delete it. Based on 
role and access rights, the Delete option may be 
disabled for some users of FileSite. Contact your 
WorkSite Administrator for more information. 
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E-mailing Documents
Forward Document

You can e-mail a copy of a WorkSite document as an attachment using the 
Forward option on the Document menu.

1. Select the document in the Document Grid. 

2. Choose the Forward option from the Document menu. 

You can also send an attachment by opening a new message in Outlook. 
Select the WorkSite document you want to attach, then drag the document 
into your e-mail message while holding down the CTRL key.

A new e-mail message appears with the document attached. 

Figure 70 Document attached to e-mail message

3. Enter the e-mail address of the recipient and click Send.

Send Link

You can e-mail a link to a WorkSite document using the Send Link option on the 
Document menu.

1. Select the document in the Document Grid. 

2. In the Document menu, point to the Send Link option, and select from the 
following version options:

 To This Version. Links to current version of the document.

 To Latest Version. Links to the most recent version of the document.

You can also create a new e-mail message and drag the WorkSite document 
into the e-mail. It will appear in the Attachment field with the .nrl extension.
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Figure 71 Document link in e-mail message

3. Enter the e-mail address of the recipient and click Send.

Inserting WorkSite Links into Outlook Objects

FileSite provides you with the ability to attach a WorkSite link or a copy of a 
WorkSite document to Outlook tasks, events, contacts, or journal entries. You can 
attach the WorkSite document or link (.nrl or .url) to an Outlook object using the 
following methods. 

Drag and Drop

1. In FileSite, select the document from the Document Grid. 

2. Drag the WorkSite document from the Document Grid to the Outlook folder 
under Outlook Today in the Folder List. 

 If you want to attach a copy of the WorkSite document, hold down the 
CTRL key while you drag the document. Be sure to hold down the CTRL 
key until the document icon appears. 

 If you want to attach a .nrl or .url link to the document, hold down the 
SHIFT key while you drag the document. Be sure to hold down the SHIFT 
key until the link appears.

The desired WorkSite link or document is attached to the Outlook object. 

NOTE To send a URL link to a document, your system 
must include the WorkSite Web component server.
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Printing Documents
In the example shown in Figure 72, several WorkSite documents are saved as .nrl 
links or attachments to an Outlook Task folder.

Figure 72 Example WorkSite links in an Outlook Task folder

Printing Documents

You can print a copy of a document directly from FileSite. 

1. Select the document from the Document Grid.

NOTE You can also send WorkSite documents from the 
Microsoft Office or Adobe Acrobat integrated desktop using 
the options on the File menu. To insert documents, links, 
and attachments, use the options on the Insert menu. See 
Chapter 7. 
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2. Select Print from the Document menu. The document opens in its associated 
application and prints. 

Relating Documents

You can create one- or two-directional relations between documents in FileSite. 
Document relations are one of the ways you can organize and group documents. 

Depending on how your system is set up, each document you select is related in a 
one-way or two-way relationship, to the original document. The selected 
documents, however, are not related to each other. For example, if you want to 
relate Documents B, C, and D to Document A, Table 28 shows how the 
documents relate. 

Creating Relations

1. Select the document from the Document Grid. If your system is set for 
one-way relationships, this becomes the parent document.

NOTE Because this print routine uses the document's 
native application to print the document, it is not 
possible to change the printer settings directly from the 
FileSite application. It will print using Windows default 
settings.

NOTE Relations are two-directional by default. You can 
enable one-way relations using a registry key. For more 
information, refer to the WorkSite Desktop Client 
Customization Guide.

NOTE Your system can handle either one-way or two-way 
relationships, but not both.

Table 28  Document Relations

Relationship set-up in 
your system Document A relates to:

Documents B, C, and D 
relate to:

One-way B, C, and D Only documents you set up

Two-way B, C, and D A, and any other 
documents you set up
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Unlocking Documents
2. From the Document menu, point to Document Info and select Related 
Documents. The Related Documents window opens, listing documents that 
are related to the selected document. 

3. From the Folder List, navigate to the documents you want to relate to this 
document. 

4. Select the documents and drag them into the Related Documents window. 
You can select multiple documents and drag them all at once. 

The  Related Documents icon appears in the Document Icon Column in 
the Document Grid for documents that have related documents. 

5. You can see the related documents by selecting the primary document in the 
Document Grid and clicking the Related Documents tab in the Document 
Results Frame. 

Removing Relations

1. Select the related document you wish to unrelate from the Document Grid. 

2. Choose Remove Relation from the Document menu. The document is 
unrelated from the primary document. 

Uses for Related Documents

Document relations are used to group documents and their attachments. For 
example, a contract and its amendments, a contract and riders to the contract 
and so on. You can also use document relations to link a primary document 
with the documents that were used to create it, such as a final report with its 
inserts, which could be spreadsheets, graphics files, tables, figures, and 
charts.

Unlocking Documents

In some instances, when network connectivity fails or your computer shuts down 
unexpectedly, you may find that a document that you were working on is marked 
as “In use” when it is no longer “In use”. You can unlock the document in the 
WorkSite library and FileSite will release it, making it available for checkout.

NOTE The documents do not need to be in the same 
folder as the primary document.
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Any copy of the document that exists locally will be “orphaned” from the network 
version after an Unlock is complete. You can put the local document into WorkSite 
as a new document or use the Add Version option to import it as a new version. 
You should only use the Unlock option to free up documents that are erroneously 
marked “In use” or checked-out due to a network or system failure.

Only the user who most recently opened or checked out the document can unlock 
it in the WorkSite library. If you try to open or unlock a document that is currently 
open or checked out, a message warns that you will not be able to check in the 
document after you unlock it. 

To unlock a document: 

1. Select the document from the Document Grid.

2. Choose Unlock from the Document menu. A message asking you to confirm 
the Unlock operation appears. See Figure 73. 

Figure 73 Confirm Unlock message

3. Click Yes to unlock the document.

4. If the system detects that the document in question resides on your local or 
network drive, the Confirm Synchronization of Locked Document dialog box 
opens.

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.
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Declaring a Document as a Record
Figure 74 Confirm Synchronization of Locked Document dialog box

This dialog box offers you two options: 

 Synch. to Server & Unlock. Checks in the local copy of the document 
and overwrites the network copy. Use this option if you are sure the local 
copy is the more appropriate one. 

 Ignore Wrkstn. doc. & Unlock. Unlocks the network copy of the 
document and ignores the local copy. 

Declaring a Document as a Record

You can declare a document to be a record. You can use the Open command to 
open the declared document in its native application, make changes, and 
subsequently save it back to the WorkSite library as a new document or a new 
version of the original document.

NOTE The Unlock option may be disabled for some 
users of FileSite. Contact your WorkSite Administrator 
for more information.
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When you declare a document as a record, the action is recorded in the 
document’s history. See “History Tab” on page 83 for more information on 
displaying a document’s history.

To declare a document as a record: 

1. Select the document from the Document Grid.

2. Choose Declare as Record from the Document menu. A message asking 
you to confirm the operation appears. See Figure 75. This operation can be 
rolled back within a specific period of time. For more information, see 
“Undeclaring a Record” on page 178. 

Figure 75 Declare as Record confirmation message

3. Click Yes to declare the document as a record.

When you have declared the document as a record, the  Locked icon 
appears against that document in the Document Grid. 

Undeclaring a Record

You can undeclare a document that is declared as a Record. Undeclaring a 
document restores it to its status prior to declaration, and you can change its 
profile information. However, you can undeclare a document only within a specific 
period of time from when the document was declared. This time period is 
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Undeclaring a Record
determined by the Grace period to undeclare setting on the WorkSite Server 
Service Manager. Contact your WorkSite Administrator for more information. After 
the expiry of this set time period, you cannot undeclare a document. 

When you undeclare a document, the action is recorded in the document’s history. 
For more information on displaying a document’s history, see “History Tab” on 
page 134. 

To undeclare a document:

1. Select the document from the Document Grid.

2. Choose UnDeclare as Record from the Document menu. A message asking 
you to confirm the operation appears. See Figure 76. 

Figure 76 Undeclare Record confirmation message

3. Click Yes to undeclare the document. 

When you have undeclared the document, the  Locked icon against it 
disappears. 

NOTE An NRTADMIN user can undeclare documents at 
any time, that is, irrespective of the expiry of the grace 
period, or when the Grace period to undeclare setting is 
set to 0.

NOTE Only users with at least Read/Write access to the 
declared document can undeclare it. Contact your WorkSite 
Administrator for more information. 
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Restoring Archived Documents

You can restore archived documents if the proper archive files are available to the 
server. When you try to open or checkout a document that is marked as 
“archived”, FileSite displays a message asking if you want to restore it.

Figure 77 Document Archived Message

If you click Yes, FileSite retrieves the archived document from the archive 
location. If the archive file is not available to the server, FileSite will mark the file 
for restoration by your WorkSite Administrator.

Restoring Archived Document Shortcuts

You can restore shortcuts to archived documents by updating the shortcut to link 
to the document in its archived location. 

1. Select the document from the Document Grid. 

2. Choose Restore Shortcut to Archived Document from the Document 
menu. The Restore Shortcut to Archived Document message appears. 

Figure 78 Restore Shortcut to Archived Document Message
0 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Displaying Document Information
3. Click Yes to update the shortcut to now link to the document in its archived 
location. 

Displaying Document Information

You can view the following information about a document: 

 Versions. View a list of a document’s versions. 

 History. View a list of events in the document's history. 

 Related Documents. View a list of the document’s relations. 

 Checkedout Info. View information about a checked-out document. 

 Where Used. View information about a document’s location in the WorkSite 
library. 

Versions

1. Select the document from the Document Grid. 

2. From the Document menu, point to Document Info and select Versions. 

A list of the document’s versions is displayed in the Document Versions 
window. 

History

1. Select the document from the Document Grid. 

2. From the Document menu, point to Document Info and select History.

A list of events in the document's history is displayed in the Document History 
dialog box. 

NOTE WorkSite can restore the link to the archived 
document only if it resides in a database that is 
connected to WorkSite.
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Figure 79 Document History dialog box

 Click Find to open the Find in List dialog box and enter a search string to 
locate a particular event.

 Click Print to open the standard Windows Print dialog box to print the list 
of the document’s history. 

Related Documents

1. Select the document from the Document Grid. 

2. From the Document menu, point to Document Info and select Related 
Documents. 

A list of the document’s relations is displayed in the Related Documents 
window. 
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Displaying Document Information
Checkedout Info

1. Click the  Checkedout Documents icon in the Folder List. This displays all 
your checked-out documents for the selected server in the Document Grid. 

2. Select a document from this list. 

3. From the Document menu, point to Document Info and select Checkedout 
Info. The Document Checked Out dialog box opens, displaying the 
information you need about the checked-out document. 

Figure 80 Document Checked Out dialog box

NOTE You cannot edit the information that appears in 
this dialog box.
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Where Used

1. Select the document from the Document Grid. 

2. From the Document menu, point to Document Info and select Where Used. 
The Where Used dialog box opens with information about where the 
document is located. 

Move or Copy from Outlook to FileSite

You can copy or move e-mail or folders in Outlook to FileSite libraries using the 
buttons on the WorkSite toolbar (or from the Actions area of the WorkSite tab for 
Outlook 2010).

Move E-mails to WorkSite

1. Select one or more e-mail from the Outlook Inbox or other Outlook folder 
displayed in the Document Grid.

2. Click the  Move Email icon on the WorkSite toolbar. The Save As dialog 
box opens.

NOTE You can also move and copy e-mail to WorkSite 
using the Move to Folder and Copy to Folder options in 
the native Outlook application.
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Move or Copy from Outlook to FileSite
Figure 81 FileSite Save As dialog box

3. Navigate to the FileSite folder in which you want to save the e-mail. You can 
also use the Express Search panel to find a location. See “Express Search 
Panel” on page 266 for more information on using this panel. 

4. Enter the Author, Class, and Subclass (if any) fields.

5. Click Save. The e-mail appears in the Document Grid with the  Locked 
E-mail icon indicating it cannot be edited. It is removed from its original 
location in Outlook.

In Outlook 2010, click the Move Email icon on the WorkSite tab of the ribbon 
bar. The Select Destination dialog box opens.
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Figure 82 Select Destination dialog box

Select the folder where you want to move the e-mail and click Select. The 
e-mail is removed from its original location in Outlook and appears in the 
folder you selected.

Copy E-mails to WorkSite

1. Select one or more e-mails from the Outlook Inbox or other Outlook folder 
displayed in the Document Grid.

2. Click the  Copy Email icon on the WorkSite toolbar. The Save As dialog 
box opens. See Figure 81. 

3. Navigate to the FileSite folder in which you want to save the e-mail. You can 
also use the Express Search panel to find the folder. See “Express Search 
Panel” on page 266 for more information on using this panel. 

4. Enter the Author, Class, and Subclass (if any) fields.

5. Click Save. The e-mail appears in the Document Grid with the  Locked 
E-mail icon indicating it cannot be edited. The document is not removed from 
its original location in Outlook.
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Move or Copy from Outlook to FileSite
In Outlook 2010, click the Copy Email icon from the Actions area of the 
WorkSite tab. The Select Destination dialog box opens. See Figure 82.

Select the folder where you want to copy the e-mail and click Select. The 
e-mail appears in the folder you selected and is not removed from its original 
location in Outlook.

Move Folders to WorkSite

When you move or copy an Outlook folder to a WorkSite library, you first create a 
new folder and then file the documents from the original folder to the new folder.

1. Select an Outlook folder in the Folder List.

2. Click the  Move Folder icon on the WorkSite toolbar.

In Outlook 2010, click the  Move Folder icon from the Actions area of the 
WorkSite tab.

The Add to Folders dialog box opens.

Figure 83 FileSite Add to Folders dialog box

3. Navigate to the FileSite folder in which you want to save the Outlook folder. 
You can also use the Express Search panel to find the folder. See “Express 
Search Panel” on page 266 for more information on using this panel. 
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4. Click Select. The Create New Folder dialog box opens.

Figure 84 Create New Folder dialog box

5. Enter property and security information in the Create New Folder dialog box. 
For detailed instructions, see “Document Folder” on page 111. 

6. Click OK. The File to WorkSite progress window opens.
8 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Move or Copy from Outlook to FileSite
Figure 85 File to WorkSite progress window

7. When the e-mails are filed in the new folder in FileSite, the New Profile dialog 
box opens. Enter property and security information for the e-mail documents. 
For detailed instructions, see “Importing E-mails” on page 156.

8. Navigate to and select the new folder in FileSite. The e-mail displays in the 
Document Grid with the  Locked E-mail icon indicating they cannot be 
edited.

The folder and its contents are no longer in the Outlook directory.

Copy Folders to WorkSite

1. Select an Outlook folder in the Folder List.

2. Click the  Copy Folder icon on the WorkSite toolbar. 

In Outlook 2010, click the  Copy Folder icon on the Actions area of the 
WorkSite tab.

The Add to Folder dialog box opens. See Figure 83. 

3. Navigate to the FileSite folder in which you want to save the Outlook folder. 
You can also use the Express Search panel to find the folder. See “Express 
Search Panel” on page 266 for more information on using this panel. 

4. Click Select. The Create New Folder dialog box opens. See Figure 84. 

5. Enter property and security information in the Create New Folder dialog box. 
For detailed instructions, see “Document Folder” on page 111. 

6. Click OK. The File to WorkSite progress window opens. See Figure 85. 

7. When the e-mails are filed in the new folder in FileSite, the New Profile dialog 
box opens. Enter property and security information for the e-mail documents. 
For detailed instructions, see “Importing E-mails” on page 156.

8. Navigate to and select the new folder in FileSite. The e-mail displays in the 
Document Grid with the  Locked E-mail icon indicating they cannot be 
edited.
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The folder and its contents remain in the Outlook directory.

WorkSite Add-on Functions

WorkSite Add-ons are optional features that your system may include. You must 
have Adobe Acrobat 6.04 (Standard or Professional), 7.08, or 8.0 installed on your 
machine for the PDF Add-ons to work. 

Convert to PDF Add-on

The Convert to PDF Add-on lets you convert Microsoft Office documents to PDF 
documents. You can also convert a document and send it in an e-mail message in 
a single operation. 

To convert a Microsoft Office document (Word, Excel, or PowerPoint) to PDF:

1. Select the document you want to convert.

2. From the Document menu, point to Utilities and choose Convert to PDF. 
You can also click the  Convert to PDF icon on the toolbar. The PDF 
conversion process begins. A progress message appears.

Figure 86 PDF Conversion Progress dialog box

3. When the conversion process is complete, the PDF Save As dialog box 
opens.

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

NOTE The Add-ons require Adobe Acrobat. They do not 
appear if you have only Adobe Reader installed on your 
system. 
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WorkSite Add-on Functions
Figure 87 PDF Save As dialog box

4. Choose from the following options:

 New Document. Saves the PDF to the WorkSite library as a new 
document.

 New Version. Saves the PDF as a new version of the original document. 

5. If you choose to save the PDF as a New Document, you can select the 
Relate PDF to original option. The PDF document will relate to the original 
document in a one-way or two-way relationship depending on how your 
system is configured. See “Relating Documents” on page 174 for more 
information on creating relations between documents. 

6. Click OK after you have made your selections. The New Document Profile 
dialog box or the New Version Profile dialog box opens, depending on the 
option you selected. 

7. Enter the information in the profile dialog box. See “Entering Document Profile 
Information” on page 144. 

NOTE The New Version option is not available in 
Portable mode.

NOTE The Relate PDF to original option is not 
available in Portable mode.
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Send as PDF Add-on

The Send as PDF Add-on lets you send the converted document in an e-mail 
message. 

1. Select the document you want to convert and send in an e-mail.

2. From the Document menu, point to Utilities and choose Send as PDF. You 
can also click the  Send as PDF icon on the toolbar. The PDF conversion 
process begins. A progress message appears. See Figure 86. 

3. After the PDF conversion process is complete, FileSite opens a new e-mail 
message and adds the PDF document to the message as an attachment.

4. Enter e-mail addresses in the To and Cc fields and click Send.

Creating New Documents

You can create a new document directly from FileSite. Because your FileSite 
system is integrated with the Microsoft Office Suite, you have the ability to create 
a new Word document, Excel spreadsheet, or PowerPoint presentation. See 
Figure 89. 

You or your WorkSite Administrator can create “template” documents and place 
them in a folder under the WorkSite directory on your machine or on the LAN. If 
the templates reside on your machine, the path is:

C:\Program Files\Interwoven\WorkSite\
Figure 88 New folder containing example Word and Excel templates
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Creating New Documents
If there is a form, basic document, or presentation that you use frequently, you or 
your WorkSite Administrator can put it in this folder. This is the first place FileSite 
looks when you want to create a new document. 

To create a new document: 

1. Right-click the  Document Worklist icon or a  document folder icon in 
the Folder List, point to New and make a selection from the following options 
in the New submenu:

 Mail Message

 Microsoft Word Document

 Microsoft Excel Worksheet

 Microsoft PowerPoint Presentation

Figure 89 New submenu

2. When you select an item from the New submenu, FileSite opens the New 
Profile dialog box. 

NOTE The New submenu is customizable from your 
computer’s registry. Your WorkSite Administrator can 
add items, for example, document templates from other 
applications, such as WordPerfect or Visio.
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Figure 90 New Profile dialog box

3. Fill in the fields of the dialog box. See “Entering Document Profile Information” 
on page 144 for detailed steps.

4. Click Save to save the document and open it in its native application. 

5. Add content to the document and save. The document will appear under the 
selected document folder or worklist.

Creating New Document Defaults

You can create a virtual template of default document profile information that 
appears in the New Profile dialog box. This option lets you set certain fields of 
profile information to standard values that typically do not change, so you do not 
have to enter the same information each time you create a document. For 
instance, if you frequently create documents that have a certain field of profile 
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information set to a constant value, you can enter that value as the default value 
for that field, and it will appear automatically each time you create a new 
document.

If you have defined security templates, you can include one in the New Profile 
dialog box. See “Working with Security Templates” on page 202 for more 
information on creating security templates.

To create a new document default profile: 

1. From the WorkSite menu, point to Configure, and select Document Profile 
Defaults. 

In Outlook 2010, on the WorkSite tab, click the  Document Profile 
Defaults icon from the Configure area.

The New Profile Default dialog box opens. See Figure 91. The information that 
you enter in this dialog box will appear automatically in the new document’s 
profile dialog box.

To move between fields in the following dialog box, use the TAB key. Because 
the fields and their names are customizable, there are no keyboard shortcuts 
on profile dialog boxes.

NOTE If a document folder is selected when you import or 
create a new document, the default values appear in the 
document profile dialog box, along with the property 
information that is set on the folder.
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Figure 91 Example New Profile Default dialog box

2. Enter default profile information. In Figure 91, default values are entered in the 
Author and Class fields. See “Entering Document Profile Information” on 
page 144 for instructions.

3. When you select certain security settings, they are automatically selected in 
the New Profile dialog box each time you add a new document to the WorkSite 
library. 

NOTE The New Profile Default dialog box can be 
customized by your WorkSite Administrator and may be 
significantly different than the dialog box shown in 
Figure 91.
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4. Click Save to store the default information and close the New Profile Default 
dialog box.

Keyword Variables in Default Profiles

You can specify keyword variables for the current date, time, date and time, and 
user name in the New Profile Default dialog box.

Figure 92 shows an example of a New Profile Default dialog box where the default 
Description field will be the name of the current user followed by the date and 
time. The Author field is also set to the current user. The Class field defaults to 
DOC.

NOTE Although the values that you enter in the New 
Profile Default dialog box appear automatically for each 
new document you create, you can modify these values 
when you create or edit a document. See “Editing 
Document Profile Information” on page 146 for more 
information. You do not have to use the default values.

Table 29  List of Supported Variables

Keyword Variable What it does

%DATE% Inserts current date

%TIME% Inserts current time

%DATETIME% Inserts current date and time

%USERID% Inserts name of user currently logged in to the WorkSite 
library
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Figure 92 New Profile Default dialog box, variables entered

NOTE New document default settings remain in effect 
until you explicitly reset them.
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Default Profile Properties for Documents

FileSite has five required fields of profile information: Description, Type, Class, 
Author and Operator. The following table shows how FileSite handles these profile 
fields when documents are imported into folders. See “Creating New Document 
Defaults” on page 194 for more information on creating default document profiles. 

Creating E-mail Profile Defaults

You can create a virtual template of default e-mail profile information that appears 
in the Default Email Profile dialog box. This option allows you to streamline the 
profiling of e-mail messages. 

You can set fields of profile information to standard values that typically do not 
change, so you do not have to enter the same information each time you create or 
import e-mail into the WorkSite library. 

If you have defined security templates, you can include one in the Default Email 
Profile dialog box. See “Working with Security Templates” on page 202 for more 
information on creating security templates.

To create a new e-mail profile default: 

1. From the WorkSite menu, point to Configure, and select Email Profile 
Defaults. 

In Outlook 2010, on the WorkSite tab, click the  Email Profile Defaults 
icon from the Configure area.

The Default Email Profile dialog box opens. See Figure 93. The information 
that you enter in this dialog box will appear automatically in the dialog box 
used to enter property information for new e-mail messages that are saved to 
WorkSite.

Table 30  Default Profile Properties, Documents

Profile Field Imported Document

Description File name of the document. 

Type Autodetected if file type is known or defaults to ANSI/UNKNOWN. 

Class Obtained from folder profile defaults or default set on your system 
(usually DOC). 

Operator User who imports the document. 

Author Obtained from folder profile defaults or same as Operator. 
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To move between fields in the following dialog box, use the TAB key. Because 
the fields and their names are customizable, there are no keyboard shortcuts 
on profile dialog boxes.

Figure 93 Example Default Email Profile dialog box

2. Enter default profile information. See “Entering Document Profile Information” 
on page 144 for instructions.

3. When you select certain security settings, they are automatically selected in 
the Default Email Profile dialog box each time you add a new e-mail message 
to the WorkSite library. You can always enter custom security settings for an 
e-mail message, if desired.

NOTE The Default Email Profile dialog box can be 
customized by your WorkSite Administrator and may be 
significantly different than the dialog box shown here.
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Creating E-mail Profile Defaults
4. Click Save to store the default information and close the Default Email Profile 
dialog box.

Keyword Variables in Default E-mail Profiles

You can specify keyword variables for the current date, time, date and time, and 
user name in the Default Email Profile dialog box. See Table 29 for a list of 
supported variables. 

Default Profile Properties for E-mails

FileSite has five required fields of profile information: Description, Type, Class, 
Author and Operator. The following table shows how FileSite handles these profile 
fields when e-mail messages are imported into folders with e-mail addresses. See 
“Creating E-mail Profile Defaults” on page 199 for more information on creating 
default e-mail profiles. 

NOTE Although the values that you enter in the Default 
Email Profile dialog box appear automatically for each 
new e-mail message you create, you can modify these 
values whenever you create a new e-mail message. 
See “Editing Document Profile Information” on 
page 146 for more information. You do not have to use 
any of the default values set.

Table 31  Default Profile Properties, E-mails

Profile Field E-mail

Description Subject of the e-mail. 

Type Autodetected if file type is known or defaults to ANSI/
UNKNOWN. 

Class Obtained from folder profile defaults or default set on 
your system (usually e-mail). 

Operator User name in From field of the e-mail. 

Author Obtained from folder profile defaults or same as 
Operator. 
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Working with Security Templates

By default, document security is determined by the security settings on the folder 
in which it is created or dragged and dropped. In earlier versions of WorkSite, 
document security was set by applying a class-based security template, or list of 
predefined security settings. Your FileSite > Configure submenu may include the 
Security Template option, but keep in mind that you can only use security 
templates if you are NOT using folder security. 

There are two types of security templates you can apply:

 Local Security Template. You can create a local security template in FileSite 
and apply it to your documents. See “Creating a Local Security Template” on 
page 202 and “Applying a Security Template” on page 205 for more 
information. 

 Author-based Security Template. Your WorkSite Administrator can create 
lists of predefined security settings and assign these templates to users. 
When the user imports or creates a new document in WorkSite, the security 
settings assigned to the user are automatically applied to the document 
profile. See “Applying an Author-based Security Template” on page 207 for 
more information. 

Creating a Local Security Template

In FileSite you can create local security templates that can be applied to new 
documents. 

1. From the WorkSite menu, point to Configure, and select Security 
Templates. 

In Outlook 2010, on the WorkSite tab, click the Security Templates icon from 
the Configure area.

The Security Template Management dialog box opens. See Figure 94. 

NOTE The Security Template option in the FileSite > 
Configure submenu may be disabled on your system by 
your WorkSite Administrator.

NOTE Contact your WorkSite Administrator for more 
information on creating Author-based security 
templates. 
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To move between fields in the following dialog boxes, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

Figure 94 Security Template Management dialog box

2. Click New. This launches the Security Template dialog box.

Figure 95 Security Template dialog box
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3. Enter a name for the template in the Security Template Name field. After you 
enter the template name the other fields become available.

4. Select a default level of security from the Default Security list to assign 
security access to users who are not accounted for in your explicit access 
control list. Author and Operator are automatically given Full Access. The 
default security defaults to Private. See “Default Security” on page 87 for 
more information on security levels.

5. Select the level of access from the Type of Access list for the users and 
groups you specifically name in the template. See “Access Control List (ACL)” 
on page 87 for more information on security levels. 

6. Click Add User or Add Group to add specific users or groups to the template. 
If you click Add Group, the Select Internal Group(s) dialog box opens. 

Figure 96 Select Internal Group(s) dialog box
4 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Working with Security Templates
7. Select one or more groups or users from the list. You may select from a list of 
external users or groups by selecting the External Group or External User 
option. 

8. Click Add to add them to the security template.

9. Click Users to see a list of users that included in the highlighted Group. The 
Users of Group dialog box opens. 

Figure 97 Users of Group dialog box
o

10. Click OK to close the dialog box. The users and groups are listed in the 
Security Template dialog box. 

11. To remove a user or group from the template list, select the user or group and 
click Remove.

12. Click OK to save the security template.

Applying a Security Template 

You can apply a security template to:

 A new document you add to the WorkSite library
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 An existing document in the WorkSite library

Applying a Local Security Template

To apply a local security template to a new document:

1. In the New Profile dialog box or the New Version Profile dialog box (depending 
on whether you are adding a new document or a new version of an existing 
document), there is a Security Template list. This list contains the security 
templates available to you. Select a security template from this list to apply to 
the new document. 

2. Click Save to add the document to a WorkSite library. 

To apply a local security template to an existing document:

1. Select the document(s) to which you wish to apply the security template from 
the Document Grid. 

2. From the Document menu, point to Utilities and select Bulk Security Edit. 
The Edit Security dialog box opens. 

To move between fields in the following dialog box, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

NOTE Only the Author, Operator or a user with Full 
Access on the document can apply a security template 
to it.

NOTE You can modify the access control lists when 
you add a document to a WorkSite library. However, if 
you assign an author-based security template, you 
cannot modify the security settings assigned to that 
Author.

NOTE If the Security Template list does not appear in 
the New Profile dialog box or the New Version dialog 
box, your WorkSite Administrator must enable this 
feature.
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Figure 98 Edit Security dialog box

3. In the Default Security list, select the <no change> option. 

4. Select the security template from the Apply Security Template list. 

5. Choose an option in the Set Security Options area:

 Remove existing security settings. Replaces the current settings in the 
document with the new settings from the template. 

 Only add to or modify existing settings. Keeps the current settings on 
the document, but you can add or change specific settings. The settings 
you select will change but all other settings will remain as they were.

6. Click OK to apply the security template. You get a message confirming the 
successful update of the document’s security. 

Applying an Author-based Security Template

1. In the New Profile dialog box or the New Version Profile dialog box (depending 
on whether you are adding a new document or a new version of an existing 

NOTE After you apply the security template, if you 
want to change the security settings you can use the 
Properties option in the Document menu. See “Editing 
Document Profile Information” on page 146 for more 
information.
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document), click the  Lookup button that appears next to the Author field. 
The Select Internal Author dialog box opens. 

Figure 99 Select Internal Author dialog box

2. Select the user to whom your WorkSite Administrator has assigned an 
author-based security template. The security settings defined in that template 
are applied to the new document. 

NOTE The lookup dialog box can display only 250 valid 
entries for that field of profile information in the WorkSite 
library. If there are more than 250 valid entries, use the 
Find option at the top of the dialog box to locate your 
entry. When you enter a value in the Find field, FileSite 
searches all valid entries for matches.
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3. Click Save to add the document to a WorkSite library. 

Editing Security on Documents

There may be times when you need to edit the security for a large group of 
documents at the same time, for example, if a new employee joins your group. 
You can edit the security settings on two or more documents in the same 
operation. This feature functions only on documents that are currently checked in. 
You cannot edit security on documents that are archived, locked, or checked-out.

To edit security settings on multiple documents:

1. Select the documents whose security you want to edit from the Document 
Grid. 

2. From the Document menu, point to Utilities and select Bulk Security Edit. 
The Edit Security dialog box opens.

To move between fields in the following dialog boxes, use the TAB key, arrow 
keys, or ALT key plus underscored letter.

Figure 100 Edit Security dialog box

3. Select the Default Security for all the documents from the Default Security 
list. You can select from the following options:

 <no change>
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 Make all Public

 Make all Private

 Make all View

See “Default Security” on page 87 for more information on default security 
settings.

4. Click User/Group Security to add Users and/or Groups who require explicit 
access other than the default security. The File Permissions dialog box opens.

Figure 101 File Permissions dialog box

5. To specify access privileges for selected users and groups, make a selection 
from the Type of Access list. The access privileges you grant to specific 
users and groups are exceptions to the Default Security settings. See “Access 
Control List (ACL)” on page 87 for more information.

6. Click OK to close the File Permissions dialog box. 

7. If you wish, you can apply an existing security template to the documents. 
Select a security template from the Apply Security Template list. 

8. Choose an option in the Set Security Options area:
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 Remove existing security settings. Replaces the current settings in all 
documents with the new settings from the security template. 

 Only add to or modify existing settings. Keeps the current settings on 
the document, but you can add or change specific settings. The settings 
you select will change but all other settings will remain as they were.

9. Click OK to edit the security. You get a message confirming the successful 
update of the document’s security. 

Application Setup in FileSite

The local application table contains information that is used by FileSite to launch 
applications and to associate particular document types with appropriate 
applications. 

You may need to change the local copy of the application table in the following 
circumstances: 

 The path to an application changes.

 You want to associate a document type with a different application.

 You want to integrate an application that is not listed in the application table on 
the database.

FileSite Features for Microsoft Outlook 2007 or 2010

When you use FileSite with Microsoft Outlook 2007 or Microsoft Outlook 2010, 
there are some special features that are not available with earlier versions of 
Outlook. This section describes the following features:

 “Inserting a WorkSite Attachment”

 “Creating Outlook Folders in FileSite”

 “Dragging and Dropping Outlook Items to FileSite”

CAUTION Do not attempt to edit the local copy of the 
application table unless you understand the way 
applications are integrated with WorkSite. Contact your 
WorkSite Administrator before proceeding.
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Inserting a WorkSite Attachment

When you create a new e-mail or other item in Outlook 2007 or Outlook 2010, the 
New Message dialog box has a ribbon bar in place of the traditional menu bar. 
The WorkSite tab on the ribbon bar offers the option of attaching a WorkSite 
document to the new item.

1. Click Insert WorkSite Attachment on the Message ribbon bar. The WorkSite 
Integrated Insert dialog box opens, allowing you to select a document to 
attach.

Figure 102 Example New Message dialog box
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Figure 103 Insert a WorkSite document dialog box 

2. Navigate to the document. You can also use the Express Search panel to find 
the document. See “Express Search Panel” on page 266 for more information 
on using this panel. 

3. Select the document.

4. Select an option from the Insert Link menu:

 Insert Link

 Insert Copy

The .nrl link or the document is attached to the item.

Creating Outlook Folders in FileSite

You can replicate your Outlook folders in FileSite and use drag and drop 
functionality to save Outlook tasks, contacts, notes and other items to the 
WorkSite library.

NOTE The Insert WorkSite Attachment command is 
available when you create a new Mail Message, Task, 
Task Request, or Contact.
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The special folders that you create under the  FileSite node in the navigation 
pane are visible only when the full folder list is displayed. They will not appear if 
you are displaying e-mail only. To display all folders, click the folder list icon at the 
bottom of the navigation pane.

Figure 104 View options on navigation pane

To create folders for Outlook items, follow the instructions for creating a new 
document folder (see “Creating a Document Folder” on page 111). You can give 
the folder any name, but it must include the folder type in parentheses. When the 
folder appears in the navigation pane, its icon will indicate the type of Outlook 
items it contains.

To create additional folders for Outlook items, indicate the following types of items 
in parentheses in the folder name:

Dragging and Dropping Outlook Items to FileSite

After creating folders for Outlook items in FileSite, you can drag the corresponding 
items from Outlook and drop them in the FileSite folders. You are prompted to 
enter profile information. All items dragged from Outlook folders are saved in 
FileSite as documents of type E-MAIL. When you display items of a particular 
type, for example, Tasks, Outlook displays two Tasks folders in the navigation 
pane: the Outlook folder and the FileSite folder. 

Table 32  Outlook Folder Types

If the Outlook folder 
contains...

Include in the folder name in 
FileSite...

Appointments (appointment)

Calendars (calendar)

Contacts (contact)

Journal Entries (journal)

Notes (stickynote)

Tasks (task)

NOTE The Outlook Calendar, Note, and Task folders 
described in this section are not the same as the 
collaboration folders for Tasks, Notes, and Events that 
are available in the WorkSite Web application.
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Figure 105 Example Tasks folders displayed in Outlook navigation pane

You can see in Figure 105 that the items in the FileSite folder (shown in the center 
pane) are links to e-mail. When you click a link in a FileSite folder, the e-mail 
opens and displays information about the item.

Tasks

You can drag tasks from the Outlook To-Do Bar or To-Do List and save them to 
the WorkSite library as documents of type E-MAIL. When you perform this 
operation, a new e-mail message containing information about the task opens, 
and you are prompted to enter profile information and save to FileSite. You can 
also send the e-mail to a colleague or group. 

You can view tasks by clicking the Tasks (task) folder in FileSite or by clicking the 
 Tasks icon at the bottom of the navigation pane. See Figure 105. Display the 

contents of the FileSite folder and click a task. This opens the corresponding Task 
form. 

NOTE The special folders are visible in the navigation pane 
only when the Folder List is displayed. If you do not see the 
Tasks (task) folder, click the  Folder List icon at the 
bottom of the navigation pane to display all folders.
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Figure 106 Example Task dialog box

Contacts

You can drag contacts from the Outlook Contacts list and save them to the 
WorkSite library as documents of type E-MAIL. When you perform this operation, 
a new e-mail message linked to the contact form opens, and you are prompted to 
enter profile information for the e-mail and save it to FileSite. You can also send 
the e-mail to a colleague or group.

You can view contacts by clicking the Contacts (contact) folder under the FileSite 
node or by clicking the  Contacts icon at the bottom of the navigation pane and 
opening the Contacts (contact) Folder in FileSite. 

NOTE The special folders are visible in the navigation pane 
only when the Folder List is displayed. If you do not see the 
Contacts (contact) folder, click the  Folder List icon at the 
bottom of the navigation pane to display all folders.
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Figure 107 Example Contacts displayed in the Outlook navigation pane

Display the contents of the FileSite folder and click an e-mail link. This opens the 
corresponding Contact form. 

Figure 108 Example Contact dialog box
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Calendars and Appointments

You can drag appointments from the Outlook Calendar or To-Do Bar and save 
them to the WorkSite library as documents of type E-MAIL. When you perform this 
operation, a new e-mail message containing information about the appointment 
opens, and you are prompted to enter profile information and save to FileSite. You 
can also send the e-mail to a colleague or group.

You cannot move a recurring appointment (for example, a weekly meeting) to an 
Appointment (appointment) folder in FileSite. You must copy each occurrence of a 
recurring appointment and drag the copies into the FileSite folder. You cannot 
receive responses from invitees to the appointment in the FileSite folder.

You can view appointments and calendars by clicking the Calendar (calendar) or 
Appointments (appointment) folder in FileSite. or by clicking the  Calendar icon 
at the bottom of the navigation pane and then opening the Calendar (calendar) in 
FileSite or Appointments (appointment) in FileSite folder listed under All 
Calendar Items. 

Figure 109 Example Calendars and Appointments displayed in the Outlook 
navigation pane

Display the contents of the FileSite folder and click an e-mail link. This opens the 
corresponding Meeting form.

NOTE The special folders are visible in the navigation pane 
only when the Folder List is displayed. If you do not see the 
Calendars (calendar) or Appointments (appointment) folder, 
click the  Folder List icon at the bottom of the navigation 
pane to display all folders.
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Figure 110 Example Meeting dialog box

Notes

You can drag notes from the Outlook Contacts list and save them to the WorkSite 
library as documents of type E-MAIL. When you perform this operation, a new 
e-mail message linked to the actual note opens, and you are prompted to enter 
profile information for the e-mail and save it to FileSite. You can also send the 
e-mail to a colleague or group.

You can view notes by clicking the Notes (stickynote) folder in FileSite or by 
clicking the  Notes icon at the bottom of the navigation pane and opening the 
Notes (stickynote) Folder in FileSite. 

NOTE The Notes (stickynote) folder is visible in the 
navigation pane only when the Folder List is displayed. If 
you do not see it, click the  Folder List icon at the bottom 
of the navigation pane to display all folders.
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Figure 111 Example Notes displayed in the Outlook navigation pane

Display the contents of the FileSite folder and click an e-mail link. This opens the 
corresponding Note. 

Figure 112 Example Note

Journal Entries

You can use the Outlook Journal to track actions related to specific contacts and 
display them in a timeline view. For example, you could keep a record of all phone 
calls and e-mail to a particular client.
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Drag notes from the Outlook Contacts list and save them to the WorkSite library 
as documents of type E-MAIL. When you perform this operation, a new e-mail 
message linked to the journal entry opens, and you are prompted to enter profile 
information for the e-mail and save it to FileSite. You can also send the e-mail to a 
colleague or group.

You can view journal entries by clicking the Journal Entries (journal) folder in 
FileSite or by clicking the  Journal icon at the bottom of the navigation pane 
and opening the Journal Entries (journal) Folder in FileSite. 

Figure 113 Example Journal folders displayed in the Outlook navigation pane

Display the contents of the FileSite folder and click an e-mail link. This opens the 
corresponding journal entry form. In the example shown in Figure 114, the action 
recorded was an e-mail sent to two clients.

NOTE The Journal Entries (journal) folder is visible in the 
navigation pane only when the Folder List is displayed. If 
you do not see it, click the  Folder List icon at the bottom 
of the navigation pane to display all folders.
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Figure 114 Example Journal entry dialog box

To see the actual message that was sent to the clients, click the e-mail message 
link in the body of the journal entry.
2 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



CHAPTER 6  
Searching in FileSite

Overview

This chapter contains the following topics describing FileSite’s searching 
capabilities: 

 “WorkSite Search Capability”

 “Searching on Profile Information”

 “Full-text Searching”

 “Performing Searches”

 “Microsoft Outlook Search”

 “Saved Search”

 “WorkSite Container Searches”

NOTE Express Search is a separate search utility. 
Refer to the WorkSite Express Search User’s Guide for 
more information.
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WorkSite Search Capability

FileSite can perform fast and powerful searches for Workspaces, folders, and 
documents based on profile information and/or full-text information. You can save 
a FileSite search by creating search criteria as properties on a search folder. A 
new search is performed each time you open the search folder. You can also 
perform Microsoft Outlook’s native searches.

Searching on Profile Information

When you perform a search based on a document’s profile information, you can 
enter search criteria for certain fields of profile information. FileSite returns 
documents whose profile information matches the criteria. This type of search is 
sometimes called a query-by-form search. The fields of profile information are 
entered in the Search dialog box.

Search Dialog Box

The Search dialog box is used to enter search criteria for any type of search, 
including full-text or document profile information. 

NOTE The Search dialog box can be customized by your 
WorkSite Administrator. Figure 115 shows the default 
appearance of the Search dialog box.
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Figure 115 Search dialog box

At a glance you can see the information your search covers using the Search 
Helper area. It shows the Search Scope (selections made in the Result Filter 
and Search Within fields) and the Search Criteria (a summary of the profile 
information you have entered).

Full-text Searching

Full-text searching locates documents based on the occurrence of search terms 
or strings in the text of the document. These can be individual words, partial 
words, phrases, or sequential words. You can search for occurrences of these 
terms either in the contents of documents or in the text of certain profile fields, 
such as Comment or Description, and custom fields such as From and To. 
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A full-text search can be performed in conjunction with a search on profile 
information. The search returns documents that meet both the profile search 
criteria and contain the words or phrases specified by the full-text search criteria. 

You can enter full-text search criteria in the Look For field (at the bottom of the 
Search dialog box). See Figure 116. You can also select whether to search 
through the entire body of the document or on certain profile fields by selecting an 
option from the list adjacent to the Look For field. 

Figure 116 Search dialog box, full-text information

NOTE By default, full-text searches are not case-sensitive.
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Simplified Full-text Search

A Simplified full-text search dialog box is available for users who are not familiar 
with Boolean logic or full-text query language. See Figure 117. This dialog box 
allows you to enter key terms or phrases and to construct a simple full-text search 
query automatically.

Figure 117 Simplified full-text search dialog box

Access this dialog box by clicking the  Lookup button next to the Look For 
field in the Search dialog box. 

Use this intuitive dialog box to create simple full-text search queries by entering 
words or phrases separated by commas into the appropriate fields. 

 In the first field, enter a list of terms which must all appear in the document in 
order for it to appear in your search results.

 In the second field, enter a list of terms only one of which must appear in the 
document for it to appear in your list of search results.

 In the third field, enter terms that should exclude a document from the search 
results if they appear in that document. 
FileSite Installation and User’s Guide  227

• 
• 
• 
•
•
•



Chapter 6 Searching in FileSite

22
The All of these words list at the top of the Simplified full-text search dialog box 
lets you set the proximity with which the terms you enter must appear near each 
other. 

 The Anywhere in document option returns documents in which the terms 
appear anywhere in the document, not necessarily within any proximity of 
each other.

 The Near each other returns documents in which the terms must appear 
within a defined proximity of each other. 

The Near field enables you to set the proximity between terms in numeric values.

Search Syntax

A search query is made up of search terms and operators. Terms are individual 
words, partial words, and phrases that you use to perform full-text searches. 
Multiple terms can be combined using operators. 

Search Operators
Operators allow search terms to be combined to restrict your search. In FileSite, 
the search syntax and operators are different when searching profile information 
and full-text information.

NOTE WorkSite ignores stop words, that is, common 
words such as, “a”, “an”, and “the” that are included in 
search queries. To forcibly include stop words in your search 
query, enclose them in quotes. 
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Table 33 lists the operators that work only on profile fields. 

Table 34 lists the search operators supported for full-text searches. All operators 
must be entered in all UPPERCASE letters.

Table 33  Profile Field Operators

Search Operator Description Example

> (Greater Than) The greater than sign is used to find documents 
that contain a value in a particular profile field 
that is greater than a specified minimum value.

To select documents with a document 
number greater that 2500, enter:

> 2500 in the Document Number 
field. 

>= (Greater Than or 
Equal To)

The greater than or equal to sign finds 
documents that contain a value in a particular 
profile field that is greater than or equal to a 
specified value. 

To search for documents with a 
document number greater than or 
equal to 2800, enter:

>= 2800 in the Document Number 
field. 

< (Less Than) The less than sign is used to find documents 
that contain a value in a particular profile field 
that is less than a specified maximum limit.

To search for documents with a version 
number less than 3, enter: 

< 3 in the Version Number field. 

<= (Less Than or 
Equal To)

Like the greater than or equal to sign, the less 
than or equal to sign combines the searching 
power of the less than and equal to signs.

To search for documents with a version 
number less than or equal to 3, enter:

<= 3 in the Version Number field. 
FileSite Installation and User’s Guide  229

• 
• 
• 
•
•
•



Chapter 6 Searching in FileSite

23
Table 34  Full-text Search Operators

Search 
Operator Description Example

“ ” The double quotation marks operator locates 
documents that contain an exact word or phrase. It is 
used to perform a literal search. You can use double 
quotation marks with any of the other operators 
described in this table.

When search terms are included in quotes, WorkSite 
Indexer stems the search terms by default. Stopwords 
(common words like and, or, the) are removed from 
queries using quotes. 

To find documents that contain the 
phrase new york, enter:

"new york" 

If you do not use quotation marks, 
your results will include matches for 
new, and york. 

AND The AND operator locates documents containing both 
the terms on either side of it. 

To find documents that contain the 
words England and North, enter: 

England AND North

OR The OR operator finds documents that contain at least 
one of the terms to which it is applied. It enlarges the 
search scope and is normally used to look for terms 
that have similar meaning or refer to similar subjects. 

To find documents with one or both of 
the words red and green, enter:

red OR green

NOT The NOT modifier is used with the AND and OR 
operators, to exclude documents that contain a given 
term.

Note: In order for the NOT modifier to work, you must 
first enter a positive search criteria.

To find documents that contain the 
words mushrooms and olives but not 
the word anchovies, enter:

mushrooms AND olives AND 
NOT anchovies

The following example query would 
not return any results:

NOT anchovies

~ Adding a tilde before a search term returns results 
which match the case of the search term. 

The AdvancedSearch and AdvancedCaseSearch 
parameters must be enabled for WorkSite Indexer to 
process case sensitive searches.

To find documents that contain the 
word President, enter:

~President

Occurrences of president or 
PRESIDENT would be ignored.

? The question mark (?) replaces any single 
alphanumeric character.

Note: You can use more than one question mark 
within a term. 

Note: If you want a wildcard character to be 
interpreted as text and not as a wildcard, precede the 
character with a backslash (\). 

b?rn  would match the words born, 
barn, or burn.

sh??e would match the words 
shore and shade. 
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* The asterisk (*) is used as a wildcard operator to 
represent any number of alphanumeric characters 
(including none). 

Note: When using the asterisk wildcard, try to narrow 
the potential scope of the wildcard entry as much as 
possible.

Note: If you want a wildcard character to be 
interpreted as text and not as a wildcard, precede the 
character with a backslash (\).B

To find documents about 
automobiles, enter:

auto* 

Matching documents include words 
such as auto, automobile, and 
automotive, but also include 
autobiography, autocracy, and 
autograph. A more specific query 
would be:

auto OR automo*

Searching for *vert* would return 
matches for the words convertible, 
inverted, vertigo, and covert.

( ) Parentheses group terms and operators allowing you 
to control the evaluation of search operators. Items 
grouped in the parentheses are evaluated first.

document AND (cluster OR 
redundancy) would return 
documents which contain document 
and either cluster or redundancy.

BEFORE The specified term or expression must appear before 
another term or expression in the search results.

red BEFORE green would return 
only those documents in which the 
term red appears before the term 
green.

AFTER The specified term or expression must appear after 
another term or expression in the search results.

red AFTER green would return 
only those documents in which the 
term red appears after the term 
green.

EOR

XOR

Only one of the terms is permitted to appear in the 
document. If both terms appear in the document, it is 
not returned in the search results.

To find documents that contain either 
cat or dog. 

cat EOR dog

cat XOR dog

Documents which contain both cat 
and dog are not returned.

NEARn Only returns documents in which the second term is 
within n words of the first term-that is, the terms are n 
or fewer words apart. If you do not specify n, it defaults 
to 5. 

To find documents with the words red 
and green within seven words of 
each other, enter:

red NEAR7 green

Search 
Operator Description Example
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DNEARn Only returns documents in which the second term is 
within n words of the first term, in the specified order. 
If you do not specify n, it defaults to 5.

To find documents in which the term 
green follows the term red, and is no 
more than 2 words away from the 
term red.

red DNEAR2 green

WNEARn Weighted NEAR. The WNEAR operator promotes 
relevance when terms are less than the specified n 
words distance. The closer together the words are in 
the document, the higher the relevance of the 
document. If you do not specify n, it defaults to 5.

Documents in which the terms do not occur within n 
words of each other are returned with normal 
relevance.

WNEAR will return search results which contain either 
of the two terms.

In this query, extra relevance is given 
to documents in which the terms dog 
and cat appear 7 or fewer words 
apart.

dog WNEAR7 cat

Documents which contain either dog 
or cat will be returned, but with lower 
relevance.

YNEARn The YNEAR operator is similar to the WNEAR 
operator, except that only documents which include 
both terms will be returned. 

YNEAR promotes relevance when terms are less than 
the specified n words distance. The closer together 
the words are in the document, the higher the 
relevance of the document. If you do not specify n, it 
defaults to 5.

Documents in which the terms do not occur within n 
words of each other are returned with normal 
relevance.

Note: This is the default operator.

In this query, extra relevance is given 
to documents in which the terms dog 
and cat appear 7 or fewer words 
apart.

dog YNEAR7 cat

Only documents which contain both 
dog and cat will be returned.

XNEARn Only returns documents in which the second term is 
exactly n words from the first term.

This query only returns documents in 
which the term dogs follows the term 
cats and is exactly two words away 
from the term cats. This means that 
documents which contain cats and 
dogs are returned, while documents 
that contain dogs and cats or cats, 
dogs are not returned.

cats XNEAR2 dogs

Search 
Operator Description Example
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Performing Searches
Searching for Word Variations with Stemming
When a full-text search is performed, WorkSite stems the search terms, and finds 
words that have the same stem. For example, a search for the word lovely is 
stemmed to the word love; and returns results such as lovely, love, loved, and so 
on. 

Performing Searches

There are three main types of searches you can perform using FileSite. 

 “Microsoft Outlook Search”

 “Saved Search”

 “WorkSite Container Searches”

 Database Search. A search performed on a document library you are 
currently logged into.

 Workspace Search. A search for Workspaces or for content on a 
Workspace.

 Folder Search. A search for content in a folder.

Microsoft Outlook Search

FileSite supports the use of Microsoft Outlook’s native searching functions to 
search for FileSite documents. From the Tools menu, point to Find and choose 
the Find or Advanced Find option to perform the search.

Figure 118 Microsoft Outlook 2003 Quick Search toolbar

In Outlook 2007, click the Instant Search box located under the Inbox heading to 
perform an Outlook search. Click the drop-down menu for search options.

NOTE Using the FileSite desktop, you can search only for 
the content within a folder, not for a folder itself. Using the 
WorkSite Integrated Desktop search function, you can 
search for the content within a folder or the actual folder. 
See “Search” on page 265 for more information.
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Figure 119 Microsoft Outlook 2007 Instant Search toolbar

In Outlook 2010, click the Instant Search box located under the Inbox heading to 
enable the Search tab and select search options

Figure 120 Microsoft Outlook 2010 Search tab

Refer to Microsoft Outlook Help for detailed instructions on how to perform this 
search.

Saved Search

A saved search is a search folder with pre-defined search criteria. When you 
create the folder, FileSite places all documents that fulfill the search criteria into 
the folder automatically. Every time you select the search folder in the Folder List, 
the search is performed again and any additional documents that meet the search 
criteria are displayed as contents of the folder. You can share these search folders 
with other users by adding them to the access control list.

Performing a saved search involves the following steps:

NOTE Using Outlook’s native search can lead to 
inconsistent results, so it is recommended that you use 
WorkSite search options.
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 Creating a search folder. See “Creating a Search Folder” on page 123 for 
more information.

 Viewing the search results. When you select a search folder in the Folder List, 
FileSite re-runs the search to see if any additional documents meet the search 
criteria on the search folder.

WorkSite Container Searches

You can search in WorkSite libraries and other containers for WorkSite objects.

Database Search

In FileSite, you can perform searches on one or more WorkSite databases/
libraries that you are currently logged into. The search results appear in the 
Document Grid.

1. From the WorkSite menu, point to Other Search Forms.

In Outlook 2010, on the WorkSite tab, click the  Other Search Forms icon 
from the Search area.

A submenu appears with a list of available libraries.

2. Select the WorkSite library you wish to search from the submenu. The Search 
dialog box opens with the Search Within field populated with your selection.

NOTE You can also modify the search criteria you 
entered when you created the search folder. See 
“Changing Search Folder Profile Information” on 
page 128 for more information.
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Figure 121 Search dialog box, database selected

3. To expand your selection of libraries, click Select to open the list as shown in 
Figure 121. Select All Databases to perform a search on all the libraries 
available to you. 

4. Specify profile information or full-text search criteria, or both. Click OK. The 
search results are displayed in the Document Grid under the  Recent 

NOTE If serialized database searching is enabled by 
your WorkSite Administrator, WorkSite searches each 
library one at a time and displays a dialog box, which 
enables you to cancel the search in between each 
library search. However, this dialog box is displayed 
only when searching a large volume of documents.
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Searches folder. Search results are saved in Recent Searches only for the 
duration of the session.

Saving a Database Search
1. To save this search, click Save Search. The Choose WorkSpace/Folder 

dialog box opens. 

Figure 122 Choose WorkSpace/Folder dialog box

2. Navigate to the Workspace or folder in which you want to search. You can also 
use the Express Search panel to find a location. See “Express Search Panel” 
on page 266 for more information on using this panel. 

NOTE You can also perform a search on a specific 
WorkSite library by expanding the 

 WorkSite Explorer node in the Folder List to display 
a list of available libraries. Right-click the  library 
icon and select Search Documents from the menu, or 
click the  Search Documents icon on the toolbar (or 
on the WorkSite area of the Home tab in Outlook 2010). 
The Search dialog box opens, and you can enter search 
criteria. 
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a. Choose a Folder List component from the shortcut bar on the left. 
Alternately, you can also make a selection from the Look in list. A list of 
available Workspaces and folders appear in the grid.

b. Double-click or select and press enter to drill down into the WorkSite 
container until you reach the Workspace or folder in which you want to 
save the search.

3. Click Select. The Create New Search Folder dialog box opens. See “Creating 
a Search Folder” on page 123 to continue. 

Workspace Search

You can search for Workspaces using FileSite. The Workspaces found are added 
to your Matter Worklist.

1. From the WorkSite menu select Search WorkSpaces, or click the 
 Search WorkSpaces icon on the toolbar.

In Outlook 2010, click the  Search WorkSpaces icon on the WorkSite tab 
or from the WorkSite area on the Home tab.

The Search Workspaces dialog box opens.

Figure 123 Example Search Workspaces dialog box
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2. Enter profile information search criteria. You can also enter full-text search 
criteria in the Full Text field. 

3. Click Search. The search results appear in a search results window, as shown 
in Figure 124.

Figure 124 WorkSpace Search Results

4. Double-click a Workspace in the list, or select a Workspace and click the 
Open button drop-down arrow to display the options in the list:

 Open. The Search Results dialog box closes and you will see the selected 
Workspace under the Matter Worklist in the Folder List. This enables you 
to drill into the Workspace and perform actions on the documents inside 
the Workspace. 

 Add to My Matters. The Add to My Matters dialog box opens. You can 
add the selected Workspace to your My Matters list. If you wish, you can 
change the name of the Workspace. 

 Add to My Favorites. The Add to My Favorites dialog box opens. You can 
add the selected Workspace to your My Favorites list. If you wish, you can 
change the name of the Workspace. 
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Searching Within a Workspace
1. Under the Matter Worklist, right-click the Workspace you want to search and 

select Search Documents from the menu. You can also select the Workspace 
and click the  Search Documents icon in the toolbar. 

In Outlook 2010, click the  Search Documents icon from the WorkSite 
area of the Home tab.

The Search dialog box opens with the Search within field populated with your 
selection.

2. Enter profile information or full-text search criteria, or both. Click OK to 
perform the search. The search results are displayed in the Document Grid 
and saved to the  Recent Searches folder for the duration of the session.

Saving a Workspace Search
The procedure for saving a Workspace search is similar to saving a database 
search. See “Saving a Database Search” on page 237.

Folder Search

You can search within multiple folders or confine your search to a single document 
folder. The search results appear in the Document Grid.

1. In the Folder List, right-click the folder you want to search and select Search 
Documents from the menu. You can also select the folder and click the 

 Search Documents icon on the toolbar. 

In Outlook 2010, click the  Search Documents icon from the WorkSite 
area of the Home tab.

The Search dialog box opens with the Search within field populated with your 
selection.

NOTE Only documents to which you have Full, Read/
write, or Read access rights are returned in your search. 
Documents to which you have no access rights are not 
listed when you perform a search.

NOTE Using the FileSite desktop, you can search only for 
the content within a folder, not for a folder itself. Using the 
WorkSite Integrated Desktop in an integrated application, 
you can search for the content within a folder or for the folder 
itself. See “Search” on page 265 for more information.
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Figure 125 Search dialog box, folder selected

2. If you wish to select another folder, click Select to open the list as shown in 
Figure 125. Select the Choose WorkSpace/Folder option. The Choose 
WorkSpace/Folder dialog box opens. 
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Figure 126 Choose WorkSpace/Folder dialog box

3. Navigate to the folder you want to search. You can also use the Express 
Search panel to find a location. See “Express Search Panel” on page 266 for 
more information on using this panel. 

a. Choose a Folder List component from the bar on the left. Alternately, you 
can make a selection from the Look in list. A list of available Workspaces 
and folders appears in the grid.

b. Double-click, or select and press enter to drill down into the WorkSite 
container until you reach the folder in which you want to search. Click 
Select. 

4. Enter profile information or full-text search criteria, or both. Click OK to 
perform the search. The search results are displayed in the Document Grid 
and saved to the  Recent Searches folder for the duration of the session. 

NOTE Only documents to which you have Full, Read/
write, or Read access rights are returned in your search. 
Documents to which you have no access rights are not 
listed when you perform a search.
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Saving a Folder Search
The procedure for saving a folder search is similar to saving a database search. 
See “Saving a Database Search” on page 237. 
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CHAPTER 7  
Integrated Applications

Overview

This chapter contains the following information to describe WorkSite’s integration 
with other applications: 

 “Introduction”

 “Microsoft Office Integration”

 “Enhanced Application Integration”

 “Classic Application Integration”

 “Additional Microsoft Office Integration Functions”

 “Adobe Acrobat Integration”

 “Integration with Other Applications”

Introduction

Application integration is the seamless integration of WorkSite with applications 
like Microsoft Office. It allows users to perform WorkSite functions directly from 
the application they are using and eliminates the need to switch to FileSite to 
perform certain WorkSite tasks. FileSite is actively integrated with most major 
Windows applications.
FileSite Installation and User’s Guide  245

• 
• 
• 
•
•
•



Chapter 7 Integrated Applications

24
Microsoft Office Integration

NOTE FileSite and Microsoft Office Integration for 
WorkSite now support Microsoft Office 2007 and Microsoft 
Office 2010, which have a new look and feel. In both 
versions, the traditional menu bar has been replaced with a 
ribbon bar. WorkSite functionality for these versions is 
available from the tabs on the ribbon bar or from the later 
version’s File menu equivalent - the Office button for Office 
2007, or the File button for Office 2010, as shown in Figure 
127 on page 247. For steps that reference the Office 2003 
File menu, the File menu equivalent is implied for later 
versions of Office.

NOTE The procedural steps and example screenshots 
throughout this chapter use Microsoft Office 2003 as the 
base version. For procedural steps or screenshots that are 
identical or similar for Office 2007 or Office 2010, no 
alternate steps or screenshots are included, so the 
screenshots in some instances may differ slightly. For 
procedural steps or screenshots that differ significantly for 
Office 2007 or Office 2010, alternate steps and/or 
screenshots are included following the steps and 
screenshots for Office 2003.
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Figure 127 Office 2003 File Menu and later version equivalents

FileSite can be integrated with Microsoft Office applications in two ways: active 
integration or passive integration. The functionality associated with these two 
methods of integration is essentially the same. However, they differ in terms of the 
changed menu options available under the integrated application’s File menu:

 With active integration, FileSite replaces some of the application’s File menu 
to provide access to WorkSite commands.
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 With passive integration, FileSite adds separate menu commands to the File 
menu.

The appearance and functionality of the WorkSite Integrated dialog boxes that 
appear when using the menu options may also differ.

Getting Started in the Integrated Application

The behavior of the integrated application at startup depends on how your system 
is configured and whether other WorkSite components are running. The Microsoft 
Office Integration Module can prompt you to select a connection mode at startup 
or can automatically start in online mode.

Choice of Connection Mode

When you launch an integrated application, you are prompted to select the 
connection mode under the following circumstances:

 No servers are registered for use in FileSite. This occurs when you start an 
integrated application for the first time after installing FileSite.

 No connection can be made to the registered servers.

 The Prompt User for Connect Mode feature is enabled. Contact your 
WorkSite Administrator for more information on enabling or disabling this 
feature.

The Select Connection Mode dialog box opens.

Figure 128 Select Connection Mode dialog box

In Office 2007 or Office 2010, open the Select Connection Mode dialog box from 
the WorkSite tab on the Office application’s ribbon bar.
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Figure 129 Example WorkSite tab on Office application ribbon bar

Choose from the following options:

 Connect. Select this option to log into the registered servers. If you have not 
previously connected to a WorkSite Server, the Register and Login dialog box 
opens. See “Registering a Server” on page 54 for more information. When you 
are connected to a WorkSite Server, you can use all the features of FileSite 
and access all documents in libraries to which you have access rights.

 Work Offline. Select this option to access the WorkSite neighborhood in the 
offline mode. This mode lets you work on portable checked-out documents 
stored in the NrPortbl directory, as well as echo documents stored in the 
NRTEcho directory. When you later connect to the registered servers, you can 
check the documents back into the WorkSite library and synchronize the 
documents with those in the library. See Chapter 10 for more information.

 Local. Select this option to create and use documents available on your local 
or network drives. When you are finished, you can keep the documents on 
your local or network drive or switch to online mode to import the documents 
into WorkSite libraries.

Automatic Online Mode

After you start an integrated application and register the servers, the Integration 
module starts in online mode automatically. If one of the conditions listed in 
“Choice of Connection Mode” on page 248 is true, the integration module fails to 
start automatically and you are prompted to select a connection mode.

NOTE When using the online and offline modes with 
active integration, you can still access files on your local 
or network drives using the Local Open and Local 
Save As commands.

NOTE With passive integration, the Microsoft Office 
application’s Open, Save, and Save As options are not 
affected by FileSite and can be used to access files on 
your local or network drives.
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Seamless Online/Offline Transition

Applications integrated with FileSite now support the following features to provide 
a seamless online/offline transition:

 Mode switching no longer requires closing FileSite and launching it in a 
different mode. FileSite now supports explicit switching of modes via a Switch 
Online/Offline menu item on the WorkSite menu (or WorkSite tab for 
Outlook 2010). This feature requires iManage OffSite. Mode switching can 
take place while the application is open.

 If multiple WorkSite applications (namely FileSite and integrated applications 
like Word, Excel, PowerPoint and Adobe) are running simultaneously, the 
modes of all the applications can be switched simultaneously by initiating the 
switch from any WorkSite application.

 On change of status of network connectivity, an attempt is made to check 
whether the WorkSite Server is available. If the connection to the WorkSite 
Server is lost or restored, the user is notified via a message in the system tray 
and is prompted to switch connection mode. For example, if a user is working 
in online mode and the connection to the network is lost, the user will be 
notified and prompted to switch to offline mode.

Figure 130 Prompt to Switch Offline

The WorkSite icon in the system tray displays a red X, indicating that there is 
no connection to the WorkSite Server: 

When a user is working offline and a server connection becomes available, 
the following prompt appears in the system tray:

NOTE After switching to Offline mode, the message in 
the system tray will not change until the connection to 
the WorkSite Server is restored. It will then prompt the 
user to switch Online.
0 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Microsoft Office Integration
Figure 131 Prompt to Switch Online

When the connection is restored, the WorkSite icon in the system tray displays 
a green arrow: 

By default, the collaborative mode switching feature is disabled in FileSite. The 
execution of the Switch Online/Offline option in the WorkSite Office integration 
menu can be performed as in earlier versions. You must close and relaunch all 
open WorkSite applications to switch connection modes.

NOTE After switching to Online mode, the message in 
the system tray will not change until the connection to 
the WorkSite Server is lost. It will then prompt the user 
to switch Offline.

NOTE There may be certain circumstances when the 
mode switch will not be performed successfully, for 
example, when a WorkSite dialog is open in the 
application or when the user is working offline with 
modified documents open in OffSite. In the latter case, 
the user should save the document(s) and then switch 
connection modes.

NOTE To enable seamless transition from online/offline 
modes, see “Seamless Online/Offline Transition” on 
page 250.

NOTE Your WorkSite Administrator can enable a Work 
Online/Offline option on the WorkSite menu (or WorkSite 
tab for Outlook 2010).
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Delayed Login Option

Microsoft Office integration with FileSite can be configured to delay logging into a 
WorkSite Server until you need to open a WorkSite document or save a document 
to WorkSite. This avoids unnecessary delays when you are working locally in your 
Office application.

Pre-Profiling Template

The pre-profiling template allows you to define profile information for a document 
during its initial creation.

In an integrated application, the Integrated Save As dialog box usually appears 
when the document is saved. With the pre-profiling template enabled, the 
Integrated Save As dialog box appears when the document is initially created. 
This allows you to define profile information and designate a WorkSite location for 
the document at the time of creation.

When you click New from the integrated application’s File menu, the Integrated 
Save As dialog box appears. On this dialog box, you can enter profile information 
for the document. When you click OK, the profile information is saved and the 
document exists, in a checked-out state, in the designated WorkSite location. 
When you close the document, a typical WorkSite check-in function is performed.

To enable this feature for Microsoft Word or Microsoft Excel, download the 
appropriate .zip file located in $worksite_install_path$\macros. Installation 
instructions are included in each .zip file.

NOTE The Delayed Login feature is enabled when you turn on 
the enhanced mode switching functionality. See “Seamless 
Online/Offline Transition” on page 250 for instructions. To 
manually create the Delayed Login key in the registry on your 
computer, refer to the WorkSite Desktop Client Customization 
Guide.

NOTE This feature is only available for Microsoft Word and 
Microsoft Excel version 2007 or 2010.

NOTE For the pre-profiling template to function as 
expected, you must have an active connection to the 
WorkSite Server. You can either disable the Delayed Login 
feature (see “Delayed Login Option”) or manually log in to 
the WorkSite Server after launching Word or Excel.

NOTE For this feature to function correctly, macros must be 
enabled in the integrated application.
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Menus with WorkSite Options

When integrated with FileSite, WorkSite commands are available on the File 
menu, the Edit menu, and the Insert menu. A WorkSite menu is added to the 
application’s menu bar.

In Office 2007 Integration or Office 2010 Integration, WorkSite commands are 
available on the Home tab, the Insert tab, the Mailings tab, and the Review tab. 
A WorkSite tab is added to the application’s ribbon bar.

File Menu

The options available on the integrated application’s File menu are determined by 
the mode of integration.

Active Integration

When an application is actively integrated with FileSite, its File menu changes to 
provide access to WorkSite documents. Certain functions such as Open, Close, 
Save, and Save As are changed. Also, new commands such as Local Open, 
Local Save As, Send WorkSite Link, and WorkSite Properties are added to the 
menu. Figure 132 illustrates an example of the Microsoft Word File menu when 
actively integrated with FileSite.
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Figure 132 Example File menu, Active Integration

Open
The Open command launches the WorkSite Integrated Open dialog box.

See “Enhanced Application Integration” on page 262 and “Classic Application 
Integration” on page 277 for more information on the functionality of the WorkSite 
Integrated Desktop.

NOTE In Office 2007 Integration or Office 2010 Integration, 
the Properties and Send Link options are available on the 
WorkSite tab and on the WorkSite area of the Home tab.
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Local Open 
The Local Open command exists only if the application is integrated. Selecting it 
launches a standard Windows Open dialog box, which you can use to locate files 
on your local or network drive. You can use this option to open a document that is 
not in a WorkSite library. 

Save and Save As
The Save and Save As commands behave differently in the Classic and 
Enhanced modes of integration.

In the Enhanced mode of integration, the Save and Save As commands open the 
WorkSite Integrated Save As dialog box if the document is being saved for the 
first time. If the document already exists on a local drive, the Save command 
simply saves the document, and the Save As command opens the Save As 
Options dialog box.

In the Classic mode of integration, the Save and Save As commands open the 
Save As Options dialog box if the document is being saved for the first time. If the 
document already exists on a local drive, the Save command simply saves the 
document, and the Save As command opens the Save As Options dialog box.

See “Enhanced Application Integration” on page 262 and “Classic Application 
Integration” on page 277 for more information on the functionality of the WorkSite 
Integrated Desktop.

Local Save As
The Local Save As command opens a standard Windows Save As dialog box. 
Use this dialog box to save your file on your local or network drive. The Local 
Save As command is a convenient method of saving the file independently of 
FileSite and any libraries to which you may be connected. It is equivalent to using 
the Export function in FileSite.

If you use the Local Save As option to save a WorkSite document to a local drive, 
modifications you make before saving are not reflected in the original document in 
the WorkSite library.

NOTE Local Open may be disabled in selected 
applications by your WorkSite Administrator. 

NOTE Local Save As may be disabled in selected 
applications by your WorkSite Administrator.
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Close
When you click  Close to close a document in an integrated application, you 
can save the document if the contents have changed since the document was 
opened. Figure 133 shows an example of the message that appears when you 
close a document in an integrated application.

Figure 133 Example Close message

If you select Yes from this message box, FileSite responds as if you selected 
Save from the File menu. If the document is not already in a WorkSite library, or 
does not have profile information already saved, you are prompted to enter profile 
information for the new document.

Print
Printing documents in integrated applications functions the same as printing them 
in non-integrated applications. When you print a WorkSite document in Microsoft 
Word, the document’s activity history is updated to show that the document was 
printed, how many pages were printed, and who printed the document.

WorkSite Properties
When you select WorkSite Properties from the File menu, the Properties dialog 
box for viewing or editing document profile information appears. See Figure 135.

In Office 2007 or Office 2010, the Properties option is on the WorkSite tab on the 
ribbon bar. It is also available on the Home tab. With a WorkSite document open, 
click Properties to display the basic properties quick view shown in Figure 134. 
To modify properties that do not appear in the quick view above the document, 
click the Advanced button to open the Properties dialog box shown in Figure 135. 
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Figure 134 WorkSite Properties quick view

Users who have Read access to a document cannot change the information 
displayed in the Properties dialog box. Users with Read/Write access can change 
certain fields, such as the Comments field. Only the Author and Operator of a 
document have the full authority to change the access privileges on the 
document.

NOTE The dialog box used to enter profile information is 
customizable by your WorkSite Administrator. The dialog 
boxes that appear in your version of FileSite may differ from 
the default shown in Figure 135.
FileSite Installation and User’s Guide  257

• 
• 
• 
•
•
•



Chapter 7 Integrated Applications

25
Figure 135 Properties dialog box, Default appearance

Send WorkSite Link
When a WorkSite document is open in an integrated application, and you select 
Send WorkSite Link from the File menu, a new e-mail message appears with a 
WorkSite link (as an .nrl file) to the currently active document included as an 
attachment. The link can then be sent to any user who can normally access the 
document.

In Office 2007 Integration or Office 2010 Integration, the Send Link option is 
available from the WorkSite tab and the Home tab on the ribbon bar.
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Figure 136 Example Send Link on the WorkSite ribbon bar

Passive Integration

The Passive Integration option can be set by your WorkSite Administrator 
according to the needs of your system. When the Passive Integration option is 
set, the functionality of the Open and Save operations remains unchanged. 
Separate menu options to perform a WorkSite Open and WorkSite Save As are 
added to the File menu.

Most menu options are similar to those described in Active Integration. The 
differences are detailed in this section.
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Figure 137 File menu, Passive Integration

Open
The Open command launches a standard Windows Open dialog box, which you 
can use to locate files on your local or network drive. You can use this option to 
open a document that is not in a WorkSite library.

WorkSite Open
The WorkSite Open command launches the WorkSite Integrated Open dialog 
box. See “Enhanced Application Integration” on page 262 and “Classic 
Application Integration” on page 277 for more information on the functionality of 
the WorkSite Integrated Desktop.
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Save As
The Save As command opens a standard Windows Save As dialog box. Use this 
dialog box to save your file on a local or network drive. When you use this option, 
you save the file independently of FileSite and any libraries to which you may be 
connected. If your document originated from a WorkSite library, the Save As 
option does not automatically update the original copy of the document with any 
changes you may have made.

WorkSite Save As
The WorkSite Save As command behaves differently in the Classic and 
Enhanced modes of integration.

In the Enhanced mode of integration, the WorkSite As command opens the 
WorkSite Integrated Save As dialog box. In the Classic mode of integration, the 
WorkSite As command opens the Save As Options dialog box.

See “Enhanced Application Integration” on page 262 and “Classic Application 
Integration” on page 277 for more information on the functionality of the WorkSite 
Integrated Desktop.

Enhanced and Classic Application Integration

Both active and passive integration with Microsoft Office applications are available 
in two formats:

 Enhanced Application Integration

 Classic Application Integration

These formats determine the configuration of the Integrated Desktop. You can use 
this interface to view your WorkSite folders and Workspaces and perform 
operations on WorkSite documents, such as view, check out, check in, and edit 
profile.

Your WorkSite Administrator can set the integration format to either Classic 
Application Integration or Enhanced Application Integration.

The Enhanced Application Integration mode is enabled in the application by 
default. This integration format supports a matter-centric approach to document 
management. It allows you to profile documents by dragging them into folders. 
Documents inherit the profile information set for each folder. If the folder's profile 
contains sufficient information to profile the document, you can save documents in 
the WorkSite repository without being prompted to enter document profile 
information. The Enhanced Application Integration Open and Save As dialog 
boxes also contain features that make it easy to locate and save documents to 
WorkSite. See “Enhanced Application Integration” on page 262 for more 
information.
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In the Classic Application Integration desktop, you are always prompted to enter 
document profile information when saving content to WorkSite from an integrated 
application.

See “Classic Application Integration” on page 277 for more information.

Enhanced Application Integration

When you open a WorkSite document from within an integrated application, the 
WorkSite Integrated Desktop appears instead of the standard Windows dialog 
boxes that normally appear when you perform certain functions such as Open, 
Save or Save As from the File menu.

Figure 138 WorkSite Integrated Desktop, Enhanced mode

Elements of the Enhanced Integrated Desktop

Shortcut Bar
On the left side of the Enhanced Integrated Desktop is the Shortcut Bar. It 
contains shortcuts to Recent Folders, Checked-out Documents, Document 
Worklist, Matter Worklist, My Matters, My Favorites, and the WorkSite Explorer. 
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You can also select containers and navigate to their subfolders from the Look in 
list. Click any icon in the Shortcut Bar to display its subfolders. Documents 
contained in a selected folder are listed in the Document Grid.

Document Grid
All the documents or containers selected in the Shortcut Bar are displayed in the 
Document Grid. To see the contents of a container, double-click it. You can 
organize the list in ascending or descending order by clicking the column 
headings.

You can narrow the focus of documents in the Document Grid by making 
selections from the following options in the Filter Conditions area:

 Type

 Last Modified

Toolbar
The toolbar of the Enhanced Application Integration desktop has controls for 
navigating within the desktop.

Look in
Choose a container from the Look in list (as shown in Figure 139) to start looking 
for the document you want to open.

Figure 139 Look in list

Back
Click the  BACK arrow to navigate to the last list you looked at.

Up One Level
Click the  Up One Level icon to access a container higher in the tree structure.

Create New Folder‘
Click the  Create New Folder icon to create a new folder in the current 
container.
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Delete
The  Delete icon is enabled when you have Full Access to the document that is 
selected in the Document Grid. To delete a document, select the document from 
the Document Grid and click the Delete icon. Users who have Read/Write access 
can remove a document from the folder but cannot delete it from the WorkSite 
library. 

View Menu
The  View Menu button allows you to toggle between showing the column 
heading or not. You can also customize the information that appears in the 
Document Grid by clicking the down View Menu button drop-down arrow to 
display a list of options:

 List. Displays a list view of the documents or containers selected.

 Detail. Displays a detailed view of the documents or containers selected.

 Option. Opens the View Options dialog box.

Figure 140 View Options dialog box
4 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Menus with WorkSite Options
Select the options you want to display in the column heading. You can change the 
order of the headings by selecting a heading and using the Move Up or Move 
Down buttons. Click OK when you have completed your selections.

Search
Click the Search button drop-down arrow to perform a standard WorkSite search. 
You can select from a list of options:

 Express Search Panel. Displays the Express Search panel. See “Express 
Search Panel” on page 266 for information on using this panel to perform 
searches.

 Advanced Workspace Search. Opens the Search Workspaces dialog box. 
See “Workspace Search” on page 238 for details on using the Search 
Workspaces dialog box.

 Advanced Folder Search. Opens the Search Folders dialog box. Using this 
dialog box, you can search for a particular folder and access the contents 
within that folder.
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Figure 141 Search Folders dialog box

Enter search criteria in the dialog box fields and click Find. Your search results 
are returned in the WorkSite Integrated Desktop dialog box.

 Advanced Document Search. Opens the Search Dialog box.

Each Search Dialog box is customizable by your WorkSite Administrator, so the 
options available may vary. See Chapter 6 for detailed information on performing 
WorkSite searches.

Express Search Panel
The Express Search panel contains the following options:

 Database Scope

 Type Selection

NOTE When performing a folder search based on an 
e-mail address, use only the folder id, not the entire 
e-mail address. For example, if the folder’s e-mail 
address is folder1.databasename@domain.com, 
the folder id is folder1. A search for the entire e-mail 
address will return no results.

NOTE For details on searching within folders using the 
FileSite desktop, see “Folder Search” on page 240.
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 Recent Search

Database Scope
You can use the Database Scope option to scope your search queries to a 
particular database. You can also select all the available databases for your 
search.

Express Search detects all the databases connected to your WorkSite Server 
setup. To select a database, click the Database Scope drop-down menu. The 
available databases are listed and the primary database is selected by default. 
The currently selected database is marked with a check mark as shown in Figure 
142.

Figure 142 Default Scope  

To choose a different database, click the desired database. A check mark appears 
next to the selected database. To clear this selection, click the database once 
more. To choose all available databases, select the All Databases option.

Selecting the All Databases option clears all the individual database selections in 
the menu. Clearing the All Databases option selects the primary database in the 
menu.

Type Selection
You can use the Type Selection drop-down menu to select the desired search 
type (see Figure 143).

NOTE If you run a search query using the Scope keyword, 
this query takes precedence over the databases that were 
selected from the drop-down menu. However, the 
databases selected from the drop-down menu are retained 
as your default scope.
FileSite Installation and User’s Guide  267

• 
• 
• 
•
•
•



Chapter 7 Integrated Applications

26
Figure 143 Type Selection

You can choose from the following options:

 Type:Workspace. type:workspace is added to the query box and the 
search query. When executed with other parameters, it returns Workspaces in 
the results.

 Type:Document. type:doc is added to the query box and the search query. 
When executed with other parameters, it returns all document types.

 Type:Email. type:email is added to the query box and the search query. 
When executed with other parameters, it returns e-mails.

To run a search query:

1. In the query box, enter a search term or use the autocomplete feature to add a 
search query.

The autocomplete feature suggests keywords in a list as soon as you start 
entering text in the query box.

2. If a value in the list of suggestions matches your criteria, click the value or 
press the DOWN arrow key to select the value and press ENTER. The value 
appears in the query box with a list of suggestions (if any) for this entry.

NOTE Results are not displayed for the search queries 
‘type:workspace’, ‘type:email’ and 
‘type:document’, unless they are executed with other 
parameters. For example, type:workspace 
createdate:last month.

NOTE If you enter type:email in the query box while 
Type:Workspace was previously selected from the 
drop-down menu, then type:email takes 
precedence. The same rule applies to other options in 
the drop-down menu. For example, if you enter 
type:email custom1:legal while 
Type:Workspace was selected from the drop-down 
menu, then the type control is refreshed to Email.
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For example, search for Workspaces using the keyword ‘type’. When the letter 
‘t’ is entered, the suggestions ‘to’ and ‘type’ are displayed (see Figure 144).

Figure 144 Autocomplete feature

3. Select type from the list. ‘Type’ appears in the query box with a colon (:), and 
a list of values for ‘Type’ are displayed (see Figure 145).

Figure 145 Autocomplete feature (suggestion selected)

4. Select Workspace from the list.

5. Enter ‘c’ and select createdate, then choose last month from the list of 
suggestions. The search query is executed and the results are displayed in 
the Document Grid.

Recent Search
You can use the Recent Search option to access the last ten search queries that 
you executed (see Figure 146).

NOTE Any search query entered is automatically 
executed based on the number of seconds set in the 
Miner Preferences section of the Preferences dialog 
box. The Preferences dialog box is accessed using 
Express Search. For more information, refer to the 
WorkSite Express Search User’s Guide.
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Figure 146 Recent Search

The Recent Search option follows these rules:

 If you clear the query box using the X button (to the right of the query box), the 
search query is added to the top of the Recent Search list and the tenth (last) 
search query is removed from the list.

 If you delete the search query without using the X button to clear the query 
box, the search query always replaces the top most search query in the 
Recent Search list.

To access your recent search queries, click the DOWN arrow button next to the 
query box and select Recent Search as shown in Figure 146. The last ten search 
queries that you executed are displayed. To execute a search query again, select 
the search query from the list. The query box is populated with the search query.

Quick Search Panel
The Quick Search panel does not appear by default. Contact your WorkSite 
Administrator to enable it in the WorkSite Integrated Desktop. Refer to the 8.2 
FileSite Installation and User’s Guide for more information on using the Quick 
Search panel.

Quick Open Panel
The Quick Open panel does not appear by default. Contact your WorkSite 
Administrator to enable it in the WorkSite Integrated Desktop. Refer to the 8.2 
FileSite Installation and User’s Guide for more information on using the Quick 
Open panel.

NOTE Autonomy recommends using the more advanced 
Express Search panel for searching documents. See 
“Express Search Panel” on page 266 for more information.

NOTE Autonomy recommends using the more advanced 
Express Search panel for searching documents. See 
“Express Search Panel” on page 266 for more information.
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Working with Documents in the Enhanced Integrated Desktop

You can perform all the typical document functions from the Enhanced Integrated 
Desktop by right-clicking the document in the Document Grid and selecting the 
desired option from the menu. Some commonly used document functions are 
discussed here:

 “Opening Documents”

 “Viewing Documents”

 “Editing Document Profile Information”

 “Saving Documents”

 “Checking Out Documents”

 “Checking In Documents”

 “Exporting Documents”

 “Removing Documents from a Folder”

 “Deleting Documents”

 “Unlocking Documents”

 “Displaying Document Information”

For more information on other document functions, see Chapter 5.

Opening Documents
The Enhanced Integrated Desktop is used to access documents in WorkSite. You 
can reach it by selecting Open from the application's File menu. Select a 
document from the Document Grid and right-click the selection or click the Open 
button drop-down arrow to display the following list of options:

 Open. Opens the original document in the WorkSite library.

 Open Read-only. Opens a read-only copy of the document.

 Open a Copy. FileSite launches the New Profile dialog box for you to enter 
the new document’s profile information.

 Open a New Version. FileSite launches the New Version Profile dialog box for 
you to enter the new version's profile information.

 Open and Repair. Opens and repairs the corrupted document.
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 Local Open. Opens the local copy of the document stored on your local or 
network drive. 

Viewing Documents
To view a document, select the document from the Document Grid and right-click 
or press SHIFT+F10. Select View from the menu.

The View command launches a read-only version of the selected document in the 
WorkSite Viewer application. See Chapter 9 for more information. Viewing 
documents is useful to verify that you have selected the correct document before 
you check it out.

Editing Document Profile Information
To edit or view a document's profile information, select the document from the 
Document Grid and right-click or press SHIFT+F10. Select Properties from the 
menu.

The Properties dialog box displays the document’s current profile information. You 
can edit the information displayed and then record your changes. See “Editing 
Document Profile Information” on page 146 for more information.

In Office 2007 or Office 2010, the Properties option is on the WorkSite ribbon bar. 
With a WorkSite document open, click Properties to display and edit the 
document’s properties. To modify properties that do not appear in the quick view 
above the document, click the Advanced button to open the Properties dialog box 
shown in Figure 135.

Saving Documents
1. To save a new document, select Save or Save As from the File menu of the 

integrated application. The WorkSite Integrated Save As dialog box appears 
(see Figure 148).

NOTE You can also use the Express Search panel to 
open a document in its native application. In the query 
box, enter doc.num: <Document number of the 
document> version: <Version number of the 
document>, and press Enter. The Enhanced 
Integrated Desktop closes and the document is opened 
in its native application. 
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To save an existing WorkSite document that is open in the integrated 
application, when you select Save As, the Save As Options dialog box 
appears (see Figure 147). 

Figure 147 Save As Options dialog box

Select from the following options:

 Replace Original

 New Version

 New Document

When you click OK, the WorkSite Integrated Save As dialog box appears (see 
Figure 148). 

NOTE In Office 2007 Integration or Office 2010 
Integration, you cannot modify the value in the Save As 
Type field when you replace an original WorkSite 
document.

NOTE In Office 2007 or Office 2010 Integration, when 
you update the file format to the later version and save 
the document as a New Version or New Document, the 
value in the Save As Type field is changed accordingly.
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Figure 148 Integrated Save As dialog box, Enhanced mode

2. Navigate to the Workspace or folder where you want to save the document. 
You can also use the Express Search panel to find a location. See “Express 
Search Panel” on page 266 for more information on using this panel.

 To display the names of documents in the current location, click Show 
Documents in this folder.

 Enter the appropriate information in the Author, Class, and Subclass (if 
applicable) fields.

 Click Save.

3. If the folder’s metadata does not include all required fields, the New Profile 
dialog box opens for you to enter profile information. You can also open the 
New Profile dialog box by clicking Detail.

NOTE When the document is added to the folder, it 
automatically inherits the folder’s profile properties or 
metadata. If the folder’s metadata includes all required 
fields, FileSite automatically creates the profile without 
requiring further input.
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4. Click Save to save the document to the WorkSite library. 

Checking Out Documents
To edit a document, you must first check it out of the WorkSite library and 
temporarily store it on your local or network drive.

To check out a document, select the document from the Document Grid and 
right-click or press SHIFT+F10. Select Checkout from the menu.

Use the Checkout feature when you want to work on a document outside the 
Document Management System (i.e., on your local workstation, or away from the 
network) and you intend to return the document to the system as the same 
document. The Checkout feature prevents anyone else from editing the document 
while you work on it.

See “Checking Out Documents” on page 162 for more information.

Checking In Documents
To check in a document that is marked “checked-out”, select the document from 
the Document Grid and right-click or press SHIFT+F10. Select Checkin from the 
menu. The Check In Options dialog box replaces the document that you 
previously checked out.

See “Checking In Documents” on page 163 for more information.

Exporting Documents
To export a copy of a document to your local or network drive, select the 
document from the Document Grid and right-click or press SHIFT+F10. Select 
Export from the menu.

See “Exporting Documents” on page 159 for more information.

Removing Documents from a Folder
To remove a document from a folder, select the document from the Document 
Grid and right-click or press SHIFT+F10. Select Remove from folder from the 
menu.

NOTE Your WorkSite Administrator may set up your 
system so that the Author, Class, and Subclass fields 
do not appear in this dialog box. In that case, click Detail 
to complete these fields.
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See “Removing Documents from a Folder” on page 121 for more information.

Deleting Documents
When you delete a document, you have the option of removing it from the folder 
or permanently deleting it from the WorkSite library.

To delete a document, select the document from the Document Grid and 
right-click or press SHIFT+F10. Select Delete from the menu. Only the Author or 
Operator of a document can delete it. See “Deleting Documents” on page 170 for 
more information.

Unlocking Documents
To unlock a document, select the document from the Document Grid and 
right-click or press SHIFT+F10. Select Unlock from the menu. See “Unlocking 
Documents” on page 175 for more information.

Displaying Document Information
You can view the following information about a document:

 “Versions”

 “History”

 “Related Documents”

 “Checkedout Info”

Versions
To view a list of the document’s versions, select the document from the Document 
Grid and right-click or press SHIFT+F10. Select Versions from the menu. See 
“Document Versions Tab” on page 134 for more information.

History
To view a document’s history, select the document from the Document Grid and 
right-click or press SHIFT+F10. Select History from the menu. See “History Tab” 
on page 134 for more information.

NOTE The Remove from folder menu option does not 
remove a document from the network or a particular library. 
Removing a document from the network or library requires 
the Delete command. Not everyone who has the Remove 
from folder menu option permission has the Delete 
permission. Contact your WorkSite Administrator for more 
information.
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Related Documents
To view a document’s relations, select the document from the Document Grid and 
right-click or press SHIFT+F10. Select Related Documents from the menu.

Document relations are one of the ways you can organize and group documents, 
in addition to folders and document classifications. See “Related Documents Tab” 
on page 134 for more information.

Checkedout Info
To display information about a checked-out document, select the document from 
the Document Grid and right-click or press SHIFT+F10. Select Checkedout Info 
from the menu. The Document Checked Out dialog box opens with the checked 
out information. See “Checkedout Info” on page 183 for more information.

Classic Application Integration

WorkSite documents can be accessed directly through an integrated application. 
The WorkSite Integrated Desktop appears instead of the standard Windows 
dialog boxes that normally appear when you perform certain functions, such as 
Open from the File menu.

Elements of the Classic Integrated Desktop

This section describes the elements of the Classic Integrated Desktop.
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Figure 149 Open dialog box on the Classic Integrated Desktop

Figure 149 consists of the following elements:

 1 - Shortcut Frame

 2 - Tree Frame

 3 - Document Grid

 4 - Document Information

Tree Frame

On the left side of the Classic Integrated Desktop is the Tree Frame. It contains 
the organizational structure of all servers, libraries, WorkSite Workspaces, folders, 
worklists and saved searches. It is similar to the Folder List appearing in the 
FileSite desktop. See “Folder List” on page 76 for more information.

Click any icon in the Tree Frame to display its subfolders. Documents contained in 
a selected folder are listed in the Document Grid.
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Shortcut Bar
The Shortcut Bar contains the Tree Frame for the WorkSite Server you are logged 
into. The WorkSite shortcut bar exists as a default and cannot be deleted. You can 
create a shortcut bar beneath the Browse Bar and add folders to it.

To create a shortcut bar:

1. Right-click the WorkSite shortcut bar. Select Add Group from the menu.

2. Enter the name of the new group.

To delete a shortcut bar:

1. Right-click the shortcut bar you wish to delete.

2. Select Remove Group from the menu.

To insert folders into the shortcut bar:

1. In the Tree Frame, right-click the folder to be added to a shortcut bar.

2. Select Add to Shortcut bar from the menu.

3. Select the shortcut bar in which you wish to insert the folder.

Server Selection List
The Server Selection list allows you to select the servers currently available to 
you. Click the list to open the menu and select the server from the list.

Document Grid
All the documents of a selected folder in the Tree Frame are displayed in the 
Document Grid. Click the column headings to organize the list in ascending or 
descending order.

Make selections from the following options in the Document Selection area to 
narrow the focus of documents in the Document Grid:

 Database

 Document Number

 Document Version

 Document Type

 Last Modified

Toolbar
The options on the Classic Integrated Desktop are described in this section.
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Search
Click Search to perform a standard WorkSite search. The Search dialog box 
opens. See Chapter 6 for detailed information on performing WorkSite searches.

Show Fields
The  Show Fields icon allows you to configure the columns that appear in the 
Document Grid. Click the Show Fields icon to open the Select Fields to Display in 
Grid dialog box. Choose the fields to display as columns in the Document Grid 
from this dialog box.

Forward and Back Buttons
Use the Forward and Back buttons to navigate through folders in the tree in the 
order in which you visited them.

Working with Documents in the Classic Integrated Desktop

You can perform all the usual document functions from the Classic Integrated 
Desktop by right-clicking the document in the Document Grid and selecting a 
command from the context menu.

All commands in the Classic Integrated Desktop are similar to the Enhanced 
Integrated Desktop except the Open, Save, and Save As commands.

See “Working with Documents in the Enhanced Integrated Desktop” on page 271 
for information on the other document functions.

Opening Documents
To use the Classic Integrated Desktop to access a document in WorkSite, select 
the document in the Document Grid and click Open at the bottom of the desktop. 
By default, FileSite opens the document when you click the Open button. Other 
options are available from the Open menu:

 Open. Opens the original document in the WorkSite library.

 Open Read-only. Opens a read-only copy of the document.

 Open a Copy. FileSite generates a copy of the document and launches the 
New Profile dialog box for you to enter the new document’s profile information.

 Open a New Version. FileSite creates a new version of the document and 
launches the New Version Profile dialog box for you to enter the new version's 
profile information.

 Open and Repair. Opens and repairs the corrupted document.

 Local Open. Opens the local copy of the document stored on your local or 
network drive.
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Saving Documents
If you create a new document or a local file and choose Save or Save As from the 
File menu, the Save As Options dialog box appears.

Figure 150 Save As Options dialog box, Classic mode

To move between fields, use the TAB key, arrow keys, and ALT key plus 
underscored letter.

There are three options for saving a document:

 Replace Original. Replaces the original document. This option functions the 
same as selecting Save from the File menu. If you have Read access to the 
document, you cannot use this option. Instead, save the document as a New 
Version of the original document or as a New Document.

 New Version. FileSite automatically assigns a new version number to the 
document and the New Version Profile dialog box opens to enter the new 
version's profile information.

 New Document. Launches the New Profile dialog box for you to enter the 
new document's profile information.

If your application is ODMA-compliant, FileSite remembers the option you used 
the last time you performed the Save As command and uses that option as the 
default. However, your WorkSite Administrator can set a specific option to use as 
the default all the time.
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If the active document does not exist in FileSite when you select the Save As 
command, then FileSite saves it as a new document. 

Working with WorkSite Links in Office Integration

In the integrated application, you can perform various linking functions with 
WorkSite documents using WorkSite commands on the application’s menu.

File Menu
From the File menu, select Send WorkSite Link to send an e-mail containing a 
link to the open WorkSite document.

Figure 151 Microsoft Word integrated File menu

In Office 2007 Integration or Office 2010 Integration, the Send Link option 
appears on the Home tab and the WorkSite tab of the ribbon bar.

NOTE The Save As command in an actively integrated 
application functions the same as the WorkSite Save As 
command in a passively integrated application.
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Figure 152 Example Send Link option on Home ribbon bar

Edit Menu
From the Edit menu, you can perform the following operations in WorkSite 
documents containing linked objects (see Figure 153):

 Importing Documents containing Linked Objects

 Editing Links in Documents containing Linked Objects

 Replacing Links in Documents containing Linked Objects

Figure 153 Edit menu

Insert Menu
From the Insert menu, you can perform the following linking functions:

 Inserting links in documents

 Inserting files in documents

 Inserting hyperlinks in documents
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Figure 154 Insert menu

In Office 2007 Integration or Office 2010 Integration, the WorkSite commands 
Insert Link and Insert Footer are located on the Insert tab of the ribbon bar.

Figure 155 Example WorkSite Link and Footer on Insert ribbon bar

The WorkSite Link button has the following options:

  Insert Link. Inserts the entire content of the WorkSite document as a 
WorkSite OLE link into another WorkSite document.

  Insert Link As Icon. Insert a link to a WorkSite document as an icon into 
another WorkSite document. Click the icon to view the document.

  Insert Hyperlink. Inserts a hyperlink to a WorkSite document into another 
WorkSite document. Roll over the hyperlink to view the document’s properties 
in a tooltip. See “Inserting a WorkSite Hyperlink” on page 285.

  Insert Text from File. Insert selected text from a WorkSite document into 
another WorkSite document.
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  Edit Links. Edit the links in a WorkSite document containing linked 
objects.

  Import Links. Import a WorkSite document containing linked objects.

  Replace Links. Replace the links in a WorkSite document containing 
linked objects.

Figure 156 Example Insert Link menu on WorkSite ribbon bar

See Chapter 8 for more detailed information.

Inserting a WorkSite Hyperlink

In Microsoft Office integration with FileSite, you can insert a hyperlink to a 
WorkSite document into another WorkSite document.

1. Open the document in which you want to insert the hyperlink.

2. Place the cursor where you want to insert the hyperlink, or select the text you 
want to hyperlink.

3. From the Insert menu, point to WorkSite Object, and select Insert 
Hyperlink. The Insert WorkSite Link dialog box appears.

In Office 2007 or Office 2010, select Insert Hyperlink from the Insert Link 
menu on the WorkSite tab (see Figure 156).
FileSite Installation and User’s Guide  285

• 
• 
• 
•
•
•



Chapter 7 Integrated Applications

28
Figure 157 Insert WorkSite Link dialog box

4. Navigate to the document you want to hyperlink to your document.

5. You can hyperlink any version of the document. Click the Latest button 
drop-down arrow to display the following options:

 Latest. Inserts a hyperlink that will always point to the most current 
version of the document to which you have access rights.

 This Version. Inserts a hyperlink that will always point to the selected 
version of the document.

When you select either version option, the Insert WorkSite Hyperlink dialog 
box appears.
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Figure 158 Insert WorkSite Hyperlink dialog box

6. If you selected the text you want to hyperlink in Step 2, the text appears in the 
Text to display field. You can modify the hyperlink text to be displayed.

7. Click OK. The hyperlink to the WorkSite document appears.

8. Roll over the hyperlink to display the linked document’s properties in a tooltip. 
Use CTRL+click to open the linked document in its native application.

Inserting a WorkSite Footer

In Microsoft Office integrated applications, you can insert a footer into a WorkSite 
document. From the Insert menu, select WorkSite Footer. A footer with the 
following information displays:

Document Name: Document Number–Version Number

If the Document Name field is empty, only the Document Number and Version 
Number are displayed.

In Office 2007 Integration or Office 2010 Integration, the Footer option is available 
from the Insert ribbon bar. See Figure 156 on page 285.

Performing a WorkSite Mail Merge

To perform a mail merge, you must have a main document and a data source 
document. The main document is a form that contains the text that will appear in 
the final document. The document includes merge fields to indicate where 
variable information from the data source document should be inserted.

NOTE Other footer information, such as Author, Page 
Number, file path information, and so on can be inserted 
using standard options available in Microsoft Word.
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The data source document holds a table that contains the specific information to 
complete the form in the main document. When the main document and the data 
source document are merged, they create a third document that inserts each row 
of the table in the data source document into the merge fields on the main 
document form. The third document contains as many forms as there are rows in 
the data source table. You can store all three documents in WorkSite.

When you are performing a mail merge in Word using FileSite, certain scenarios 
can occur as indicated in Table 35. 

Performing a Mail Merge Using WorkSite Documents

1. Launch Microsoft Word, and select WorkSite Mail Merge from the Tools 
menu.

In Office 2007 Integration or Office 2010 Integration, the Mail Merge option is 
available from the WorkSite tab of the ribbon bar.

Table 35  Mail Merge Scenarios

If... Then...

Your main document is in WorkSite, but 
your Data Source document is not.

Create the Data Source document, if 
necessary. Import it into WorkSite. Then 
follow the procedure given in “Performing a 
Mail Merge Using WorkSite Documents”

Your data Source document is in 
WorkSite, but your Main document is not.

Follow the procedure given in “Performing a 
Mail Merge Using Newly Created 
Documents”

Your main document and Data Source 
document are both in WorkSite.

Follow the procedure given in “Performing a 
Mail Merge Using WorkSite Documents”

NOTE You may need to switch to the Microsoft Word Mail 
Merge Wizard to complete the Mail Merge process. The 
following procedures indicate when this is necessary.

NOTE You may want to display the Microsoft Word Mail 
Merge toolbar and use the buttons when performing a 
WorkSite Mail Merge.
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Figure 159 Example WorkSite ribbon bar, Mail Merge option

The WorkSite Mail Merge dialog box appears.

Figure 160 WorkSite Mail Merge dialog box

2. Click the Main document button drop-down arrow, and choose the kind of 
main document you want to use.

 Form letters

 Mailing labels

 Envelopes

 Catalog

 Select Restore to Normal Word Document to restore the document 
selected as the main document to a non-mail merge document.

The following dialog box opens.
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Figure 161 WorkSite Mail Merge dialog box, Main document selection

3. If your Main document is in WorkSite, click Select from WorkSite. The 
WorkSite Integrated Open dialog box opens.

4. Browse and open the document from the WorkSite Integrated Open dialog 
box. The WorkSite Mail Merge dialog box opens with the selected document 
name appearing against the Main document button, as shown in Figure 162.

Figure 162 WorkSite Mail Merge dialog box, Main document selected

5. Click Data document on the WorkSite Mail Merge dialog box. The Select 
Data Source dialog box opens.
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Figure 163 Select Data Source dialog box

6. Select a Data Source using one of the following methods:

 Select one of the available documents already open in Word and click 
Open.

 Click Select Data Source from WorkSite. The WorkSite Integrated Select 
Data Source dialog box appears.

Browse and open the document from the WorkSite Integrated Select Data 
Source dialog box. The WorkSite Mail Merge dialog box appears with the 
selected document name appearing against the Data document button, as 
shown in Figure 164.
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Figure 164 WorkSite Mail Merge dialog box, Data document selected

7. (Optional) If you are using a Header document that is stored in WorkSite, click 
Header document on the WorkSite Mail Merge dialog box and open it.

8. Click Run Merge on the WorkSite Mail Merge dialog box to open the Merge 
dialog box.

Figure 165 Merge dialog box
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9. In the Microsoft Office Merge dialog box, change Query Options if necessary, 
and make other selections. When you have finished, click Merge to perform 
the mail merge operation.

Performing a Mail Merge Using Newly Created Documents

1. Launch the Microsoft Word integrated application.

2. Open the document you want to use as the Main Document from your local or 
network drive.

3. Select WorkSite Mail Merge from the Tools menu. The WorkSite Mail Merge 
dialog box opens.

Figure 166 WorkSite Mail Merge dialog box

4. Click the Main document button drop-down arrow and choose the type that 
corresponds to your main document.

 Form letters

 Mailing labels

 Envelopes

 Catalog

NOTE You may want to display the Microsoft Word Mail 
Merge toolbar and use the buttons when performing a 
WorkSite Mail Merge.
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 Click Restore to normal Microsoft Word document to restore the 
document selected as the main document to a non-mail merge document.

The following dialog box opens.

Figure 167 WorkSite Mail Merge dialog box, Main document selection

5. Click Active Window to return to the WorkSite Mail Merge dialog box. The 
active document name appears against the Main document button, as shown 
in Figure 168.

Figure 168 WorkSite Mail Merge dialog box, Active document selected

6. To change the main document to a different document type, for example from 
labels to envelopes, click the Main document button drop-down arrow and 
choose the kind of main document you want to use. The dialog box shown in 
Figure 169 appears.
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Figure 169 WorkSite Mail Merge dialog box, Change Document Type

7. Click Change Document Type to confirm the change to a different document 
type and return to the WorkSite Mail Merge dialog box.

8. Click Data document on the WorkSite Mail Merge dialog box. The Select 
Data Source dialog box opens.

Figure 170 Select Data Source dialog box

The remaining procedure varies according to the type of Data Source 
document.

 If your data source is a Microsoft Word or Excel document, proceed to 
Step 9.

 If your data source is a Microsoft Outlook Contacts list, proceed to Step 10.
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 If your data source is an Access library, proceed to Step 9.

9. Click Select Data Source from WorkSite, and open the Data Source 
document from the WorkSite Integrated Select Data Source dialog box.

 If you need to create merge fields in your Main document, a message 
appears indicating that you need to edit the Main document. Click Edit 
Main Document. Add the merge fields to your Main document, then 
proceed with the mail merge.

Figure 171 Edit Main Document message box

 If you do not need to create merge fields in your Main document, proceed 
to Step 10.

10. Click Close to close the WorkSite Mail Merge dialog box.

11. In Microsoft Word, from the Tools menu, point to Letters and Mailing and 
select Mail Merge. The Microsoft Word Mail Merge Wizard task pane appears. 
Follow Microsoft’s instructions to complete the merge.

Comparing and Merging WorkSite Documents

Use the Compare and Merge WorkSite Documents option on the Tools menu 
of the integrated application to compare the currently open document against a 
document in a WorkSite library.

1. Launch Microsoft Word.

2. From the Tools menu, select Compare and Merge WorkSite Documents.
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Figure 172 Tools menu

In Office 2007 Integration or Office 2010 Integration, the Compare and Merge 
WorkSite Documents option is available from the Review tab of the ribbon 
bar.

Figure 173 Example Review ribbon bar, Compare and Merge WorkSite Documents option

The WorkSite Integrated Compare and Merge WorkSite Documents dialog 
box opens.

NOTE If this menu option does not appear, it has not 
been enabled by your WorkSite Administrator. Contact 
your WorkSite Administrator for more information.
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Figure 174 Compare and Merge WorkSite Documents dialog box

3. Navigate to the document you want to compare with the open document. You 
can also use the Express Search panel to find a location. See “Express 
Search Panel” on page 266 for more information on using this panel.

4. Click the Merge button drop-down arrow to display a list of options:

 Merge

 Merge into current document

 Merge into new document

5. Make your selection to perform the compare and merge operation.

In Office 2007 Integration or Office 2010 Integration, the compare and merge 
operation returns multiple windows comparing the original document and the 
merged document.
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Figure 175 Example Compare and Merge Documents result

Additional Microsoft Office Integration Functions

In an integrated application, the WorkSite menu option appears in the menu bar.

For Office 2007 Integration or Office 2010 Integration, the WorkSite tab appears 
in the ribbon bar.

You can perform the following tasks from the WorkSite menu or tab:

 Connecting to and registering WorkSite Servers. See “Register/Unregister 
WorkSite Servers” on page 300.

 Performing synchronization tasks. See “Synchronization Tasks” on page 300. 

 Viewing information about the Integration module. See “About the Integration 
Module” on page 300.
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 Changing the connection mode. See “Switch Connection Mode” on page 301. 

Register/Unregister WorkSite Servers

Your first step in using the Microsoft Office Integration Module is to register the 
WorkSite Servers you will use. The WorkSite Server contains your documents and 
libraries. To register and log into a WorkSite Server, you need a valid Login, 
Password and Server name. The Register/Unregister menu option is only 
available when you use FileSite in the online mode. It is not available in offline 
mode, and it does not appear on the WorkSite menu (or WorkSite tab for Office 
2007 or Office 2010) in local mode.

See “Connecting to WorkSite Servers” on page 53 for more information. 

Synchronization Tasks

Use the Offline Access menu to configure your synchronization options. It opens 
a submenu with the following options:

 Express Synchronize

 Full Synchronize

 View Offline Details

 Offsite Synchronization Settings

About the Integration Module

The About WorkSite Integration menu option displays information about the 
Integration module. Select the About WorkSite Integration menu option to 
display the About WorkSite Integration dialog box.

In Office 2007 Integration or Office 2010 Integration, the About WorkSite option 
is on the WorkSite tab of the ribbon bar.

NOTE Options related to OffSite do not appear unless 
OffSite is installed with your WorkSite client application. 
Refer to the OffSite Installation and User’s Guide for 
more information.
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Figure 176 Example WorkSite ribbon bar, About WorkSite option

The About WorkSite Integration dialog box displays information about the 
application and the current session and user.

Switch Connection Mode

The Switch Connection Mode menu option enables you to change the 
connection mode you are presently in.

Select the Switch Connection Mode menu option to display the Select 
Connection Mode dialog box. This dialog box is similar to Figure 128, but includes 
a Cancel button, which is used to close the dialog box without changing the 
connection mode.

Figure 177 Select Connection Mode dialog box

Adobe Acrobat Integration

The Adobe Acrobat Integration Module provides users of Adobe Acrobat and 
Acrobat Reader with an integrated interface to the WorkSite document 
management system. When a user opens Acrobat or Acrobat Reader, an 
integrated user interface presents menu options that enable the user to perform 
operations on PDF documents within the WorkSite system.
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Requirements

The following software components are required for a successful installation of the 
Adobe Acrobat Integration Module:

 Adobe Acrobat or Adobe Acrobat Reader 6.04 (Standard and Professional), 
7.08, or 8.0.

 FileSite 8.2 SP1 or later

NOTE The Adobe Acrobat Integration Module is installed during the installation of FileSite. 
Contact your WorkSite Administrator for more information on installing the Integration 
Module.

Getting Started

The behavior of the Adobe Acrobat and Acrobat Reader integrated application at 
startup depends on how your system has been configured and whether other 
WorkSite components are running. The Adobe Integration module can start in one 
of the following ways:

 Prompts you to select a connection mode.

For more information about selecting a connection mode when using an 
integrated application, see “Choice of Connection Mode” on page 248.

 Automatically starts in online mode.

For more information, see “Automatic Online Mode” on page 249. 

Integration with WorkSite

When the Adobe Acrobat and Acrobat Reader application is integrated with 
WorkSite, its File menu changes to support WorkSite functionality. Certain new 
commands such as Open from WorkSite and Save to WorkSite are added to 
the menu. Figure 178 illustrates the Adobe Acrobat or Acrobat Reader File menu 
when integrated with FileSite.

NOTE When you are working in online mode, you can 
still access documents from your local or network drives 
using the Open, Save, and Save As options on the 
Acrobat or Acrobat Reader File menu.
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Figure 178 Integrated Adobe Acrobat or Acrobat Reader File menu

Open from WorkSite

The Open from WorkSite command launches the WorkSite Integrated Open 
dialog box, instead of the default Adobe Acrobat or Acrobat Reader Open dialog 
box. 

NOTE For a detailed description of the WorkSite Integrated 
Desktop, see “Enhanced Application Integration” on 
page 262 and “Classic Application Integration” on page 277.
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Save to WorkSite

The Save to WorkSite command behaves differently in the Classic and 
Enhanced modes of integration. In the Enhanced mode of integration, the Save to 
WorkSite command opens the WorkSite Integrated Save As dialog box. In the 
Classic mode of integration, this command opens the Save As Options dialog box.

See “Enhanced Application Integration” on page 262 and “Classic Application 
Integration” on page 277 for more information on the functionality of the WorkSite 
Integrated Desktop.

Save and Save As

The Save and Save As commands open a standard Windows Save As dialog 
box. Use this dialog box to save the file to your local or network drive. This is a 
convenient way to save a WorkSite document locally. It is equivalent to using the 
Export function in FileSite.

Modes of Integration

Integration with the Adobe Acrobat and Acrobat Reader applications is available 
in two modes:

 Enhanced Application Integration

 Classic Application Integration

These modes affect the behavior of the Open from WorkSite and Save to 
WorkSite commands in the integrated application’s File menu.

Your WorkSite Administrator can set the integration mode to either Classic 
Application Integration or Enhanced Application Integration.

See “Enhanced Application Integration” on page 262 and “Classic Application 
Integration” on page 277 for more information.

Working with Documents in the Integrated Application

The document functions you can perform in the Adobe Integration module are 
similar to those you can perform in the Microsoft Office Integration module, though 
Adobe uses the Open from WorkSite and Save to WorkSite menu commands.

See “Working with Documents in the Enhanced Integrated Desktop” on page 271 
and “Working with Documents in the Classic Integrated Desktop” on page 280 for 
information on the other document functions.
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Opening Documents

1. From the File menu of the integrated Adobe Acrobat or Acrobat Reader 
application, select Open from WorkSite. The WorkSite Integrated Open 
dialog box opens.

Figure 179 WorkSite Integrated Open dialog box

2. Navigate to the document you want to open. You can also use the Express 
Search panel to find the document. See “Express Search Panel” on page 266 
for more information on using this panel.

Only Acrobat documents will display; however, you have the option of 
selecting a different document type using the Type lookup button in the Filter 
Conditions area.

3. Select a document in the Document Grid.

4. Click Open to open the document in the integrated Adobe Acrobat or Acrobat 
Reader viewer.

Saving Documents

1. From the File menu of the integrated Adobe Acrobat or Acrobat Reader 
application, select Save to WorkSite. The WorkSite Integrated Save As 
dialog box opens.
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Figure 180 WorkSite Integrated Save As dialog box

2. Navigate to the Workspace or folder where you want to save the document. 
You can also use the Express Search panel to find a location. See “Express 
Search Panel” on page 266 for more information on using this panel.

 To display the names of documents already in the current location, click 
Show Documents in this folder.

 Enter the Author, Class, and Subclass (if any) fields.

 Click Save.

3. If the folder’s metadata does not include all required fields, the New Profile 
dialog box opens for you to enter profile information. You can also open the 
New Profile dialog box by clicking Detail.

4. Click Save to save the document to the WorkSite library.

NOTE When the document is added to the folder, the 
document automatically takes on the folder’s profile 
properties or metadata. If the folder’s metadata includes 
all required fields, FileSite automatically creates the 
profile without further input from you.
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Additional Adobe Acrobat Integration Functions

In an integrated application, the WorkSite menu option appears in the menu bar. 
You can perform the following tasks from the WorkSite menu:

 Connect to and register WorkSite Servers. See “Register/Unregister WorkSite 
Servers” on page 300.

 View and edit document profile information. See “Properties” on page 307.

 Send WorkSite document links. See “Sending WorkSite Links” on page 307.

 Change the connection mode. See “Switch Connection Mode” on page 301.

 Perform synchronization tasks. See “Synchronization Tasks” on page 300.

 View information about the Integration module. See “About the Integration 
Module” on page 308.

Properties

When you select Properties from the WorkSite menu, the Properties dialog box 
for viewing or editing document profile information appears. 

Users who have Read access to a document cannot change the information 
displayed in this dialog box. Users with Read/Write access can change certain 
fields, such as the Comments field. Only the Author and Operator of a document 
have the full authority to change the access privileges on the document. Edit the 
profile information according to the procedure described in “Editing Document 
Profile Information” on page 146.

Sending WorkSite Links

When you select Send WorkSite Link from the WorkSite menu, a new e-mail 
message appears with the WorkSite link (as an .nrl file) to the currently active 
document included as an attachment. The link can then be sent to any user who 
has access to the document.

NOTE The Properties dialog box can be customized by 
your WorkSite Administrator. The dialog boxes that appear 
in your version of FileSite may differ from the default.
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About the Integration Module

The About WorkSite Acrobat Integration menu option displays information 
about the Integration module. Select the About WorkSite Acrobat Integration 
menu option to display the About WorkSite Acrobat Integration dialog box. This 
dialog box displays information about the application and the current session and 
user.

Integration with Other Applications

FileSite can be integrated with the following document utilities:

 DocuComp

 CompareRite

 FullAuthority

 CiteRite

These document utilities can be directly accessed from the FileSite desktop and 
not through an integrated application (such as Microsoft Word) or the WorkSite 
Integrated Desktop.

In FileSite, from the Document menu point to Applications, and select the 
appropriate application from the list. 

Integration with DocuComp

DocuComp is an application that enables you to compare versions of documents 
and to produce comparison reports automatically. For the DocuComp menu 
option to work properly, this application must be integrated correctly with FileSite. 
Contact your WorkSite Administrator for assistance. 

Comparing Documents using DocuComp

1. In FileSite, select the document whose versions you want to compare from the 
Document Grid.

NOTE You must have a path established to the directories 
for each of these utilities. Each WorkSite library 
automatically provides entries in the application table for 
each of these document utilities. Contact your WorkSite 
Administrator for more information.
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2. From the Document menu, point to Document Info and select Versions. A 
list of the document’s version is displayed in the Document Versions window.

3. From this list, select the two versions of the document you want to compare. 

4. From the Document menu, point to Applications and select DocuComp 
from the submenu. The Compare Documents using DocuComp dialog box 
opens.

Figure 181 Compare Documents using DocuComp dialog box

The version of the document shown first in the Document Results Frame is 
listed as the Original Document. You can sort the Document Results Frame by 
version number by clicking the Version column heading.

5. Select the way you want to handle the resulting comparison document.

 Open. To open the comparison document.

 View. To view the comparison document with the WorkSite Viewer 
program.

 Import. To import the comparison document into a WorkSite library.

NOTE To compare versions of the same document you 
must show all versions of the document. See 
“Document View” on page 67 for information on setting 
this option.
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6. FileSite automatically enters a filename in the Compare Doc Name field. The 
comparison results are saved to the file specified in this field.

7. Click Compare to perform the comparison.

Integration with CompareRite

CompareRite is another application that lets you compare versions of documents 
and generate comparison reports. For the CompareRite menu option to work 
properly, this application must be integrated correctly with FileSite. Contact your 
WorkSite Administrator for assistance.

The procedure for comparing documents using CompareRite is similar to 
DocuComp. See “Comparing Documents using DocuComp” on page 308.

Integration with FullAuthority

FullAuthority is a software application provided by Lexis-Nexis that enables you to 
analyze the citations in a document. For the FullAuthority menu option to work 
properly, it must be integrated correctly with FileSite. Contact your WorkSite 
Administrator for assistance.

Analyzing Citations Using FullAuthority

1. In FileSite, select a document in the Document Grid.

2. From the Document menu, point to Applications, and select FullAuthority 
from the submenu. The FullAuthority dialog box opens, with the selected 
document listed in the dialog box.
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Figure 182 FullAuthority dialog box

3. Select how you want to handle the report.

 Open. To open the output document.

 View. To view the output document with the WorkSite Viewer program.

 Import. To import the output document into a WorkSite library.

4. FileSite automatically enters a filename in the Output Doc Name field. The 
table of authorities or citation report is saved to the file specified in this field.

5. Click Run to perform the analysis on the selected document.

Integration with CiteRite

CiteRite is another software application provided by Lexis-Nexis that enables you 
to analyze the citations in a document. For the CiteRite menu option to work 
properly, it must be integrated correctly with FileSite. Contact your WorkSite 
Administrator for assistance.

The procedure for analyzing citations in a document using CiteRite is similar to 
FullAuthority. See “Analyzing Citations Using FullAuthority” on page 310.
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E-mail Integration

FileSite is integrated with electronic mail products through the MAPI interface. 
Standard e-mail systems supported include:

 Network GroupWise

 Microsoft Mail

 Microsoft Outlook

 Lotus cc:Mail

 Lotus Notes

 DaVinci

You can choose to send either a link to a WorkSite document or a copy of a 
WorkSite document as an attachment to an e-mail message. See “E-mailing 
Documents” on page 170 for more information.

When you have selected the document, FileSite automatically invokes the e-mail 
Send command and uses the MAPI standard to display the Mail To windows 
appropriate to the e-mail system. When sent via e-mail, document profiles have 
the extension .txt, while document filenames have the application’s extension 
(for example, .doc for Word files, .wri for Write files, and so on).

Non-Integrated Applications

In some cases, an application cannot be integrated with FileSite, and FileSite’s 
functions are not available from within the application. You can still organize, 
track, and store your documents using FileSite. To open a document:

1. Launch FileSite and log into a WorkSite Server.

2. Search for and find the document you want to open.

3. Check out the document from the WorkSite library to your local drive.

4. Launch the non-integrated application.

5. Open the document on your local drive from within the application.

6. When you are finished editing or revising the document, switch focus to 
FileSite.

7. Use the Checkin option to copy the revised document back to the WorkSite 
library.
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CHAPTER 8  
Linking WorkSite Documents

Overview

This chapter contains the following information about linking WorkSite documents:

 “Introduction”

 “Configuring WorkSite for Linking”

 “Working with Destination Documents”

Introduction

You can use the linking features of Microsoft Office to create documents 
containing linked objects and import them into a WorkSite library. Documents 
containing linked objects are supported in the following applications:

 Word 2003

 Excel 2003
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 PowerPoint 2003

Documents can be linked in the following ways:

 Entire documents. Use the WorkSite Object option on the Insert menu of 
the integrated Office application to link entire documents into other 
documents. 

 Object links. Use the Copy and Paste Special technique to links parts of 
documents into other documents. See “Using the Paste Special Option” on 
page 319. 

 Cell links. Links groups of Excel cells to other Excel worksheets. 

The types of links that WorkSite does not support (at this time) are:

 Recursive links. An object from Document A is linked to Document B along 
with an object from Document B linked to Document A, or an object from 
Document A to another place in Document A. 

 Multi-level links. An object from Document C is linked to Document B which, 
in turn, is linked to Document A. 

 Word or Excel objects linked into PowerPoint slides. 

Linking Definitions

The following terminology is used to define the object linking and embedding 
functionality in WorkSite: 

 Destination document. It is the document in which you insert the linked 
object. If you change information in a linked object in the destination 
document, it does not change the source document. 

 Source document. It is the document used to create the linked object. If you 
change information in the source document, the information in the destination 
document can change, depending on whether or not you choose to always 
use the current version.

 Cached information. It is the information in the destination document that is 
contained in the link.

NOTE Microsoft Office 2007 and Office 2010 use an 
updated document format, which affects linking. The 
current version of FileSite does not support Office 2007 
or Office 2010 documents containing linked objects. 
However, Office 2007 Integration and Office 2010 
Integration support OLE linking in documents created in 
Office 2003.
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Example of OLE Linking in WorkSite

If you are producing a report that consists of a Word document with information 
from several Excel spreadsheets and some slides from a PowerPoint 
presentation, you can link the information from all the source documents to a 
single destination document and store all the documents in a WorkSite library. 

You can choose whether to update the information in the destination document 
whenever the source documents are updated. If you create a document on a local 
drive, add links to it, and import it to a library, WorkSite prompts you to import the 
linked documents as well. You can create a single document profile and apply it to 
all linked documents that are imported simultaneously.

Configuring WorkSite for Linking

For the WorkSite linking feature to work properly, you need to specify a 
configuration option in FileSite. 

1. From the WorkSite menu, point to Configure, and select General Options. 
The Options dialog box opens. 

2. Select the Advanced tab.

3. Click Options or type ALT+O. The Advanced Configure dialog box opens. 
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Figure 183 Advanced Configure dialog box

4. Within the Document Options listed, select the Check document for OLE 
links option. 

This option enables WorkSite to prompt you to import the linked documents as 
well, when you import a document with links from your local or network drive 
into a WorkSite library. 

5. Click OK to save your changes and close the dialog box. Click OK again to 
close the Configure dialog box. 

Working with Destination Documents

You can perform the following operations with documents:

 “Creating Documents Containing Linked Objects”

 “Importing Documents Containing Linked Objects”

 “Opening Documents Containing Linked Objects”

 “Editing Links in Documents Containing Linked Objects”

 “Replacing Links in Documents Containing Linked Objects”
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 “Exporting Documents Containing Linked Objects”

 “Checking Out Documents Containing Linked Objects”

 “Checking In Documents Containing Linked Objects”

Creating Documents Containing Linked Objects

You can create OLE links using the following Microsoft Office functionalities, which 
you can access from the integrated application:

 “Using the Insert Option”

 “Using the Paste Special Option”

Using the Insert Option

1. Open the document in which you want to insert the link. This is the destination 
document. 

2. Place the cursor where you want to insert the link.

3. From the Insert menu, point to WorkSite Object and select WorkSite Link. 
The WorkSite Integrated Insert dialog box opens.
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Figure 184 WorkSite Integrated Insert dialog box

4. Navigate to the document you want to link to your document. This is the 
source document. You can also use the Express Search panel to find the 
document. See “Express Search Panel” on page 266 for more information on 
using this panel. 

5. You can link any version of the source document to the destination document. 
Click the Latest button drop-down arrow to display the following options: 

 Latest. Inserts the link that will always point to the most current version of 
the source document to which you have access rights. 

 This Version. Inserts the link that will always point to the selected version 
of the source document. 

When you select either version option, WorkSite inserts a link to the source 
document into your destination document. 

NOTE You can also insert an icon that represents the 
source document, if you do not want to insert the entire 
document. To do this, select WorkSite Link as Icon 
from the Insert | WorkSite Object menu in Step 3. The 
remaining procedure is the same.
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Using the Paste Special Option

1. Open the document in which you want to insert the link. This is the destination 
document. 

2. Open the source document you want to link to the destination document.

3. Select and copy to the clipboard the portion of the source document that you 
want to link to the destination document.

4. In the destination document, place the cursor where you want to paste the 
link.

5. From the Edit menu, select Paste Special. A Microsoft Paste Special dialog 
box opens. 

The Paste Special dialog box varies according to the application of the source 
and destination documents. 

NOTE If the source document is a PowerPoint 
presentation, you must switch to the Slide Sorter View 
to select a slide.
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a. If the destination document is a Word document, see Table 36. 

b. If the destination document is an Excel document, see Table 37. 

23. Repeat Step 2 to Step 5 until you have linked all required objects from the 
source documents into your destination document.

24. When you save your document, the Version Selection dialog box opens. 

Table 36  Destination Document: Microsoft Word Document

The Source Document 
is: 

In the Paste Special dialog box, do the 
following: 

Another Word document 6. Select Microsoft Office Word Document Object. 

7. Choose the Paste link option.

8. Click OK.

An Excel workbook 9. Select Microsoft Office Excel Worksheet Object.

10.Choose the Paste link option.

11.Click OK. 

A PowerPoint presentation 12.Select Microsoft Office PowerPoint Slide Object.

13.Choose the Paste link option.

14.Click OK.

Table 37  Destination Document: Microsoft Excel Document

The Source document 
is: In the Paste Special dialog box, do the following: 

Another Excel workbook 15.Select Microsoft Office Excel Object. 

16.Click OK.

A Word document 17.Select Microsoft Office Word Document Object.

18.Choose the Paste link option.

19.Click OK.

A PowerPoint presentation 20.Select Microsoft Office PowerPoint Slide Object.

21.Choose the Paste link option.

22.Click OK.
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Figure 185 Version Selection dialog box

Select a version option:

 Select Latest Version to always point to the most current version of the 
document that you have access to.

 Select This Version to always point to the version you have just used to 
create the link.

25. When your edits are complete, close the source documents. 

26. Close the destination document to check it in to FileSite. 

Importing Documents Containing Linked Objects

When importing documents into WorkSite, there are two scenarios than can 
occur. Table 38 indicates what to do in each scenario. 

Importing Destination and Source Documents into WorkSite

If you already have existing destination and linked source documents saved on 
your local or network drive, you can import them into WorkSite.

1. In FileSite, navigate to the folder in the WorkSite library where you want to 
save the document.

2. Select Add Document from the WorkSite menu. The Find File to Import to 
Folder dialog box opens. 

Table 38  Importing Linked Documents

If Then

Neither the destination nor source 
documents are in WorkSite. 

Follow the procedure given in “Importing 
Destination and Source Documents into 
WorkSite”

The destination document is in WorkSite, 
but the source document is not. 

Follow the procedure given in “Importing 
Source Documents into WorkSite”
FileSite Installation and User’s Guide  321

• 
• 
• 
•
•
•



Chapter 8 Linking WorkSite Documents

32
3. Navigate to the file you want to import, and click Open. The Import Source 
Documents dialog box opens if you have selected a document containing 
linked objects. 

Figure 186 Import Source Documents dialog box

4. The local source documents that are linked to the local destination document 
appear in the list. Select the check box for each linked source document you 
want to import. If you do not wish to import the source document, clear the 
check box.

5. (Optional) Select the Use common profile option to record the same profile 
information for each document you are importing. If you do not select this 
option, FileSite opens a profile dialog for each imported source document.

6. (Optional) Select the Always link to the latest version of the source 
document option. Leave this option unselected if you only want to link to the 
current version of the source document.

7. Click Import to import the documents into WorkSite.

NOTE This option applies to all source documents you 
import. You can change this setting later on, if you wish. 
See “Creating Documents Containing Linked Objects” 
on page 317.
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Importing Source Documents into WorkSite

If you have a destination document already saved in WorkSite, you can import 
linked source documents into WorkSite directly from the destination document. 

1. Open the destination document. 

2. Open the source document stored on your local or network drive.

3. Select and copy to the clipboard the portion of the source document that you 
want to link to the destination document.

4. In the destination document, place the cursor where you want to paste the 
link.

5. From the Edit menu, select Paste Special. 

When you have completed pasting the links, you can import the linked source 
documents into WorkSite. 

6. In the destination document, select Import WorkSite Links from the Edit 
menu. The Import Links dialog box opens.

NOTE See Step 5 of “Using the Paste Special Option” 
on page 319 for information on how to use the Paste 
Special option in various applications.
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Figure 187 Import Links dialog box

7. The local source documents that are linked to the destination document 
appear in the list. To import the linked source document, select the check box 
next to it. 

8. (Optional) Select the Use common profile option to record the same profile 
information for each document you are importing. If you do not select this 
option, FileSite opens a profile dialog for each imported source document.

9. (Optional) Select the Always link to the latest version of the source 
document option. Leave this option unselected if you only want to link to the 
current version of the source document.

10. Click Import to import the source documents into WorkSite.

NOTE This option applies to all source documents you 
import. You can change this setting later on, if you wish.
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Opening Documents Containing Linked Objects

When you open a document containing linked objects, you can choose to 
download and view the linked source documents for your reference. The 
destination document contains cached information from the source document. 
The source document could have been updated since the information was linked 
to the destination document.

 If you want to see the latest information, you should download the source 
documents. 

 If you can use the cached data in the destination document, you do not need 
to download the source documents.

To open a destination document and its linked source document:

1. Open the destination document in FileSite. If it contains links to source 
documents in WorkSite, the Open dialog box opens.

Figure 188 Open dialog box

NOTE Read-only copies of the source documents are 
downloaded. You must have at least Read access to the 
documents to download them.
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2. Select the linked source documents from the list. WorkSite downloads a 
read-only copy of the document. To download all linked source documents, 
click Select All.

3. Click Download when you have completed your selections. WorkSite opens 
the destination document. 

4. You are prompted to update the linked data. If you want to update, click Yes. 
To keep the existing information, click No.

Editing Links in Documents Containing Linked Objects

You can edit source documents that are linked to a destination document. 
However, you should have at least Read/Write access to the source document.

1. Open the destination document. To edit the links, it is not necessary to open 
the source documents. 

2. In the destination document, from the Edit menu select WorkSite Links. The 
WorkSite Links dialog box opens. 

Figure 189 WorkSite Links dialog box

3. Select the source document you want to edit from the list, and click Check 
Out. WorkSite places a copy of the source document into the NrPortbl 
directory on your local or network drive. The icon in front of the document 
changes (see Figure 190) to reflect its checked-out status. 
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Figure 190 WorkSite Links dialog box, checked-out document

4. After the document is checked out, click Open Source to open and edit the 
source document.

5. When you have edited the documents, first close the source documents and 
then the destination document. When you close the destination document, it is 
checked in to WorkSite. You are also prompted to check in any source 
documents that you checked out. See “Checking In Documents Containing 
Linked Objects” on page 332.

Replacing Links in Documents Containing Linked Objects

In the destination document, you may want to replace a link to an existing source 
document with a different one.

1. Open the destination document. 

2. From the Edit menu, select Replace WorkSite Links. The Replace WorkSite 
Links dialog box opens. 
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Figure 191 Replace WorkSite Links dialog box

3. Select the source document you want to replace from the list.

4. Click Replace Link or type ALT+R. The WorkSite Integrated Replace Link 
dialog box opens.

Figure 192 WorkSite Integrated Replace Link dialog box

5. Navigate to the WorkSite document you want to link to the destination 
document. You can also use the Express Search panel to find the document. 
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See “Express Search Panel” on page 266 for more information on using this 
panel. You can link any version of the source document. 

6. Click the Latest button drop-down arrow to display the following options: 

 Latest. Inserts the link that will always point to the most current version of 
the source document to which you have access. 

 This Version. Inserts the link that will always point to the selected version 
of the source document. 

7. When you choose either of the version options, WorkSite selects this 
document and it appears in the Replace WorkSite Links dialog box. 

8. Click OK to complete the process. 

Exporting Documents Containing Linked Objects

You can export a destination document and its linked source documents to a 
folder on your local or network drive.

1. In FileSite, select the document containing linked objects that you want to 
export.

2. From the Document menu, choose Save As. The Export dialog box opens.

Figure 193 Export dialog box

3. Click Browse to select a destination path in the Destination Path field. 

4. Select the Echo option if you wish to export the documents to the NRTEcho 
directory. 

5. Click OK. The Export with Links dialog box opens.
FileSite Installation and User’s Guide  329

• 
• 
• 
•
•
•



Chapter 8 Linking WorkSite Documents

33
Figure 194 Export with Links dialog box 

6. Select the linked source documents you want to download along with the 
destination document. To download a specific source document, select the 
check box next to it. Click Select All to download all the source documents. 

7. Click Download when you have completed your selections. WorkSite places 
copies of the selected documents into the directory chosen in Step 3. You can 
also click Skip download if you want to export only the destination document 
without copies of any of the linked source documents.

Checking Out Documents Containing Linked Objects

When you check out a document containing linked objects, you have the option of 
checking out and editing its source documents as well. 

To check out a document containing linked objects:

1. In FileSite, select the document that you want to check out.

NOTE If the document is already checked out by another 
user, the  Checked out icon appears against it in the 
Document Icon column of the Document Grid in FileSite.
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2. From the Document menu, choose Check Out. The Checkout dialog box 
opens.

Figure 195 Checkout dialog box

3. Click Browse to select a destination path in the Destination Path field.

4. (Optional) Select the Integrated Check Out option, if you are checking out the 
document for offline use. 

5. Enter a Due Date for the check in of the document. 

6. Enter the reason for checking out the document in the Comments field.

7. Click OK to check out the document. If WorkSite detects files that are linked to 
the selected document, the OLE (Object Linking and Embedding) Checkout 
dialog box opens. 
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Figure 196 OLE (Object Linking and Embedding) Checkout dialog box

8. Select the linked source documents you want to check out along with the 
destination document. To check out a specific source document, select the 
check box next to it. Click Select All to check out all the source documents. 

9. Click Download when you have completed your selections. WorkSite places 
copies of the selected documents into the directory chosen in Step 3. You can 
also click Skip download if you want to check out only the destination 
document without copies of any of the linked source documents. 

Checking In Documents Containing Linked Objects

When you check in a document containing linked objects, you can simultaneously 
check in any or all of its source documents. You will also be prompted to import 
links added while the destination document was checked out, as well as source 
documents that were not imported with the destination document. 

NOTE The instructions given in this section apply to 
documents checked out to your local or network drive. See 
“Checking Out Documents Containing Linked Objects” on 
page 330 for instructions on how to check out a document 
and its linked source documents.
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Working with Destination Documents
To check in a destination document and its source documents:

1. When you have edited the destination document, close all its source 
documents. 

2. In the destination document, select Save or Save As from the File menu. (In a 
passively integrated Office application, select WorkSite Save As from the File 
menu.) 

3. Enter the profile information if necessary. The OLE (Object Linking and 
Embedding) Checkin dialog box opens. 

Figure 197 OLE (Object Linking and Embedding) Checkin dialog box

4. Select the linked source documents you want to check in along with the 
destination document. To check in a specific source document, select the 
check box next to it. Click Select All to check in all the source documents. 

5. Click Checkin when you have completed your selections. WorkSite copies the 
selected documents back into the WorkSite library. You can also click Skip 
Checkin if you want to check in only the destination document without copies 
of the linked source documents. 
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CHAPTER 9  
WorkSite Viewer

Overview

This chapter contains the following information about the WorkSite Viewer 
application: 

 “Introduction”

 “WorkSite Viewer Window”

 “Viewing Documents”

 “Searching Text of Documents”

 “Copying Documents”

 “Printing Documents”

 “Setting Document Display Options”

Introduction

The WorkSite Viewer application lets you view documents without launching the 
native application. It allows you to:

 View documents in read-only format, even when they are checked-out or “In 
use”.
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 Search the full text of documents currently displayed in the viewer.

 Copy portions of documents for pasting into other applications.

 Print documents.

Supported Document Types

File types supported by WorkSite Viewer include all major word-processing, 
spreadsheet, and graphics file formats. 

Your WorkSite Administrator can configure your system to support file types that 
are not automatically recognized by the WorkSite Server and associate them with 
the appropriate applications.

A few examples of file types supported by WorkSite Viewer are listed in the 
following sections.

Word Processing Formats

 Microsoft Office Suite 2003, 2007, and 2010

 Corel WordPerfect Suite 11.0, 12.0, X3

Spreadsheet Formats

 Excel 2003, 2007, and 2010

 QuattroPro for Windows

Graphic Formats

 Windows Bitmap

 Windows Metafile

 Tagged Image File Format TIFF

 Micrografx DRW

Miscellaneous Formats

 Adobe Reader PDF (text only)

 Adobe Acrobat
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WorkSite Viewer Window
WorkSite Viewer Window

WorkSite Viewer displays read-only copies of documents. You can display 
documents in cascade or tile format by selecting Cascade or Tile from the 
Window menu. 

Figure 198 is an example of the WorkSite Viewer window displaying two 
documents in tile format.

Figure 198 WorkSite Viewer window, Tile format

Figure 199 is an example of the same WorkSite Viewer window displaying three 
documents in cascade format. 
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Figure 199 WorkSite Viewer window, Cascade format

Viewing Documents

You can use WorkSite Viewer to view:

 Local documents 

 WorkSite documents

Viewing Local Documents

You can view documents stored locally on your local or network drive. 

1. Click the Start menu, point to Programs, then to Autonomy, and select 
iManage Viewer to launch WorkSite Viewer. The WorkSite Viewer window 
opens containing no documents. 

2. From the File menu, select Local Open. The Select File to View dialog box 
opens.
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Viewing Documents
Figure 200 Select File to View dialog box

3. Use standard Windows techniques to browse and locate the local file, then 
click Open (ALT+O) to display the file in WorkSite Viewer. 

Figure 201 WorkSite Viewer window

Viewing WorkSite Documents

You can use WorkSite Viewer to view WorkSite documents in: 

 FileSite 
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 Integrated applications

To view documents from FileSite:

1. Select the documents you want to view in the Document Grid. 

2. Choose View from the Document menu. If WorkSite Viewer is not already 
running, FileSite launches it and displays the documents in read-only format. 

To view documents from the WorkSite Integrated Desktop: 

1. Select the documents from the Document Grid. 

2. Right-click and choose View from the menu, as shown in Figure 202. 
WorkSite Viewer launches with the documents displayed in the WorkSite 
Viewer window. 

Figure 202 WorkSite Integrated Open dialog box

NOTE When you view documents using WorkSite 
Viewer, the documents are not locked or checked out of 
the WorkSite library. Instead, WorkSite Viewer makes a 
temporary copy of the document, which is displayed in 
read-only format.
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Searching Text of Documents

You can search the full text of a document displayed in the WorkSite Viewer 
window.

1. Select Find from the Search menu. The Find dialog box opens. 

Figure 203 Find dialog box

2. Enter the text you want to search in the Search String field. Click the Search 
String drop-down arrow to select from a list of search strings you entered 
previously.

3. You can select from the following search options: 

 Match Case. Specifies that the search is case-sensitive. If you do not 
select this option, the search returns all instances of the search string, 
regardless of case.

 Find Backwards. Specifies the direction of the search. By default, the 
search proceeds from the cursor forward in the document.

 Origin. Specifies where the search begins. 

 From Cursor. The search begins at the current position of the cursor 
in the active document.

 Entire Scope. The search begins at the start of the document and 
proceeds forward, or begins at the end of the document and proceeds 
backwards, depending on whether the Find Backwards option is also 
selected. 

NOTE The Find dialog box operates only on the active 
document displayed in the WorkSite Viewer window. 
That document must be a word-processing document or 
a spreadsheet. Textual searches cannot be performed 
on other document types.
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4. Click OK or press ENTER to start searching.

5. To repeat the search, select Search Again from the Search menu or press 
F3. 

Copying Documents

You can copy the entire body of a document, or selected portions of it for pasting 
into another application from the WorkSite Viewer window. 

 Select the document you want to entirely copy. From the Edit menu, choose 
Select All or click the  Select All icon in the toolbar. 

 Select portions of the document to copy. From the Edit menu, select Copy, or 
click the  Copy icon in the toolbar. Alternatively, right-click the selected 
portion, and choose Copy.

Paste the content into another document or application. 

Printing Documents

You can print an entire document, or selected portions of a document from the 
WorkSite Viewer window. 

1. Select the document or the portion of the document you want to print. 

2. From the File menu, choose Print or click the  Print icon in the toolbar. A 
standard Windows Print dialog box opens. 

3. Specify your printing preferences and click OK to print the document. 

Setting Printer Options

You can also set printer options from within WorkSite Viewer. 

NOTE The Print option operates only on the active 
document displayed in the WorkSite Viewer window.
2 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Printing Documents
1. From the File menu, select Print Setup. Alternatively, right-click the 
document, point to Options and select Print. A standard Windows Print Setup 
dialog box appears. 

2. Enter your printer settings. 

Setting More Printer Options

The Print Page Setup dialog box enables you to set additional printer options that 
are applicable only to spreadsheet documents. 

1. When a spreadsheet document is displayed in the WorkSite Viewer window, 
select Print Setup from the File menu. The Print Page Setup dialog box 
appears. 

Figure 204 Print Page Setup dialog box

The following options are available in the Print Page Setup dialog box:

 Scaling. Select the desired scaling options for the print-out.

 GridLines. Select this check box to print horizontal and vertical gridlines.

 Row and Column Headings. Select this check box to include row and 
column headings in the print-out.

 Base on spreadsheet. Select this check box to print based on the design 
of your spreadsheet. 

NOTE For spreadsheet documents, the Page Setup 
dialog box appears. For more information, see “Setting 
More Printer Options” on page 343.
FileSite Installation and User’s Guide  343

• 
• 
• 
•
•
•



Chapter 9 WorkSite Viewer

34
2. Click More to display the standard Windows Print Setup dialog box to specify 
other printer settings. 

Setting Document Display Options

In WorkSite Viewer, you can specify display settings for different document types. 

Word Processing Documents

To display word processing documents in different view modes, select the window 
in which the document is displayed. From the Options menu, point to Document. 
Alternatively, right-click the window in which the document is displayed, and point 
to View. A submenu of available view modes appears. Select the desired mode 
from the following: 

 Normal. Displays the document using the specified fonts and formatting in the 
document. Text wraps to display all text in the window.

 Preview. Displays the document using the specified fonts and formatting. Text 
does not wrap in the window. This mode shows how the document would look 
when printed.

Setting Display Font

To enlarge or reduce the font size when viewing documents, right-click the window 
in which the document is displayed, and point to Font Size. Select Enlarge or 
Reduce from the submenu. 

Bitmap Files

You can adjust the size of the bitmap files that are displayed, rotate these images 
by increments of 90°, and/or zoom in and out of these images. 

Select the window in which the image is displayed. From the Options menu, point 
to Bitmap. Alternatively, right-click the window in which the image is displayed. A 
submenu of available display sizes, degrees of rotation, and zoom settings 
appears. Select the size, rotation, and/or the zoom setting desired. 

NOTE These options are available only when the view 
mode is set to Normal.
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Setting Document Display Options
Vector Graphics

You can adjust the size of vector graphics files that are displayed. Select the 
window in which the vector graphic is displayed. From the Options menu, point to 
Vector. Select a size from the submenu of available sizes.

Setting Default Display Options

You can select a file format to use to view files of unknown type. 

1. Right-click the WorkSite Viewer window. 

2. Point to Options and select Display. The Display Options dialog box appears. 

Figure 205 Display Options dialog box 

3. In the View unknown files as area, select from the available options to set 
the default display mode for documents of unknown file types. 

4. In the Spreadsheet area, select the Show Gridlines option to show gridlines 
in the display. 

5. Click OK.
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CHAPTER 10  
Working Offline
FileSite allows you to access the document management system even when you 
are not connected to a WorkSite Server. If you are traveling or working from 
home, you can work on your documents offline and then synchronize your files 
with the online WorkSite repository when you reconnect to the WorkSite Server. 

You can work offline using:

 OffSite. An add-on for FileSite, it is an advanced and fully portable version of 
WorkSite. It allows you to carry not only your documents but also your My 
Matters folder offline, so that you can work on them when disconnected from 
the network. Refer to the OffSite Installation and User’s Guide for more 
information about OffSite. 

 Portable. If you do not have OffSite, you can still work offline using the more 
limited functionality of Portable. It allows you to check out documents from a 
library to a directory on your local machine, so that you can work on them 
when disconnected from the network. See “Working in Portable Mode” on 
page 348 for more information. 

This chapter contains the following information about working offline with FileSite:

 “Portable Mode Versus OffSite”

 “Working in Portable Mode” on page 348
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Portable Mode Versus OffSite

Table 39 provides a comparison of the functionality available in OffSite and 
Portable. 

Working in Portable Mode

When working in Portable mode you can take the FileSite document management 
system on the road with you. The process works like this: 

1. Check out the FileSite documents you want to work on to your local machine. 

2. Once you are disconnected from the network, you can access these 
documents through FileSite or through the standard commands (Open, Save, 
and so on) of an integrated application.

Table 39  Comparison of OffSite and Portable

Function OffSite  Portable

Creating a new document ¸

Editing document profile information ¸ ¸

Editing document security

Viewing and Quick-viewing a document ¸ ¸

Importing a document ¸ ¸

Importing a new version of a document

Saving an edited document as a new version

Saving an edited document and synchronizing it as a new 
version

¸

Copying a document ¸

Creating document links on the desktop or in another 
document

¸

E-mailing a document as a link or an attachment ¸ ¸

Printing a document ¸ ¸

Accessing Document Worklist, Checked-out Documents list 
and My Matters list of Workspaces and folders

¸
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Working in Portable Mode
3. When you reconnect to a WorkSite library, you can automatically check in 
these documents and synchronize them with those in the library.

Prerequisites

To access portable documents effectively, your PC should be set up as follows: 

 Registered for portable mode operation.

 Able to run a local copy of the Windows operating system.

 Have local stand-alone versions of the application programs associated with 
the portable documents.

Switching to Portable Mode

To switch from online mode to portable mode: 

1. In FileSite, from the WorkSite menu, point to Configure, and select General 
Options. 

In Outlook 2010, on the WorkSite tab, click the  General Options icon 
from the Configure area.

The Options dialog box opens with the General tab selected. 
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Figure 206 Options dialog box, General tab

2. In the When starting area, select the Work in off-line mode option. 

3. Click Apply to save your selection. Click OK to close the dialog box. 

4. Restart the Microsoft Outlook application. You are now in portable mode. The 
FileSite interface is retained as shown in Figure 207. 
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Working in Portable Mode
Figure 207 Example FileSite Desktop, Portable mode

FileSite Node in Portable Mode

In portable mode, the libraries listed under the FileSite node are those that you 
previously accessed when in online mode. These libraries are stored as 
subdirectories under the NrPortbl and NrtEcho directories on your local hard 
drive. Your portable checked-out documents and echo documents are stored 
under each library. 

See “Advanced Options” on page 66 for information on how to set the default 
drive for the Portable directory. 

Document Grid in Portable Mode

In Portable Mode, the documents displayed in the Document Grid are initially 
filtered based on whether the document is a portable checked-out document or an 
echo document. 
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Figure 208 Example Document Grid, Portable mode

Document status icons appear in the far left column of the Document Grid to 
indicate portable checked-out documents and echo documents. The icons that 
may appear in this column are listed in Table 40.

Application Setup in Portable

The local application table contains information that is used by Portable to launch 
applications associated with particular document types. Under certain 
circumstances, you may need to change the local copy of the application table: 

 The path to an application changes.

 You want to associate a document type with a different application.

 You want to integrate an application that is not listed in the application table on 
the database.

Table 40  Document Status Icons

Ico
n Portable Documents Echo Documents

The document is checked out.

The document is an orphan document 
in the NrPortbl directory. 

The document is an unmodified 
document in the NRTEcho directory. 

The echo document has been modified 
and should be synchronized. 

NOTE Contact your WorkSite Administrator before editing 
the application table. If you do not understand the way 
applications are integrated with WorkSite, editing the local 
copy of the application table is not recommended. 
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Working in Portable Mode
Working with Portable Documents

This section describes operations that can be performed with portable documents 
in FileSite:

 “Checking Out Documents from Online into Portable Mode”

 “Importing Documents into Portable Mode”

 “Opening Portable Documents”

 “Printing Portable Documents”

 “Viewing Portable Documents”

 “E-mailing Portable Documents”

 “Editing Portable Document Profile Information”

 “Checking In Documents from Portable to Online Mode”

Checking Out Documents from Online into Portable Mode

The first step in working in portable mode, is to check out documents from the 
WorkSite library to the portable document location on your local PC. This 
operation is referred to as an integrated checkout. FileSite provides you the ability 
to check out multiple documents in a single operation. The checked-out 
documents are marked as “In use” in FileSite.

The checkout process copies the documents to the NrPortbl directory, which is 
defined during portable mode registration. The profile information of the 
checked-out documents is also copied, so that you can find and access portable 
documents. 

To checkout a document for portable use:

1. In FileSite, select the document you wish to check out from the Document 
Grid. 

2. From the Document menu, select Check Out. The Checkout dialog box 
opens.
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Figure 209 Checkout dialog box

3. Select the Integrated Check Out option. The Destination Path field defaults 
to the NrPortbl directory.

4. Specify a due date to return the document, from the Due Date list. 

5. (Optional) Specify your reason for checking out the document or enter other 
information in the Comments field. 

6. Click OK or press ENTER to check out the document for portable use. 

Importing Documents into Portable Mode

If you created a new document on your local machine, while disconnected from 
the network; you can import this document into the portable mode using the Add 
Document option. When you reconnect to the network, you can checkin and 
synchronize the document with the WorkSite repository. 

To import a document from your local machine into the portable mode: 

1. Open FileSite in portable mode. See “Switching to Portable Mode” on 
page 349 for more information. 

2. From the WorkSite menu select Add Document or click the  Add 
Document icon in the toolbar. 
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Working in Portable Mode
In Outlook 2010, on the WorkSite tab, click the  Add Documents button 
from the Actions area.

The Find File To Import dialog box opens. 

Figure 210 Example Find File To Import dialog box 

3. Navigate to the document on your local or network drive. Select it and click 
Open or press ENTER. The New Document Profile dialog box opens.

4. Enter information in the document's profile. 

5. Click OK or press ENTER. 

NOTE In portable mode, the Lookup buttons are not 
available on the dialog boxes. You must enter 
information manually. However, if the Autocomplete 
option is selected, FileSite “remembers” and 
automatically fills in the rest of the character string 
previously entered. See “Other Options” on page 65 for 
more information on setting this option.
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The document appears in the Document Grid. You can check it in when you 
reconnect to the network. 

Opening Portable Documents 

1. Open FileSite in portable mode. See “Switching to Portable Mode” on 
page 349 for more information. The list of portable checked-out documents 
appears in the Document Grid as shown in Figure 207. 

2. Select the desired document. 

3. Choose Open from the Document menu. The document opens in its 
associated local application.

Printing Portable Documents

You can print documents by using the Print option. 

1. Select the document you want to print from the Document Grid. 

2. From the File menu select Print. A standard Windows Print dialog box opens. 

3. Specify your printing preferences and click OK.

NOTE Portable looks for portable documents that have 
been checked out by the same user ID used to log into 
Windows. If you checked out documents using a user ID 
other than the one used to log into Windows, Portable 
cannot find the documents. You must log out of 
Windows and log back in using the same user ID that 
you used to log into the WorkSite Server when you 
checked out the portable documents.

NOTE In portable mode, if you select Print from the 
Document menu, the document is automatically opened in 
its associated application and printed. To specify printing 
preferences in the Print dialog box, use the Print option in 
the integrated application.

NOTE If you want to preview the document before 
printing, select Print Preview from the File menu.
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Viewing Portable Documents

WorkSite Viewer allows you to view multiple documents of different formats at the 
same time. 

1. Select the document you want to view from the Document Grid. 

2. Choose View from the Document menu. A read-only copy of the document is 
displayed in the WorkSite Viewer window. 

E-mailing Portable Documents

In portable mode you can use the Forward and Send Link options on the 
Document menu to send a copy, or a link to a portable document by e-mail.

Send Document
1. Select the document from the Document Grid.

2. Right-click to access the Document menu and select Forward.

A new e-mail message appears with the document attached. You can remove 
this document from the e-mail by selecting it and pressing Delete.

Send Nrl/Url
1. Select the document from the Document Grid.

2. Right-click to access the Document menu and select Send Link. The Send 
Link submenu appears with the following options:

 To This Version. The link is to the current version of the document.

 To Latest Version. The link is to the most recent version of the document.

A new e-mail message appears with the document Nrl or Url link attached. 

Editing Portable Document Profile Information

You can view and edit document profile information of the portable documents in 
portable mode.

1. Select the document from the Document Grid.

2. Choose Properties from the Document menu. The Properties dialog box 
opens.

NOTE To send a Document URL link, your system 
must include the WorkSite Web component server.
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3. Make changes or enter new values in the appropriate fields.

4. Click OK or press ENTER. 

The changed profile information is verified when the portable documents are 
checked back into FileSite.

Checking In Documents from Portable to Online Mode

After working in portable mode, when you reconnect to the WorkSite Server, you 
can check in the checked-out documents and synchronize them with FileSite. The 
checkin process verifies the profiles of the portable documents against the 
profile-entry tables. If errors are detected, you are prompted to enter correct 
information.

1. Open FileSite in online mode. See “Switching to Online Mode” on page 362 for 
more information. 

2. Select Checkin/Synchronize from the WorkSite menu. 

In Outlook 2010, on the WorkSite menu, click the  Checkin/Synchronize 
icon from the Configure area.

The Checkin/Synchronize Documents dialog box opens. See Figure 211. 

3. Select the document from the Checkedout Documents tab. 

NOTE In portable mode, the Lookup buttons are not 
available on the dialog boxes. You must enter 
information manually. However, if the Autocomplete 
option is selected, FileSite “remembers” and 
automatically fills in the rest of the character string 
previously entered. See “Other Options” on page 65 for 
more information on setting this option.
8 FileSite Installation and User’s Guide

• 
• 
• 
•
•
•



Working in Portable Mode
Figure 211 Checkin/Synchronize Documents dialog box, Checkedout Documents

4. The checked-out documents appear in the display table with their profile fields 
as column headings.

 Use the horizontal scroll bar to display more profile fields. 

 Use the vertical scroll bar or PAGE UP and PAGE DOWN buttons to 
display all the checked-out documents.

 Click Find to open the Find in List dialog box and search on the profile 
fields of these documents. This is especially useful if the list of 
checked-out documents is large. 

5. Select the documents you want to check in. 

6. Click Checkin or type ALT+C. The Checkin dialog box opens.

NOTE Document icons that appear against the 
documents indicate their status. See Table 40.
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Figure 212 Checkin dialog box

7. Select from the following options:

 Replace Original

 New Version

 New Document

8. (Optional) Select from the following additional options:

 Keep checked out. The document remains checked out, but the changes 
are synchronized with the document in the WorkSite library.

 Delete local file after check in. The file in the Portable directory is 
deleted and the document is checked in.

 Apply to all documents. The option you selected, that is, Replace 
Original, New Version, or New Document, is applied to all documents 
you selected. This option is available only when you select multiple 
documents.

9. (Optional) You can choose the following options:

10. Click OK or press ENTER to check in the documents. 

NOTE Depending on your system settings, you may 
not be able to select the Replace Original option. 
Contact your WorkSite Administrator for more 
information. 
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Working with Portable Documents in Integrated Applications

You can open documents that are checked out for portable use, and save the 
changes from within integrated applications.

1. Launch the integrated application.

2. From the File menu in the integrated application select Open. The WorkSite 
Integrated Portable Open dialog box opens.

Figure 213 WorkSite Integrated Portable Open dialog box

3. From the Current View list, select Checkedout documents.

4. Browse within the portable libraries listed and navigate to the file you want to 
open.

5. Select the file and click Open button drop-down arrow to display the Open list, 
as shown in Figure 213. Choose one of the following options:

 Open. Opens the original document in the portable library. 

 Open Read-Only. Opens a read-only copy of the document. 

 Open and Repair. Opens and repairs the corrupted document. 

 Local Open. Opens the local copy of the document stored on your local or 
network drive. 
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6. The document opens in its associated local application. You can make 
changes and save it. See “Saving Documents” on page 272 for more 
information on saving documents in integrated applications. 

Switching to Online Mode

To switch from portable mode to online mode: 

1. In FileSite, from the WorkSite menu, point to Configure, and select Options.

In Outlook 2010, on the WorkSite tab, click the  General Options icon 
from the Configure area. 

The Options dialog box opens with the General tab selected. See Figure 206. 

2. In the When starting area, select the Work in on-line mode option. 

3. Click Apply to save your selection. Click OK to close the dialog box. 

4. Restart the Microsoft Outlook application. You are now in online mode. If you 
have checked-out documents in the offline repository, a message appears 
asking if you wish to check in the checked-out documents. 

Figure 214 Checked-out Documents message

5. Click Yes to checkin the documents. See “Checking In Documents from 
Portable to Online Mode” on page 358 to continue. 

Orphan Documents

You may have documents in your NrPortbl directory that were checked out by a 
user other than yourself. FileSite identifies such documents as orphan documents. 
You can import these orphan documents into FileSite as new documents.
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CHAPTER 11  
Document Echoing

Overview

This chapter contains the following information about the document echoing 
function:

 “Introduction”

 “Setting Up”

 “Working with Echo Documents”

Introduction

WorkSite provides a safeguard in the event of a network failure. Document 
echoing preserves backup copies of your documents, so that content is not lost. 

Every time you close a WorkSite document, FileSite saves a duplicate copy of it to 
the hard disk on your local machine. After a network failure, you can access and 
perform functions on your important and recently accessed files. If you make 
revisions to these files, FileSite provides a synchronize function to help reintegrate 
them into the WorkSite library.
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Setting Up

This section contains the following information:

 “Prerequisites”

 “Enabling Document Echoing”

 “Setting the Default Drive for the Echo Directory”

Prerequisites

To access echo documents during a network failure, your local machine should be 
set up as follows: 

 Registered for Portable mode operation. 

 Able to run a local copy of the Windows operating system.

 Have local stand-alone versions of the application programs associated with 
the echoed documents.

Enabling Document Echoing

Document echoing must be enabled for FileSite to save backup copies of your 
documents to your local machine. 

Your WorkSite Administrator can enable and disable document echoing globally 
or for certain kinds of documents. If your machine is registered for portable mode 
but FileSite is not echoing documents, contact your WorkSite Administrator for 
assistance.

Setting the Default Drive for the Echo Directory

You can set the directory where FileSite saves the echo documents. Normally, 
they are stored on a directory on your local machine. While the location for the 
Echo directory can be changed, the name of the directory is always NRTEcho. 
Contact your WorkSite Administrator for setting the default drive for the Echo 
directory. 

NOTE If no applications are associated with your 
echoed documents, you can still view echoed 
documents using WorkSite Viewer.
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Working with Echo Documents

You can access echo documents through FileSite in portable mode or through 
integrated applications such as Microsoft Word. See “Switching to Portable Mode” 
on page 349 for information on how to enable Portable mode.

This section contains the following information:

 “Working with Echo Documents in Portable Mode”

 “Working with Echo Documents from Integrated Applications”

Working with Echo Documents in Portable Mode

Both echo documents and portable documents are accessed through FileSite in 
portable mode. In portable mode, you use the same interface as in online mode. 
See “Working in Portable Mode” on page 348 for more information.

Several of the document functions performed with portable documents can be 
performed with echo documents. Table 41 provides a summary.

Opening Echo Documents

1. Launch FileSite. If you are not connected to a network, FileSite switches to 
portable mode. The list of portable checked-out documents and echo 
documents appears in the Document Grid. See Figure 208 on page 352.

NOTE You cannot open documents in the Echo 
directory until they have been synchronized with the 
WorkSite library. This feature prevents you from 
overwriting changes that you made to the document. 
See “Synchronizing Echo Documents” on page 367 for 
more information.

Table 41  Summary of Echo Document functions 

To See

Open echo documents “Opening Echo Documents” on page 365

Print echo documents “Printing Portable Documents” on page 356

View echo documents “Viewing Portable Documents” on page 357

E-mail echo documents “E-mailing Portable Documents” on page 357

View an echo document’s profile 
information

“Viewing Echo Document Profile Information” on 
page 366
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2. Open the desired WorkSite document. A message appears (see Figure 215), 
stating that this copy of the document may not be as updated as the copy in 
the WorkSite library; on reconnecting to the network, you can copy it back into 
FileSite only as a new version.

Figure 215 Echo document warning message

3. Click Yes to continue. The document opens in its associated local application.

Viewing Echo Document Profile Information

You can view document profile information of the echo documents, but you cannot 
edit profile information. 

1. Launch FileSite. If you are not connected to a network, FileSite switches to 
portable mode. The list of portable checked-out documents and echo 
documents appears in the Document Grid. See Figure 208 on page 352. 

2. Select the desired document. 

3. Choose Properties from the Document menu. The Properties dialog box 
opens, with all the profile fields appearing as unavailable because you cannot 
edit these fields. 

Working with Echo Documents from Integrated Applications

You can open echo documents, and save the changes you make from within 
integrated applications.

1. Launch the integrated application.

2. From the File menu in the integrated application select Open. The WorkSite 
Integrated Portable Open dialog box opens.
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Figure 216 WorkSite Integrated Portable Open dialog box

3. From the Current View list, select Echo documents. 

4. Browse within the portable libraries listed and navigate to the file you want to 
open.

5. Select the file and click the Open button drop-down arrow to display the Open 
list, as shown in Figure 216. Choose one of the following options:

 Open. Opens the original document in the portable library. 

 Open Read-Only. Opens a read-only copy of the document. 

 Open and Repair. Opens and repairs the corrupted document. 

 Local Open. Opens the local copy of the document stored on your local or 
network drive. 

6. The document opens in its associated local application. You can make 
changes and save. See “Saving Documents” on page 272 for more 
information on saving documents in integrated applications. 

Synchronizing Echo Documents

After you edit and save an echo document while working offline, you can copy it 
back to the WorkSite library after network connections are restored. FileSite 
provides an easy way to copy modified echo documents back to the network 
through a process called synchronization.
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When you start FileSite, if you have echo documents with changes that are not 
reflected in the copies in the WorkSite library, you are prompted to synchronize. 
This feature prevents you from overwriting changes made to the document.

The following are the prerequisites when synchronizing a document: 

 Only the user who last edited the document in FileSite can synchronize it. If 
you try to synchronize an echo document edited by another user, a message 
asking you to contact the user who last edited the document appears. 

 Your echo copy of a document must be newer than the copy in the WorkSite 
library. FileSite does not allow you to synchronize an echo document if the 
copy in the WorkSite library has been modified more recently than your echo 
copy.

 You must have Read/Write access to the source document in the WorkSite 
library. 

To synchronize an echo document:

1. Launch FileSite. You are in online mode as network connections have been 
restored. 

2. From the WorkSite menu, select Checkin/Synchronize. 

In Outlook 2010, on the WorkSite tab, click the  Checkin/Synchronize 
icon from the Configure area.

The Checkin/Synchronize Documents dialog box opens. See Figure 217. 

3. Select the Echo Documents tab to display the list of echo documents.
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Figure 217 Checkin/Synchronize Documents dialog box, Echo Documents

4. The echo documents appear in the display table with their profile fields as 
column headings.

5. (Optional) Select the Show only echo modified option to display only the 
changed echo documents.

6. Select the echo documents you want to synchronize. 

7. You can perform the following functions in this dialog box: 

 Click Find to open the Find in List dialog box for you to perform a search 
on the profile fields of the echo documents. This is especially useful if the 
list of echo documents is large. 

 Click Delete to discard the modified echo document. 

 Click Purge to set purge criteria. See “Purging Echo Documents” on 
page 371 for more information. 

NOTE Document icons that appear against the 
documents indicate their status. See Table 40.
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 Click Synch to begin the synchronization process. The Confirm 
Synchronize dialog box opens.

Figure 218 Confirm Synchronize dialog box

8. Verify the comparison between the Echo Document and the Database 
Document.

9. Choose from the following options:

 Replace Original. The modified echo document replaces the original copy 
in the WorkSite library. 

 New Version. The modified echo document is synchronized as a new 
version of the document.

 New Document. The modified echo document is synchronized as a new 
document. 

All checkin options may not be available in the following circumstances: 

 If the document is checked out in the WorkSite library, you can return the 
echo document to the WorkSite library only as a new document.

NOTE Depending on your system settings, you may 
not be able to select the Replace Original option. 
Contact your WorkSite Administrator for more 
information. 
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 If the document is not checked out in the WorkSite library and you were 
the last user of the document, you can return the echo document to the 
WorkSite library as a new version, a new document, or replace the original 
document.

 If the document is not checked out in the WorkSite library, but you were not 
the last user of the document, you can return the echo document to the 
WorkSite library only as a new version of the document or as a new 
document.

10. Click OK to synchronize the document. Click Cancel if you want to cancel 
synchronizing all the selected documents. Click Skip to cancel synchronizing 
a specific document.

Purging Echo Documents

1. Launch FileSite. 

2. From the WorkSite menu, select Checkin/Synchronize. 

In Outlook 2010, on the WorkSite tab, click the  Checkin/Synchronize 
icon from the Configure area.

The Checkin/Synchronize Documents dialog box opens. See Figure 217.

3. Select the Echo Documents tab to display the list of echo documents. The 
echo documents appear in the display table with their profile fields as column 
headings.

4. (Optional) Select the Show only echo modified option to display only the 
changed echo documents.

5. Select the echo documents you want to purge. 

6. Click Purge. The Set Purge Criteria dialog box opens:

NOTE If you are unable to use the FileSite 
synchronization process to copy your modified echo 
document back to the WorkSite library, you can use the 
Add Document command in FileSite to import the 
modified echo document as a new document. 
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Figure 219 Set Purge Criteria dialog box

7. To delete all documents older than a certain number of days, enter the 
maximum age (in days) of the echo documents that you want to keep.

8. Click OK. All documents older than the specified number of days are deleted.

Purging Echo Documents Automatically

Documents stored in the echo folder can be purged from the command line or 
through a login script. Use the following command line options, or contact your 
WorkSite Administrator for assistance.

The Portable program (PORTBL32.EXE) allows the following command line 
options: 

-D [number]{/DEL} -DS [number] {/DEL} -PS [number] {/DEL} -D 
[number] 
This option opens the Portable program and purges the user’s echo files older 
than the specified number of days. After all eligible files are purged, the Portable 
application continues running on the user's desktop. 

-DS [number] 
This option launches the Portable program in “silent” mode, and then purges the 
user’s echo files older than the specified number of days. Silent mode launches 
the Portable program only long enough to purge the necessary files, and then 
exits automatically. This is the option that is usually used in a login script to 
automatically purge the echo files upon login. 

-PS [number] 
This feature is similar to the -DS option, but applies to all users’ documents found 
on the machine rather than just your documents.

NOTE The number of days set in the Set Purge Criteria 
dialog box is valid only for a manual purge of the 
directory. Echo documents continue to accumulate 
unless you manually purge the directory in this manner.
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/DEL 
If you add this string to one of the previous options, the echo files are permanently 
deleted from the system rather than moved to the Recycle Bin. 

Examples 
To purge all echo documents older than 20 days and leave the Portable 
application running, enter the following at the command line: 

“C:\Program Files\Interwoven\WorkSite\Portbl32.exe” -D20 
To purge all echo documents older than 20 days and exit the Portable application, 
enter the following at the command line: 

“C:\Program Files\Interwoven\WorkSite\Portbl32.exe” -DS20 
The following string permanently deletes all users’ echo documents that are more 
than 20 days old. The delete operation is performed silently, and Portbl32.exe 
exits after the delete operation without displaying any user interface or messages. 

“C:\Program Files\Interwoven\WorkSite\Portbl32.exe” -DS20 /DEL 
The following string permanently deletes all users’ echo documents that are more 
than 5 days old. After the delete operation is completed, the Portable user 
interface is displayed for the user. 

“C:\Program Files\Interwoven\WorkSite\Portbl32.exe” -D5 /DEL 
The following string silently and permanently deletes all users’ echo documents 
that are more than 15 days old. The delete operation is performed silently, and 
Portbl32.exe exits after the delete operation without displaying any user 
interface or messages.

“C:\Program Files\Interwoven\WorkSite\Portbl32.exe” -PS15 /DEL 
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